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Section 1 – An Introduction to OneNote 
 

Video: What to Expect 

 

Deb: Hello everyone, and welcome to this course on OneNote for Microsoft 365. My name is 

Deb and I'm a Microsoft IT trainer and your excitable host for this course. And the reason why 

I'm so excited is because I love OneNote. And, I can't wait to show you some of the awesome 

features available in this digital notetaking application, which is really going to make you rethink 

how you go about the simple task of taking notes.  

Over the balance of this course, I'm going to show you how to get started with OneNote. How to 

gather information from different sources, how to insert different types of media files, how to 

organize that information logically, so it's easier to read and find. And I'm going to show you 

how you can collaborate with others on Team notebooks. Now this is a very comprehensive 

course. And it offers a complete guide to all of the features available in the latest version of 

OneNote.  

So, if that's what you're looking for, then you've come to the right place. Now this course is 

divided down into 13 Sections. And I've tried to arrange these logically to correspond with the 

natural flow of how you would work in OneNote. Now I'm going to be making some 

assumptions before we begin this course. I'm going to assume that you have some familiarity 

with Microsoft applications. So maybe you are a Word, or an Excel, or a PowerPoint user prior 

to coming to OneNote.  

And what I mean by this is that I won't be going through the basics of how Microsoft 

applications work per se, I am going to assume that you are reasonably familiar with the ribbon 

layout and the standard User Interface that's common amongst all Microsoft applications. And 

when it comes to the scope of this course, I'm going to be working in the OneNote for Microsoft 

365 Desktop application. I'll be providing information on things like the Mobile App and the 

Online version. But it will be a high level overview as opposed to a full training course in those 

specific parts.  

Now if you're feeling a bit confused by what I've just said there, don't worry at all. In the next 

module, we're going to start by running through the different versions of OneNote that are 

available, because as with all things in Microsoft, there are quite a few options. But for now, that 

is all. I just want to say thank you so much for choosing this course. I can't wait to dive into it 

with you. So with that said, grab yourself a coffee and let's get started. 

 

  

http://www.simonsezit.com/


OneNote Desktop and Windows 10 

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved. 

Video: Versions 

 

Deb: Hello everyone, and welcome back to the course. Now I just thought I'd start out this 

Section by running you through the different versions of OneNote that are available. Because in 

my experience, this is one of those things that causes a lot of confusion.  

In fact, very recently, I was running a webinar on OneNote. And we got about halfway through 

and I had many of the participants say to me, “What you're looking at on the screen looks 

nothing like what I'm looking at on my screen”. And we determined that we were actually using 

different versions of OneNote.  

So, this is something you really have to watch out for. So I'm going to run you through the 

different versions available, and also let you know the version that I'm going to be using 

throughout the balance of this course. If you are a Windows 10 user, what you might find is that 

you have access to the Windows version of OneNote. Because OneNote now comes packaged 

with Windows 10.  

So, if you've downloaded that onto your PC, or maybe you've bought a new laptop that has it 

already installed, you'll find that you will have a version of OneNote 2016 already installed and 

ready to go on your PC. So, I'm using a Windows 10 laptop, and this is a fairly new laptop. So I 

have this version installed. So, I'm going to jump down to my Search bar at the bottom, and I'm 

going to start to type in OneNote. Now I want you to ignore the OneNote app, which is showing 

underneath Best match for the moment because that's something different to the one underneath, 

which is OneNote for Windows 10. This is the one that comes installed with Windows 10. And it 

looks completely different to the OneNote Desktop version, and also the Online version.  

So, if I very quickly open OneNote, for Windows 10, you'll see that it looks like this. So, if when 

you open up your version of OneNote, it looks very similar to something that I have here, then 

you're more than likely using the Windows 10 version. And a really quick and easy way to check 

that is the in the Title bar at the top, it will say OneNote for Windows 10. So this is one of the 

versions. Now this isn't the version that I'm going to be using throughout this course. And the 

reason why is that it doesn't have quite as many features as the full Desktop version.  

However, because a lot of people do have this on their PC for free without having to have any 

kind of 365 subscription, at the end of each Section of this course, I am going to provide a 

module which basically runs through everything we've been through in the Section, but in the 

Windows 10 version as well. So if you do have this version, you should still be able to follow 

along nicely. So that's the first version of Windows 10 that you may or may not have available, 

depending on what operating system you're using.  

Now the second way that you can access OneNote is through a Microsoft 365 subscription. And 

you can see here that I'm currently logged in to my online 365 portal. And if you're a bit 

confused by Microsoft 365, it's just the new name for Office 365. So if you have a subscription 

to Microsoft 365, then you should have access to OneNote. So if I click the little waffle or the 

app launcher at the top here, you can see that one of the applications I have access to is OneNote. 
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I can click it, and it's going to jump me into the Online version of OneNote. And again, this 

looks very different to the Windows version, and also the full Desktop version that we're going 

to open shortly.  

Now if you're fairly used to using Microsoft 365, you'll know that this kind of online browser, 

online portal is where you can come to access the light versions of the applications. So they're 

intended for you to be able to update, read things, work on the go on whatever device you're 

using. As long as you've got an internet connection, you can jump into your Office 365 account 

and access Online versions. But these aren't the full versions. And because of that, this also isn't 

the version that we're going to be covering in this particular course.  

Now I'm going to click on Home for the time being. Because when you do have a Microsoft 365 

subscription, when you log into the portal, you're able to download and install the full versions of 

all of these applications. And you do that via this button just here, Install Office. And by clicking 

that and running through the setup process, you're then going to have the full versions of all of 

the applications available on your desktop. So that's exactly what I've done. And once you've 

done that, you will then be able to search for OneNote. It's actually this one here, so not the one 

with for Windows 10 after it, this is the full Desktop version.  

So you can click here to launch it. Or, you can do what I've done and pin it to your Task bar. And 

you'll see mine is located down here with the rest of my Microsoft applications. So I can click to 

open it up. And this is the feature-rich Desktop version. And it's this one that I'm going to be 

using throughout the balance of this course. So what I'm trying to say to you here is if you 

predominantly work in the Online version, then this isn't a training course that's going to cover 

that.  

However, if you do have the Desktop version, and also if you have that free version through 

Windows 10, then this course is going to be perfect for you. Just bear in mind, there will only be 

one module per Section that relates to the Windows 10 version, as we're mostly going to be 

working in the Desktop version. Whew, quite a lot to take in there. As always, Microsoft likes to 

make things a little bit confusing for everybody.  

And just a final point to note, there is a Mobile App that you can download for Windows Phone, 

Android, and iOS. And I will be doing a brief overview on the iOS app at the end of this course. 

So hopefully, that is reasonably clear to everybody. And we're all on the same Page with regards 

to the version we're going to be using and what we're going to be covering in this course.  

I'm going to jump across to the next module where we're going to start to explore some of the 

Keyboard Shortcuts in OneNote. So, I'm going to go across there now and I hope to see you 

there. 
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Video: Keyboard Shortcuts 

 

Deb: Now in this first module, we're going to talk about Keyboard Shortcuts. And it wouldn't be 

one of my courses if I didn't start out with this module. Because, Keyboard Shortcuts are such an 

important thing when it comes to being able to work efficiently, not just in OneNote, but any 

Microsoft application.  

Now, if you're coming to OneNote, having used Word, Excel, PowerPoint, or even Outlook, then 

you've got a bit of a head start here. Because, many of the Keyboard Shortcuts are exactly the 

same in OneNote, as they are in those other applications, at least the ones that you all use most 

frequently. Now, if all things Microsoft are completely new to you, and you're not entirely sure 

what I mean by a Keyboard Shortcut, Keyboard Shortcut is essentially a combination of 

keystrokes that will execute a task.  

And a lot of the time using a Keyboard Shortcut is a lot quicker than using your mouse to hunt 

through the different ribbons to find the tasks that you need. And there are so many different 

Keyboard Shortcuts in OneNote, that you would never be expected to remember them all. But 

most people have a catalogue about five to 10 in their minds, which they use frequently. Now, as 

I mentioned, the Keyboard Shortcuts in OneNote do bear a lot of similarities to the Keyboard 

Shortcuts in other Microsoft applications.  

So for example, something like Bold, Ctrl + B is the Keyboard Shortcut. And that is the same 

across every single Microsoft application. Italics is Ctrl + I, Underline, Ctrl + U. And of course, 

we have things like Cut, Copy, and also Paste with the same Keyboard Shortcuts. Now you'll see 

that as I hover over these different commands on the ribbons, I'm getting a little ScreenTip, 

which not only gives me a little bit of description text, so I know exactly what that command 

does, it's also showing me the Keyboard Shortcut.  

Now if for some reason, when you hover over these icons, you can't see those ScreenTips, I 

would advise you to turn them on. So let's just take a look at how we do that if we can't see these 

ScreenTips. So I'm going to jump up to File, and you'll find this in the OneNote Options. And it's 

this first General tab just here in this first group, User Interface Options. So in ScreenTips style, 

make sure you have Show feature descriptions in ScreenTips.  

Now if for some reason you find those completely annoying, then you can also turn them off 

from here as well. But as soon as you turn those on, it's going to allow you to see those Keyboard 

Shortcuts in that ScreenTip text. So that can be super useful.  

Now if you're somebody who likes to work predominantly using the keyboard as opposed to the 

mouse, if you press the Alt key on your keyboard, you'll see that you get some Keyboard 

Shortcuts assigned to the different Ribbon tabs. So this is great because it enables me to navigate 

and do things without touching my mouse.  

And I know a lot of people who are really into working with Keyboard Shortcuts use this option 

quite frequently. It's also really good if you have any wrist problems or something that prevents 
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you from fully working with your mouse, you don't technically have to use it in order to work 

within OneNote.  

So for example, if I want to navigate to the Insert tab, I can press capital N, which is going to 

jump me to that tab. And then I get a whole new list of Keyboard Shortcuts that I can use to 

execute a task. So if I want to insert a picture, I could press P, and it's going to open up File 

Explorer, and let me browse for the picture that I want to add. And also with screens like this, if 

you take a look at the bottom, if I was to hit my Enter key, it's going to open whatever I have 

selected.  

Now if I want to just cancel out of this window, which I do, I can use my Tab key to move to 

Cancel and then hit the Enter key. So I've been able to cancel that dialog box without touching 

the mouse at all. So those Alt key shortcuts are really useful.  

Now the only other thing I really want to mention to you regarding Keyboard Shortcuts here is if 

you're somebody who does like their Keyboard Shortcuts and you want to see a full list of all of 

the shortcut keys available in OneNote, then you can find a list of those within the Help files. So 

you can see here in OneNote, I have a Help tab. And once again, this isn't a tab that's turned on 

by default. So if you can't see Help up here, you're gonna want to jump to File, go down to 

Options, and then jump into Customize Ribbon.  

And on the right-hand side here, this is where you can select what ribbon tabs you can see in 

your OneNote. So just go into here and make sure that you have a tick next to Help in order to be 

able to see that ribbon tab. So if I hold my mouse over where it says Help, you'll see that there's 

also a shortcut key for this as well, and that is the F1 key. And again, as you would expect, that is 

the same across all Microsoft applications. So let's jump into Help. And that's going to open a 

pane up on the right-hand side. And what I can do is type in Keyboard Shortcuts, and press Enter 

to run that search.  

And the top result I get is Keyboard Shortcuts in OneNote, and if I jump into here, I get a lot of 

information about different Keyboard Shortcuts. And then I can view all of the shortcuts divided 

down by category. So I can jump to Frequently Used Shortcuts, and I can see all of them listed in 

here. I then have shortcuts for formatting, inserting items onto a Page, working with tables, so on 

and so forth. So this is a really great place to come if you want just to see a full list of all the 

Keyboard Shortcuts available in OneNote.  

Now, I will say that throughout this training course, I'm going to try to use Keyboard Shortcuts 

as little as possible. And the only reason for that is because it's a lot more difficult for you to see 

what I'm doing if I'm using a Keyboard Shortcut, as opposed to if I'm actually clicking on things, 

bringing up menus, so on and so forth. So if you wonder why I'm not personally using them, I 

will say that in my day-to-day work when I'm not recording a training course, I use Keyboard 

Shortcuts all the time, but I'm going to be using my mouse throughout the balance of this course.  

So that's it on Keyboard Shortcuts. In the next module in this introductory Section, I'm just going 

to be talking to you a little bit about customizing the Quick Access Toolbar. Again, this is 

something you might have done in previous application. So, if you're familiar with how to do 
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that, then you can probably jump over the next module. But if not, stay tuned, I'm going to show 

you how you can be more efficient by adding frequently used commands to the Quick Access 

Toolbar. I'm going to jump over there now. So join me when you're ready. 

  

http://www.simonsezit.com/


OneNote Desktop and Windows 10 

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved. 

Video: Customize Quick Access Toolbar 

 

Deb: Hi guys, and welcome back to the course. In this module, we're going to take a look at 

customizing the Quick Access Toolbar. Now, once again, this is one of those features that's 

available across all of the Microsoft applications.  

So if you are an Excel, PowerPoint, Word user, and you're fairly familiar with how the Quick 

Access Toolbar works and how to customize it, then you can probably skip over this module and 

head straight to the next one. However, if this is all fairly new for you, stay tuned and let's run 

through why the Quick Access Toolbar is useful and how you can customize it.  

Now the Quick Access Toolbar you'll see located in the top left-hand corner, and it's this little 

toolbar just here. So it's kind of tucked away a little bit. Now I don't have a great deal on my 

Quick Access Toolbar at the moment, just a couple of commands. And that's pretty much what 

this Quick Access Toolbar is. You can add whatever commands you like to it. In particular, 

commands that you use frequently to make them super easy for you to access.  

So for example, if I'm always inserting pictures into my OneNote notebook, instead of jumping 

to the Insert tab, and then selecting Pictures from here, I could essentially add this command to 

my Quick Access Toolbar, which then gives me one click access to that particular option. Now 

by default, when you first open up OneNote, you'll already see a couple of things assigned to 

your Quick Access Toolbar. So for me, that is the Undo command, a very popular command Ctrl 

+ Z to take us back a step, and also the command that allows me to switch between Touch and 

Mouse mode.  

Now I'm going to be going into that in more detail in the next module. So I'm not going to delve 

into exactly what this command does right at this moment. And then right on the end here, we 

have this little drop down button. And when I hover over, it says Customize Quick Access 

Toolbar. And what this is going to show you is a number of different commands that you could 

add to your Quick Access Toolbar. So I could add Forward, I could add Redo, Print, Print 

Preview, so on and so forth. So these are merely suggestions of popular commands that you 

might consider adding to that Quick Access Toolbar.  

Now something else I want to draw your attention to here is, as you can see, currently, my Quick 

Access Toolbar is tucked away in the top right-hand corner. Now whilst I don't have too many 

options as to the location of this toolbar, I do have one more option. And that is I can choose to 

show it below the ribbon. So I'm going to click that and you can now see that it pulls it down to 

below my ribbons. Now this is where I like to have my Quick Access Toolbar because I just find 

it a lot easier to get to and less tucked out of the way. So let's click our drop down again and look 

at how we can customize and add commands to this toolbar.  

Now if I wanted to choose any of these, I can just select them. So let's add the Redo button, like 

so. I could also add the Print button, and let's add Print Preview as well. And you'll see it just 

builds a long list of all of these different commands, which I can then execute simply by clicking 
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on them. So it's a lot more efficient than having to find them in the ribbons or in that file area 

backstage.  

Now one thing you will notice is that obviously, we just have a selection of commands which we 

can choose from here. But what if you want to add a command that's on the ribbon? Well, as I 

said at the beginning, if I insert a lot of pictures into my OneNote notebook, then what I could do 

is right click on the Pictures command and say Add to Quick Access Toolbar to add that on. And 

you'll see that you have this option whenever you right click on any of these commands. And of 

course, I could carry on going and build myself up a nice long list of all of the commands that I 

access frequently.  

Now in addition to adding them this way through the right-click menu, if I click the drop down 

again, you'll see right at the bottom, we have a More Commands option. And that's going to 

jump you straight into the OneNote options, and into the Quick Access Toolbar area. So over on 

the right-hand side of the screen, you're going to see everything that you currently have on your 

Quick Access Toolbar. And what you can essentially do is go through all of the commands 

available in OneNote and add them in from here. So it's definitely worth noting that not every 

single command that's available in OneNote is listed out as a command on ribbons.  

So what you could do is click the drop down here and I could say All Commands which is going 

to show absolutely every command available in OneNote, or if I just wanted to see the 

commands that weren't available to select from a ribbon, I could select Commands Not in 

Ribbon. Now I'm going to select All Commands to bring up the full list that's available. So I'm 

going to scroll through, and I can add a couple of things from here.  

So let's say Customize Tags is something I do all the time, I'm going to select it, click on the Add 

button to add it over to my Quick Access Toolbar. And of course, once I have it over here, I 

could then choose to Remove. So let's remove Print Preview, if I want to get rid of any of these. 

So I could go through this big long list just adding commands I use frequently to my Quick 

Access Toolbar.  

Now another thing that you can do within here is you can reorganize the way these are listed out. 

So for example, Undo and Redo are kind of in the same category. So I want these to be together. 

So I'm going to click on Redo. And then I can use my arrows to move that up one. Maybe I want 

Touch/Mouse mode to be right at the beginning. So I'm going to select it and say move up just to 

put that at the beginning. So you can organize your list however you like.  

Now, something else you might want to Add-in here. And again, this is more of an 

organizational tip. If you start to get quite a lot of icons on your Quick Access Toolbar, 

sometimes it's nice to have a little bit of separation between commands of similar type. And we 

can do that by adding in a Separator. Now you'll find Separators available at the top of any of 

these lists that you select. And it's this just here, I can click, click on Add to Add-in a Separator. 

And I can Add-in as many Separators as I like, so I'm going to add another one.  

I can then use my up and down arrows to move these into position. So I'm going to have one 

Separator there, and I'm going to move this one down too. So now when I click on Ok, you can 
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see how that looks on my Quick Access Toolbar. I now have these very faint lines in between 

separating out different groups of commands. So it's just a little bit easier on your eye to have 

them organized in this way, as opposed to just a big long row of random icons.  

So that is how you can customize your Quick Access Toolbar. And it is something I always 

advise people to do because it does really increase your efficiency when you're looking for 

commands you use frequently in OneNote.  

In the next module, we're going to finish off this introductory Section by talking about using 

OneNote on a Touch device. So, I'm going to grab a coffee head over there now and I look 

forward to you joining me. 
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Video: Using Touch mode 

 

Deb: Hi guys, welcome back. Now I didn't want to finish up this introductory Section without 

giving a bit of a shout out to all the Touchscreen users out there. More and more these days, 

people have tablet devices, and also laptops that have Touchscreen capabilities. I am in fact 

using one of those laptops as we speak.  

And out of all of the Microsoft applications, OneNote is the application that is most suited to 

people who use touch device with a Stylus pen. And you'll see as we work through this course, 

particularly in certain Sections, when it comes to things like handwriting, things are a lot easier if 

you are using a touch device with a Stylus, because let's face it, trying to write a word using your 

mouse never works well. So before we finish up this Section, I just want to run through a couple 

of the options for all of the Touchscreen users out there.  

Now currently, I'm working with the mouse and keyboard. And so I'm in what we call Mouse 

mode. Now helpfully one of the default commands on my Quick Access Toolbar is this option, 

just here, the Touch/Mouse mode option. So this allows me to toggle between using a Mouse and 

using Touch. Now when you're using a mouse and keyboard, the interface is really optimized for 

that particular usage. Whereas if we jump into Touch, you'll see that the screen changes slightly 

more, because it's then going to optimize for people who use a Touchscreen. So let me briefly 

switch into Touch mode.  

Now the most obvious thing that's changed here is that I have a lot more space between the 

different commands on the ribbons. So what it's doing here is just accommodating for your 

finger. Your finger is a lot bigger than your mouse pointer, and so you need a little bit more 

room because the last thing you want to be doing is pressing one command and accidentally 

hitting two or three. So if you're watching this course now and you are using a touch device, I 

would advise you to switch into this particular mode.  

And remember, if you can't see this option on your Quick Access Toolbar by default, then you 

can jump into More Commands, and then find Touch/Mouse mode in here and add it to make it 

super simple for you to switch between the two modes. Now we are going to be typing a lot of 

texts throughout the balance of this course, and again, if you are using a touch device, then 

you're gonna want to make sure that you know how to pull up your touch screen keyboard.  

Now mine's located right in the bottom corner on my taskbar. And you can see as I hover over it 

says touch keyboard. And if I click that, that's going to pull up my touch keyboard and I can then 

go through, and I can start to use that to type in different words and notes. So make sure you 

know where that is because it's going to make life a whole lot easier as we're going through this 

course. Now we're going to dip back into touch a little bit later on, particularly when we get to 

this Section of the course here where we start to draw things.  

As I said, it's a lot easier to do if you do have a Touchscreen with a Stylus. But of course as 

always, I will try to accommodate both keyboard and mouse users as well as touch users. So 
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that's it on touch. I am going to very quickly toggle back to Mouse and Keyboard mode, and I 

will see you in the next Section. 
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Section 2 – Opening a Notebook and Touring Interface 
 

Video: Opening a Notebook and Touring Interface 

 

Deb: Hello everyone, and welcome back to the course. This is Deb, your host. And we are about 

to get into Section 2, which I've titled getting started with OneNote. And over the course of this 

Section, we're going to learn some of the skills that you need to know in order to get going with 

OneNote. And we're going to start out in this first lesson by just taking a look at how we open 

OneNote. I'm going to show you how to open a Notebook. And then we're going to do a quick 

tour of the OneNote interface so you understand the ribbon structure and the kinds of commands 

that you'll find on the different ribbons. So let's dive in.  

Now, as I mentioned in the previous Section, I'm going to be demonstrating OneNote for 

Desktop. So, what I could do in order to launch OneNote is click in the Search bar down here, 

and I'm using Windows 10. Type in OneNote, and you'll see that I have OneNote listed 

underneath my apps. So I could launch it from here simply by clicking on this menu item. But 

what I've actually done is I've pinned the application to my Taskbar just to make it super simple 

for me to access. And it's all the way down here, right in the middle, I'm going to click to launch.  

Now when you open OneNote for the first time, it's probably going to look something similar to 

this. So you can see there right in the middle where we have this big old message that says you 

don't have any open Notebooks. And that would be correct. I haven't created a Notebook, and I 

don't have an open Notebook. Now one thing you'll notice is that with no Notebook open, a lot of 

the commands on the menus are grayed out. So in order to give you a quick tour of this interface, 

I'm going to need to either create a new Notebook or open a Notebook that I have saved off.  

So I'm going to do the latter, I'm going to open a Notebook that I've already created. And we are 

going to go into this in more detail a bit later on. But for demonstration purposes, let's quickly 

run through the process. Now much like any other Microsoft application, you'll see that we have 

our Ribbon tabs at the top, we have our File menu, which jumps us into that backstage area. And 

if you are familiar with other Microsoft applications, you'll know that this is kind of where you'll 

find those admin style tasks. So if you need to create a new Notebook, Open, Print, Share, all of 

those kinds of things you're going to find in here.  

So what I want to do is I want to jump straight down to Open. And you'll see at the top some of 

the Notebooks that I've had open recently, and these are Notebooks that I have stored in 

OneDrive. And if I scroll down, I can see some more or less. So on the right-hand side, I've got 

Notebooks selected. And this is showing me any Notebooks that I've recently used. So I could 

select to open one of these.  

Alternatively, if I can't see the Notebook that I want to open listed either down here, or at the top 

here, what I can do is choose to open from other Locations and jump across to my OneDrive, or 

maybe even browse my local drives to find a Notebook that I want to use.  
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Now, as I said, we're going to get into this a bit more later on. So for the time being, I'm just 

going to open something that I've opened recently. And I'm going to choose this one here, that is 

my Work Trips Notebook, click to open it up. So this is a very basic Notebook. But we're not 

going to worry about the content too much at this time. Really, what I want to do in this lesson is 

just run you through the interface so you kind of start to get an idea of where things are located 

on the different ribbons.  

Now again, something that's very consistent across all Microsoft applications, your Home ribbon 

is going to contain all of the things that you're probably going to utilize most often. So we have 

our Clipboard group which contains Cut, Copy, Paste. We have our Text Formatting options, and 

also Styles if we want to apply them. We then have a big Section here called Tags and Tags is 

something that's really cool, and we're going to talk a lot about this a bit later on in the course. I 

can email my Page from here and I also have some interaction with Outlook on the end here. 

And again, we're going to cover this a bit later on.  

Moving across to the Insert ribbon, this contains all of the things that you can insert into your 

Notebooks. So that might range from things like Tables, File Printouts, Attachments, even Excel 

spreadsheets. You can also insert Pictures whether they be saved on your local drives, or located 

online, you can add Screen clippings or Screenshots directly into your Notebook. And you can 

also do cool things like record audio and video from directly within your OneNote Notebook.  

This is also where you would come if you wanted to use some kind of Page template as well. So 

the Insert tab you come to whenever you want to insert something into your Notebook. We then 

have our Draw tab. And this is probably most useful if you are somebody who uses a laptop or 

maybe a Touch device that has a Stylus. Because, this is where you can come to draw, make 

annotations, handwrite your own notes and insert things like shapes. Now whilst it is possible to 

do these things using a mouse, a lot of the time, it is quite hard to use a mouse to do handwriting. 

As I said, this does tend to work best if you're using a Stylus.  

Moving across to the next tab, we have our History tab. And this really relates to having lots of 

people collaborating on one Notebook. You'll see as we move through the course you can share 

your Notebook with team members, other the people, and then everybody can jump into the 

Notebook and make changes, their own annotations, things like that.  

So, the History tab really comes into play if you want to essentially see changes that have been 

made to a Notebook by author, if you want to find specific changes, or even if you want to see 

different versions of your Page. And again, we're going to get into how all that works a little bit 

later on. Moving across, we have our Review tab. And this is pretty much what you would 

expect to find on any Review tab in your Microsoft applications. This is where you would come 

to Spellcheck, use the Thesaurus, check your Accessibility, change things like Language, or even 

Password Protect a Section.  

We also have something in here called Linked Notes, which is a very useful feature, which we'll 

explore in more detail later on in the course. The View tab is where you can view your Notebook 

or your Page in different ways. And you can also format your Page Background. So if you want 

to change your Page Color, or maybe you want to add Rule Lines to your Page, you can 
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definitely do that. You can do things like zoom in and out to make things a bit easier to see. And 

also make modifications to how you're displaying your window. And then finally, on the end 

here, we have our Help tab.  

Now, as I mentioned at the beginning of this course, the Help tab isn't always there by default. If 

you think that you're going to utilize this tab, and it's definitely worth jumping into OneNote 

options and turning that tab on. Now I'm not going to focus on this because we have already been 

through this tab earlier on in the course. So aside from that ribbon structure, underneath, we have 

our Quick Access toolbar, which we've seen how to customize. And then we have our Notebook. 

And the way that a Notebook is structured is it has Sections, and then it has Pages.  

So I liken this to a paper Notebook that maybe you have dividers in. The dividers are very 

similar to the different Sections that we have up here. And you can see them showing as tabs. 

And then within each Section, I have Pages. And if you cast your eyes over to the right-hand 

side, in this blue panel, you can see I currently have three Pages; Milan, Rome, and Venice 

within the Italy Section. And of course, you can add Sections, and you can add more Pages to 

each Section. And this is in general how all of the Notebooks that you create will be structured.  

Don't forget, if you feel that you need a little bit more room when you're working in your 

OneNote Notebook and you want to temporarily minimize the ribbon, you can definitely do that 

by clicking on this small little up arrow over on the right-hand side. And this up arrow does have 

a keyboard shortcut Ctrl + F1. And that's going to minimize up your ribbon which gives you a 

little bit more room when you're working in your Notebook. If you want to bring your ribbons 

back after you've collapsed them up, if you click on any of the tabs, the ribbon will drop down 

again. If I click back on my Notebook, that ribbons going to disappear.  

Now if you decide that you want to have that ribbon back permanently, what you need to do is 

just click on one of the ribbons again to pull it up and then go over to the right-hand side and 

click on the Pin the ribbon icon again Ctrl + F1. And that's going to lock that ribbon in place. So 

that is pretty much what your interface looks like when you open up a workbook. So the main 

point I want you to take away here is this Notebook structure.  

You have your Sections running in tabs across the top, and each Section can contain multiple 

different Pages. And we're going to see in the next lesson exactly how we create a new Notebook 

from scratch, and how we start to add Sections and Pages. So, I'm going to jump over to the next 

module now and I look forward to you joining me. 
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Video: Creating a New OneNote Notebook 

 

Deb: Hello everyone, and welcome back to the course. It's time for us to start creating some 

stuff. Let's start creating some content in wonderful OneNote. In the previous module, we took a 

quick tour around the OneNote interface. And of course, we're going to be dipping in and out of 

these ribbons and exploring all of the commands over the balance of this course. But the first 

thing we want to do the most fundamental thing in OneNote, is we want to create a new 

Notebook. And it's a very simple process.  

So we're going to go up to the File tab. And as you would expect, we want to make sure that 

we've got New selected. Now what you're seeing here is essentially a split screen. On the left-

hand side, we have different Locations. So this is where we want to save our new Notebook. And 

then on the right, we have a list of Recent Folders, so Recent Folders that you've saved into or 

used.  

Now this is a reasonably new account that I've set up. So currently, I only have one Recent 

Folder listed, and that's my Documents folder in OneDrive. And the way that this works is that 

when you create a new Notebook, you essentially save it first, which is why we're being asked to 

select a Location. Now I'm going to save my Notebook into OneDrive. But before I do that, let's 

just take a look at the other options that we have. So you could if you wanted to choose to save 

this directly to a SharePoint team site, you could save it to this PC, you can add a place. So if you 

have more than one OneDrive account, you can choose to add those from here to make them 

easy to access.  

Alternatively, if you just want to save your Notebook locally, you can do that by selecting 

Browse, and it's going to jump you into File Explorer, and you can then jump in and choose a 

folder. Now one thing to note here, if you want to share your Notebook with other people, then 

your Notebook must be saved to a Location that’s shareable. So for example, saving your 

Notebook to your Desktop is not a shareable Location. Whereas saving your Notebook to maybe 

a network drive that you have within your company, or even saving it to OneDrive Cloud 

Storage, those are considered shareable Locations.  

Now whilst it is a good idea to have a little bit of an idea as to if you want to share your 

Notebook right at the point where you're creating it, it doesn't matter so much if you create it in 

one Location, and then change your mind. Because, you can move your Notebook at a later time 

if you then want to share it. But what I'm going to do is I'm going to save to OneDrive. And I'm 

going to put it just in my OneDrive Train IT Now Limited folder. When I click it, it's going to 

jump me to that folder. And I'm going to say I want to put it in the folder Notebooks. And then 

I'm going to give my Notebook a name.  

So, I'm going to click in the Notebook Name field, and I'm going to call my Notebook, Project 

Artemis. So maybe where I work, we are working on a project that's got a codename of Project 

Artemis. And I want all of my notes, all of the meetings, all of the content related to this project 

to be contained within this Notebook. So I've given my Notebook a name, and I'm going to say 

create. And this is a really important point, you'll see straightaway, it's popped up with a little 
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message that says; “Your Notebook has been created, would you like to share it with other 

people”. And that's come up because I've saved it in a Location that is shareable.  

So if I wanted to, maybe I know right now that I want to share this with the rest of the Project 

Artemis team, I could choose invite people. Now I'm not going to do that at this stage, because I 

want to talk you through that process a bit later on. So I'm going to say Not Now, and it creates 

my Notebook. And what you'll see is that my Notebook name is now listed just here. And as I 

hover over, it gives me a little bit of information in that ScreenTip. So it says I can click to view 

other Notebooks.  

So if you have more than one Notebook open, if you click just here, you're going to be able to 

see all of your Notebooks listed, and you can easily switch between the different Notebooks that 

you're working in. Now, obviously, I only have Project Artemis open, which is why it's the only 

one I can see listed here. Something else you can see when I hover over is you can see the 

Location where I have this Notebook saved. So OneDrive, Train IT Now Notebooks and it's 

telling me that it's up to date. And this is another important thing to note. OneNote Notebooks 

automatically save.  

So you don't have to worry about going into File and Save. You don't have to press Ctrl + S as 

you're working. Everything automatically saves and synchronizes and this is particularly 

important if you've saved your Notebook to cloud storage like OneDrive, every change you make 

will be synchronized. Every change that anybody else makes to your team Notebook, if they 

have access, will also be synchronized. So all this message is telling me is that all of the changes 

are up to date.  

So that is basically how you create a Notebook from scratch. If you wanted to create another one, 

you could just jump back into File, go to New and go through exactly the same process. Select 

your Location first, give your Notebook a name, and then it's going to open in OneNote and it 

will be listed in your Notebooks drop down. And we're going to create a couple of Notebooks a 

bit later on so you can see how you can very easily switch between the two and work in multiple 

workbooks at the same time.  

Now in the next lesson, we're going to delve a bit more into Notebook Properties. I'm going to 

show you the different things that you can change and I'm also going to show you how you can 

essentially close a Notebook and come out of it when you're done. But for now, that is it. I will 

see you in the next module. 
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Video: Changing Notebook Properties and Closing 

 

Deb: Hello everyone, welcome back to the course. We are down in Section 2 where we are 

getting started with OneNote. And in the previous module, I showed you how to create a new 

Notebook from scratch and select a Location in which to store it. So what we're going to do in 

this module is I'm just going to show you how you can modify the Properties on a Notebook and 

also how you can close the Notebook when you're finished with it. So let's take a look at 

Properties first of all.  

Now, as we've already discovered, any Notebook that we have open will be listed underneath 

this drop down. And currently, I only have Project Artemis open. Now if I want to view the 

Properties for this particular Notebook, if I right-click my mouse, you'll see right towards the 

bottom in this little menu, we have a Properties option. So let's select it and see what we get. 

Now when you go into Notebook Properties, there isn't a great deal of information that you can 

change in here.  

But there are some important things that you should be aware of. If for example, you want to 

change the Display Name of your Notebook. So maybe I want to change this to Project Alpha, 

Project Beta, something else I can come in here, and I can edit the Display Name. And what 

you'll see underneath is it says; “Does not affect the actual Notebook folder name”. So what 

that's essentially saying is you're merely changing the Display Name, the name that you can see 

in OneNote, it doesn't change the folder name.  

So for example, if I just quickly pull up File Explorer, this is essentially where I have my 

Notebook saved. In OneDrive, in the Notebooks folder, and you can see here a couple of 

workbooks that I have within this folder. And one of them is Project Artemis. So if I was to 

change the Display Name to Project Beta, and click on Ok, it's going to change the name here, 

but what it's not going to do is change the actual folder name within Notebooks. So that's a really 

little important point to be aware of. Now, so we don't confuse things, I'm actually going to go 

back into my Properties, and I'm just going to change that name back to Project Artemis.  

The next property that we can change is the color of the Notebook. And we have a drop down 

here, which brings up a little palette of muted pastel shades. And we can essentially color code 

our different Notebooks that makes them stand out from one another. You could even color code 

Notebooks that are maybe related with the same color just as a way of organizing your 

Notebooks in a more visual way. So I'm going to select this purple color for this particular 

Notebook. Underneath that we have the Location. So it's telling me the Location where my 

current Notebook is stored.  

And if I decide I want to move that somewhere else, I can click on Change Location. Once again, 

it's going to open up File Explorer, and I can choose a different folder to save my Notebook into. 

And then finally at the bottom, it's telling me what my default format is. So it's saying that this is 

a OneNote 2010 to 2016 Notebook format, and the Convert to button is grayed out for me. So if I 

was to open a Notebook that was in a different format, I could choose to convert it to 2010 to 

2016 formats.  

http://www.simonsezit.com/


OneNote Desktop and Windows 10 

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved. 

But at the moment, we are all good with how we have our format set. So I'm just going to click 

on Ok. So now when I click the drop down, you can see that my Notebook is that purple color. 

So those are the Properties that you have for each Notebook. As I said, not a great deal, but some 

important things in there.  

Now the final thing I want to talk to you about in this particular module is how to close 

Notebooks. So you might have multiple Notebooks open. And if you've finished working in one 

of them for the day, you're going to want to close down that particular Notebook. Now in most 

Microsoft applications, when you want to close something, you would jump up to File and there 

would be a handy little Close button in here. But you can see with OneNote, we don't actually 

have that. So we need to close in a slightly different way.  

Again, we're going to click the drop down, we're going to hover the mouse over the Notebook 

that we want to close, right-click, and in here you'll find a Close this Notebook option. And when 

I click it, it's going to remove that Notebook from the list. Now I want to stress here you haven't 

deleted your Notebook, it hasn't disappeared, you have literally just closed it down. And of 

course if you want to reopen it, you would go back up to File, down to Open.  

And because this is a Notebook that I've recently opened, the quickest way for me to open this 

would be to scroll down, make sure I'm clicked on Recent, and then underneath the Notebooks 

tab, I should be able to see the last Notebook that I had open at the top of this list. So I'm going 

to click Project Artemis just to reopen this Notebook. So, modifying your Notebook Properties 

and closing Notebooks, very straightforward, very simple, but very important.  

In the next module, I'm going to talk you through the process of deleting a Notebook. Because 

this is not as easy as it might sound. And it's something that I find confuses people quite a bit, 

because it works a lot different to how other things work in Microsoft. So I'm going to grab a 

coffee, jump over to the next lesson, and I look forward to you joining me over there. 
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Video: Deleting a Notebook Stored in OneDrive 

 

Deb: Hello everyone, and welcome back to the course. This is still Deb, and we are still down in 

Section 2, where we've been taking a look at some of the fundamental skills you need to know in 

order to get started with OneNote. And in the previous modules, I've shown you how you can 

create a Notebook from scratch and ours is called Project Artemis. And I've also shown you how 

you can modify those Notebook Properties. And we finished off by taking a look at how we can 

close down any open Notebooks once we're finished using them.  

Now, the subject that I want to discuss in this particular module is Deleting Notebooks. Because 

I've been training OneNote for quite a few years now, and I find that this is a really common 

question. People get very confused when it comes to deleting because it's not as straightforward 

and obvious as you might expect it to be. So for example, if I said to you, how do you think you 

would delete a Notebook? The logical assumption is that you might jump into your Notebooks 

list, right-click on the Notebook, and you have an option in here to delete the Notebook.  

But what you'll find when you come into this right-click menu is that you actually don't. The 

only thing you have is Close this Notebook. Now whilst that will get rid of the Notebook from 

your Notebooks list, it hasn't deleted it, it's just closed it and you can jump back into File and 

reopen that Notebook whenever you like. However, there will be times where maybe you've 

completed a project and you have no use for the Notebook anymore, where you want to actually 

delete it and all of its contents. So how do we actually delete a Notebook?  

This is where it's really important to know where you have your Notebooks stored or saved. So if 

I pull up File Explorer, so here, I can see the two Notebooks that I have saved into the Notebooks 

folder in OneDrive. So what do you think I might do here in order to delete this Notebook? Well, 

again, the logical assumption as I've led you down this path is that you can come into here, click 

on the Notebook you want to delete and press the Delete key on your keyboard. But look what 

happens. I'm going to delete it, and we're going to wait a few seconds, and you'll see that it 

automatically comes back again. And this is where I find people have a problem.  

They try to delete it from OneDrive, but it keeps appearing back. Now the reason why that is 

happening is because you can see that I'm working within File Explorer. And I have my 

OneDrive synchronized to File Explorer. So, I can work with my OneDrive files without having 

to log in to the Microsoft 365 portal. But what happens is my portal synchronizes with my 

folders in File Explorer. So as soon as I delete Project Artemis, the synchronization happens, 

OneDrive can see the Project Artemis Notebooks still in Microsoft 365. And so it pulls it back 

into my folder structure. So with all that said, how do we actually delete this Notebook?  

Well, we need to log into the online portal. So I'm going to minimize File Explorer, and the first 

thing I'm going to do is I'm going to close down Project Artemis, because this is the one that 

we're going to delete. So I'm going to right-click, and I'm going to say Close this Notebook. 

What I'm then going to do is jump across to my Microsoft 365 portal. Now I'm already logged in. 

And for those of you that are familiar with using Microsoft 365, this should be instantly 

recognizable. And what I want to do is I want to access OneDrive from here.  

http://www.simonsezit.com/


OneNote Desktop and Windows 10 

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved. 

So I'm going to select the OneDrive icon, and then I'm going to go to my Notebooks folder. And 

this is where I have my OneNote Notebook saved. So what I need to do is select the Notebook, 

in this case Project Artemis, and delete it from my portal. And you'll see that when I delete it 

from here, it doesn't come back again. So now, if I jump back into File Explorer, you can see that 

in my Notebooks folder, I don't have that Project Artemis Notebook anymore. So essentially, it is 

deleted.  

So, this is a really important point to note if you want to delete a Notebook that you have saved 

to Cloud Storage. Now I will say that if the Notebook that you've created is the Local Notebook, 

it does work in a slightly different way. But we're going to save that for the next module where 

we're going to jump in, I'm going to show you how you can create a Locally Stored Notebook 

and then we'll look at the difference when it comes to deleting. But for the time being, that is it. I 

will see you in the next module. 
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Video: Creating and Managing Locally Stored Notebook 

 

Deb: Hello everyone, and welcome back to the course. In the last module, I showed you the 

process of deleting a Notebook that's been stored into OneDrive. So what I want to do in this 

lesson is really just talk a little bit about Locally Stored Notebooks, and show you how you can 

manage those, how you can delete them, so that you can see the difference between Local 

Notebooks and Notebooks that are stored in the cloud. So let's jump in. And let's create ourselves 

a couple of Notebooks.  

So we're going to go up to File down to New, and I'm going to recreate one saved into OneDrive 

because we did delete Project Artemis. And I kind of want to use that one. So let's select 

OneDrive. I'm going to select the folder of Notebooks. And I'm just going to call it the same 

thing. Let's call it Project Artemis, just to recreate that Notebook, and click on Create. Now, 

because I'm saving to a shareable Location, it's asking me if I want to invite people, I'm going to 

say not now, because that's something I'm going to do later. And there I have my Notebook 

opened again.  

And of course, we've already seen, we can right-click, and maybe I want to go into the 

Properties, and I'm going to change the color to blue, and click on Ok. So what I'm going to do 

next is I'm going to create another Notebook. But this time, I'm going to save it to my local 

drives, not in OneDrive. So back up to File, down to New. And this time, I'm going to browse for 

a Location to save. Now, what I'm looking for here is the Location that doesn't synchronize. And 

these days with OneNote, if you have it installed on your PC, even your Desktop will 

synchronize. So, I'm going to select a folder that I know doesn't synchronize, which is the 

Downloads folder.  

Now I know this is an extremely strange folder to save a Notebook into but as I said, I just want 

one that I know for sure doesn't synchronize at all. So I'm going to give my Notebook a name. 

I'm going to call it My Personal Notebook, and click on Create. Now, did you notice the 

difference there? It didn't ask me if I wanted to invite people to my Notebook. And that's because 

OneNote has recognized that this is a locally saved Notebook, and so it's not shareable. Another 

thing you'll notice is that if I click this drop down, you can now see both of my Notebooks in 

here.  

Now if I just make a quick change, so I'm going to right-click, and I'm going to say Properties. 

And let's just change the color of the folder again, and click on Ok. Notice this little syncing icon 

that comes up, it was pretty quick so you may have missed it. Let me do it one more time. I'm 

going to right-click, go to Properties, I'm just going to change the color of the Notebook. Look 

for this icon when I click on Ok. Can you see it just there? That tells me that the Notebook is 

synchronizing to Cloud Storage.  

Now, when it comes to locally saved Notebooks, it doesn't matter how many changes you make, 

you're never gonna get that icon because it's just saving to your local drive, it doesn't have to 

synchronize with Cloud Storage. So if you're wondering what that little sync icon is that appears 

every now and again when you're working in a Notebook that's been saved to the cloud, that's 
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what it's doing. It's just updating any changes that you've made, or any changes that other people 

have made to the Notebook with the copy in the cloud.  

Now when it comes to Local Notebooks, you can right-click, and you can change the Properties 

and exactly the same way. So I can change the Color of the icon, the Location, and the Display 

Name as well. So maybe I want to remove the word Notebook. Let's just delete that out as it's a 

bit of overkill and just call it My Personal, click on Ok, and there we go. And I can very easily 

switch between my two Notebooks.  

Now when it comes to deleting Locally Stored Notebooks, it works in a slightly different way. 

Now I still can't delete it from within OneNote. So if I right-click, I don't have a Delete option. 

So what I need to do is open up File Explorer again, and navigate to the folder where I have this 

Notebook stored. So I've stored this Notebook in the Downloads folder. You can see it there 

sitting at the top. So if I want to delete it, I can actually just delete it directly from here because I 

don't need to jump into Cloud Storage because it's just saved locally. And because there's no 

synchronization happening, it's not going to keep reappearing.  

However, the first thing I'm going to want to do is close down this Notebook. I can then jump 

into the folder, click on the Notebook, press Delete and that Notebook is essentially deleted. So 

the process is a little bit shorter, a little bit easier when you're deleting Local Notebooks. Now in 

the next module, we're going to start to actually expand on our Notebook by adding in Sections 

and Pages. So, I'm looking forward to it. I hope you are too. I'm going to head over there now, 

and I look forward to seeing you. 
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Video: Creating, Moving, and Deleting Sections 

 

Deb: So, so far in this course, we've been taking a look at some of the more admin tasks that you 

might wish to do within OneNote, such as closing Notebooks, creating new Notebooks, and also 

the process for deleting Notebooks. It's now time to move on to something a little bit more 

interesting, and that is to start to build our Notebook with content.  

Now, before we can start adding content in, we need to understand the structure of a Notebook. 

And that means talking about Sections and Pages. So currently, I'm in the Project Artemis 

Notebook. And you can see at the top, I have a tab that says New Section 1. Then if you cast 

your eyes over to the right-hand side, you can see I have Add Page at the top here. And then 

something that says Untitled Page. Now Untitled Page is currently where I'm clicked.  

Now, I'm going to speak a little bit more about Pages in the next couple of modules. But for now, 

we're going to focus on Sections and really organizing our Notebook. Now the way I like to 

think about this is I like to imagine a book, Project Artemis is the book title. And then within that 

book, I might have part one, which would be the Section. And then I would have the different 

chapters, which might be the different Pages. So these are kind of like dividers within your 

Notebook. And within each Section, you can have numerous different Pages.  

Now when it comes to Sections, there are lots of different things that you can do with them. So 

let's start out by running through some of the basics. So currently, I'm clicked on New Section 1. 

And if I right-click my mouse, you'll see that I get that Contextual Menu come up, which has lots 

of different things that I can do with this particular Section. So the first thing I have in this menu 

is the Rename option. Now, obviously, most of the time, you're not going to want to keep that 

tab as New Section 1, you're going to want to give it a more meaningful name. So I'm going to 

select Rename, and I'm just going to overtype what I have on the screen. And I'm going to call 

this Tab Meetings.  

Now what I can do here is I can either hit the Enter key on my keyboard, or I can just click away 

in order to set that. So that is my first Section. Now I want to have lots of other different Sections 

within this Notebook to store different types of information. So I'm going to add another Section 

in. And there's a couple of ways that you can do this. The most easiest, and probably the most 

obvious to everybody watching this lesson is that we have a little plus sign. And when we hover 

over it, it says Create new Section. That's going to give me another tab and I can now type the 

name of that tab. And this one is going to be called Courses, and hit Enter.  

Now the other way that I can add a new Section is if I right-click on any one of the tabs, you'll 

see that I have a New Section option down here as well, which is basically going to do exactly 

the same thing. So for this one, I'm going to call this Offices and hit Enter. And I'm going to 

carry on just adding a couple more Sections into this Notebook. So let's click the plus and I'm 

going to call this one at Travel, hit Enter. Click the plus again, and we're going to call this one 

Costs and hit Enter.  

http://www.simonsezit.com/


OneNote Desktop and Windows 10 

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved. 

So very quickly, I've been able to Add-into my Notebook, all of these different tabs and I can 

then just click on them to switch to those different Sections. And what you'll also notice is the 

Section tabs are color coded. So if you want to keep them all different colors, that's absolutely 

fine. However, if you have Sections that may be relate to each other, a nice way of just visually 

indicating that to whoever is looking at the Notebook is to make those tabs the same color.  

So maybe, both Offices and Travel are related and I want to make them both orange, what I can 

do is click on that Travel Section, right-click my mouse, and right at the bottom of the 

Contextual Menu, I have a Section Color option. So I'm I want to change this to orange as well. 

And so visually, I've now created a link between those two different Sections.  

Now of course, when you have a whole bunch of Sections added into your Notebook, there 

might come a time where you want to reorder them or rearrange them. And again, that's very 

simple to do. If you want to move a Section, all you need to do is grab that particular Section, so 

let's say the Courses Section. Click your mouse drag and you'll see as I drag back and forth 

across the Section tabs, I'm getting that little black arrow, and that's indicating to me where that 

Section is going to be dropped when I let go of my mouse. So I want this to be the first tab in this 

particular Notebook.  

So I'm gonna let go of my mouse and it moves that tab across. Another way that I can move 

Section tabs is to utilize that right-click menu also. So for example, if I take this Meetings tab, 

and right-click my mouse, within that right-click menu, you'll see that we have a Move or Copy 

option. So if I select that, I can now choose where I want to move this particular tab to. And what 

is showing here are all of the Sections that are currently in my Notebook. And all I need to do is 

select the one that I want to move this particular Section after.  

So I'm going to say I want Meetings to move after the Travel Section. So I'm going to select 

Travel, and click Move. And it's going to move that across. Similarly, if I right-click my mouse 

and just jump back into there, I might want to copy a Section instead of moving it.  

So if I want to copy this Meeting Section, and I want that copy to be placed after the Costs 

Section, I'm going to select Costs and then click copy at the bottom, and it's going to give me a 

new tab that's called Meetings 2. I can then right-click, go in, and rename that to something else. 

So we're going to call this one Schedule, like so. And you'll see that because I copied it, it takes 

on the same tab color as that particular Section.  

Now, in this case, I don't want these two to be the same color. So I'm going to right-click, 

Section Color, and I'm going to make this a purple color. And of course, I'm sure you get the idea 

now, but if you want to delete a particular Section, you can right-click, and you have a Delete 

option in here. Now, it's worth noting and you'll see this a bit later on when we start talking about 

Pages, when you delete a sanction, it's going to delete all of the Pages within that Section as well. 

So just bear that in mind before you actually execute this particular task. But more about that 

later.  
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So that is the basics of adding new Sections and a few tips and tricks there when it comes to 

managing them. In the next lesson, I'm going to talk to you about Section Groups. So I'm going 

to head over there now, and I look forward to you joining me. 
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Video: Creating Section Groups 

 

Deb: Hello everyone, and welcome back to the course. In the previous module, I introduced you 

to the concept of Sections. And we took a look at some of the things that you can do to add new 

Sections and also manage them. So we're going to kind of follow on from that in this particular 

module. And I'm going to talk to you about Section Groups and just show you what they are and 

how you can use them.  

Now the first thing I'm going to do in here is I'm actually going to delete one of these Sections 

that I've created. So I'm going to delete this Courses Section, because what I'm going to do is I'm 

going to make Courses a Section Group. So I'm going to right-click, and I'm going to say Delete. 

And I'm getting a message here saying, “Are you sure you want to move this Section to Deleted 

Notes”? So I'm going to say, Yes.  

Now that's actually an important point to know. When you do delete Sections or Pages or 

anything from your Notebooks, they don't disappear entirely, they go into what we call the 

Notebook Recycle Bin. I'm going to talk a little bit more about that later on in the course. So just 

keep that in your memory for a bit later on. So now, what I'm going to do is I'm going to create a 

Section Group. And this is really just another way of organizing your Notebooks. And this is 

particularly good if you have a lot of information in any one Notebook.  

Now, to create a Section Group, it's pretty simple. All you need to do is right-click on any of the 

tabs. And you can see you have an option here for New Section Group. And what that does is it 

gives me another little heading up here that currently says New Section Group. And you can see 

the icon next to it has all of these different tabs. So that gives you an idea as to what we're doing 

here. This is a way of grouping different Sections together. So I'm going to call this Section 

Group Courses and hit Enter. And what I'm going to do within here is create Sections within this 

Section Group.  

So if I right-click, I'm going to say New Section. And what you'll notice is something a bit 

strange, it adds it as if it's just another new Section, it doesn't necessarily fall directly underneath 

where we've created the new Section Group. So I'm going to go ahead and create my Sections 

that I want to be part of my Section Group.  

Now this whole Project Artemis is about the rollout of Office 365 across all of my company's 

global offices, and part of that rollout program is going to be training. And we want to retrain 

everyone on the applications within Office 365, or Microsoft 365, as it's now known. So I'm 

going to have a Section for each of the courses that are going to be offered. So the first Section is 

going to be called Word. I'm going to create another new Section called Excel. Another one 

called PowerPoint, we're going to have one for OneDrive, and I could carry on going.  

Now obviously, this is just a demo. So I'm going to stop there, but you could add as many 

Sections as you needed. Now once you've added in your Sections, if you want to group them 

together underneath this Courses Section Group, all you need to do is right-click, so let's right-

click on this first Section tab, I'm going to say Move or Copy, I'm going to select the Section 
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Group, which is Courses, and then I'm going to say Move. And you'll see immediately it jumps 

me from my main Notebook into this kind of sub group.  

So Project Artemis, Courses, Section Group, and there is my Section. So if I want to jump back, 

I just click that green arrow. So if I take this Excel Section, I'm going to click, I'm going to drag 

over, and hover my mouse on top of Courses, and you'll see it jumps me across, I can let go and 

it moves that Section.  

Now unfortunately, there is currently no way in OneNote to make multiple selections, so you 

can't select multiple Sections, and then move them all in one go. Unfortunately, you have to do 

them all individually. So I'm going to do the last two, let's do PowerPoints, I'm going to drag and 

drop. And then the final one, I'm going to right-click, I'm going to say Move or Copy, select 

Courses, and click on Move.  

So now, I have these essentially Sectioned off from the main bulk of my Notebook. And I have 

my Courses Section Group just there. So, if you have a particular Section that has lots of 

different subSections, then this is a great way of organizing your Notebook.  

So, we're starting to get some kind of structure to our Notebook now. We've got our Notebook 

ready, we've got all of our Sections, we've got a little Section Group on the end there, now we 

want to start adding Pages and content. And that's exactly what we're going to do in the next 

module. So I'm going to head over there, and I look forward to you joining me. 
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Video: Working With Pages and Subpages 

 

Deb: Hi guys, and welcome back to the course. This is still Deb, and we are heading towards the 

end of Section 2. And over the course of this Section, we really got to grips with some of the 

basics of working in OneNote. And in the last couple of modules I’ve shown you how you can 

add Sections into your Notebooks and also Section Groups. It's now time to start adding Pages 

because there's a couple of things that you need to be aware of when you're doing this.  

So as I mentioned, within each Section, you can have different Pages, and each of those Pages 

will contain content. So let's first walk through the process of adding Pages to Sections. So 

currently, I'm clicked on this Offices Section. Now what I want to have here is I want to have 

maybe an overview of all of the different offices which we’re rolling out Microsoft 365 to, and 

then I might want to have a specific Page that lists out each office individually with bits of 

information that are particularly important to that office.  

Now, if you cast your eyes over to the right-hand side of the screen, you'll see that you have this 

kind of orange bar running down the side. And this is where you basically create all of your 

Pages for your Sections. And OneNote will automatically create a Page called Untitled when you 

add a new Section. And that Page is currently what I'm clicked on within the Offices Section. 

Now currently, it's called Untitled, which isn't particularly meaningful. So, I'm probably going to 

want to go in and rename this Page so it's easy for me to identify.  

So, my first Page in this Section is just going to be called Overview. So, I've clicked my mouse 

just above where we have the Date and Time, and I've typed in the word Overview. And you'll 

see as soon as I do that, over on the right-hand side, the Page is now renamed. So I'm going to go 

through and I'm going to add a few more Pages. And we do that by clicking on the Add Page link 

at the top of that right-hand pane. So let's click on Add Page, you'll see automatically I get 

another Untitled Page, and I can now type a title for this particular Page.  

So this one is going to be called Europe, I'm going to add another Page called North America, 

another Page for Asia, another Page for Africa, and then one final Page for Australia. And as we 

move through this course, I'm going to be adding information onto these Pages. So adding Pages 

in itself is a very simple and straightforward process. But what you might not know is that you 

can also add Subpages. So for example, underneath each of these Pages, which I've just created, I 

might want to have Subpages for each of these specific office locations in each of these regions.  

So what I'm going to do is I'm going to add a Page, and you'll see it adds it to the bottom, and I'm 

going to call this one London. I'm going to add another Page, I'm going to call it Paris, I'm going 

to add another Page, and let's call this New York. And I'm going to add two Pages for each of the 

regions. And we'll do Bangkok. And we'll say Durban. Then finally, for Australia, we will have 

Sydney, and Melbourne. So you can see that now I have quite a collection of Pages. And at the 

moment, they're not really organized as I want them to be.  

So the first thing I'm going to want to do is I'm going to want to move the Pages I've just created 

underneath their relevant locations. So for example, we've got London and that needs to go 
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underneath Europe. So all I need to do to move a Page is click, drag, and you'll see I get that line. 

Let go, and it's going to move that Page. I'm going to grab Paris, and we're going to do the same 

thing. We're going to move that up.  

Now of course when I'm moving these, I can go to the right-click menu and Move or Copy. But 

for me, by far, the quickest way of doing it is just simply to drag and drop them. So I'm going to 

move New York and Chicago underneath North America. And for Pages you can actually move 

multiple Pages in one go. So, I want to move Shanghai and if I hold down my control key I can 

also select Bangkok. And then I can move both of those underneath Asia. So I'm going to do the 

same for Durban and Johannesburg, hold down Control, drag and drop. And then finally the 

bottom we have Australia with Sydney and Melbourne.  

So these look slightly better, but the structure still isn't quite there. Because essentially, these city 

Pages that I've added are Subpages of the continent. So I want to indicate that these are in fact 

Subpages. And again, there's a couple of different ways that we can do this. The first thing I can 

do is if I click on London, if I click my mouse and just drag to the right very slightly, you can see 

I can indent it. So this is a Subpage, so I'm going to indent it once. And I could do the same for 

Paris, click drag once, and that essentially makes London and Paris Subpages of Europe. And the 

structure is now reflecting that.  

Now I can do this a slightly different ways. So let's select New York, hold down Control and 

also select Chicago. If I right-click, I can say Make Subpage, and it's going to move both of those 

in. I'm going to select Shanghai, Bangkok, Durban, Johannesburg, Sydney, and Melbourne. And 

I've done that, again, simply by holding down the Control key as I'm clicking, right-click, Make 

Subpage, and it's going to move all of those in in one go.  

So right away, I now have a much better structure, it's a lot easier for me to see what's going on 

here. And as you can imagine, you can have Subpages of Subpages as well. So if I just show you 

a quick example, if I add another Page, and let's call this St. Kilda, which is a very specific area 

in Melbourne. What I might want to do is make the St Kilda Page a Subpage of Melbourne. So 

again, I can click on it, I can drag once, twice, to make that a Subpage of a Subpage. And you 

can carry on going making whatever structure it is that you need. And of course, if we right-

click, we now have that Contextual Menu come up. So everything in here is related to Pages as 

opposed to Sections or anything else.  

You can promote the Subpage. So that's essentially pulling it back up a level. Or you can 

collapse all Subpages for whichever one you're clicked on. So for me, that was Australia, its 

collapsed them all up, I can then click that drop down arrow to bring those back again. I can 

right-click, I can Move or Copy, I can Add a New Page from here as well, and you could also see 

the keyboard shortcuts in there.  

Now I'm actually going to delete this Page. So let's select Delete, to bring me back to how we 

were. So I've got a pretty good outline or structure going on on this Offices Section. And of 

course, I can go to each of these Sections and start adding in different Pages. You don't 

necessarily have to do that before you add content, you can definitely do it as you go. But for me, 
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on this particular Section, it works best if I set them up beforehand. So that's how you can very 

simply add Pages to a Section and also make Subpages and that draws this Section to a close.  

In Section 3, this is where the fun begins. We're going to start adding all different types of 

content into our Notebook so you can get a really good feel for the application and what it can 

do. So, I'm really looking forward to this Section. I'm going to head across there now and I look 

forward to you joining me. 
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Video: Windows 10 Getting Started 

 

Deb: Hi, guys and welcome back to the course. Now as I mentioned in the introduction, at the 

end of each Section, I'm going to also throw in a module using OneNote for Windows 10. 

Because, this is something that is available for free, and comes automatically installed for 

anybody who has Windows 10 on their PC or laptop.  

So in general, what we tend to find is that if somebody doesn't have a Microsoft subscription, 

necessarily, they can still utilize OneNote, but the Windows 10 version. So in order to cater for 

those people who are using this version, I'm just going to do a module at the end of each Section, 

just recapping the main points in that particular Section. So let's get started with our first look at 

OneNote for Windows 10.  

So, if you do have a Windows 10 device, you'll probably find that you already have OneNote 

preinstalled. So, I'm going to jump down to Search and I'm going to type in OneNote. And you'll 

see the first one that comes up is OneNote for Windows 10. So let's click to open this app and 

take a look at the differences.  

So immediately, what you'll notice is that the look and feel is completely different to OneNote 

for Desktop. So first of all, let's take a quick look at the interface. Now we still have essentially a 

ribbon structure. But our ribbons look slightly different, they're a bit more compact. We have a 

Home ribbon that has all of our basic formatting options on it. And Insert ribbon if we want to do 

things like insert Tables, Files, Pictures, a Draw ribbon for making annotations, and inserting 

shapes.  

A View ribbon for doing things like Zooming in and out, changing the Page Color, adding Rule 

Lines, so on and so forth. And then finally, we have a Help ribbon that's going to allow us to 

access Help On Demand if we need it. And then all the way over in the right-hand corner, we 

have some icons. So this first icon here allows me to Open a Feed. So this is basically going to 

allow me to see a feed of all activity that's going on in my OneNote Notebook. I then have this 

little light bulb icon which is basically my Search.  

So this is the Tell me what you want me to do pane, I have a Notifications area, where I can see 

exactly what's going on in my Notebooks, I have a Share button that's currently grayed out, I can 

choose to enter Full screen mode. And then I have three dots in the top corner or ellipses that's 

going to allow me to access my Settings.  

Now when it comes to actually viewing my Notebooks, if you cast your eyes over to the left-

hand side, this first icon just here is the Show Navigation button. So if I click this, this is going to 

open up a pane where I can view all of my Notebooks. Now I haven't created a new Notebook 

yet. So that's why there's nothing in there. But when I do, this is where you'll find them, and this 

is how you can switch between your Notebooks. So let's start out by doing exactly that. And 

there's a couple of different ways that you can create Notebooks in OneNote for Windows 10.  

If you take a look in the big empty space in the middle where it says Start taking Notes, it says; 

“Tap or click here to create a new Notebook. You can also open one of your existing Notebooks 
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from the Notebooks list”. So that's an important point. If I click the drop down where it says 

Notebooks and then click on More Notebooks, it's gonna allow me to open an existing Notebook 

that I have saved off. So if I want to go in and open up the Project Artemis or Personal, I can do 

that simply by clicking on that Notebook and then opening it.  

Now in this case, I actually want to create a brand new Notebook so I could click somewhere in 

this center pane, select a name for my Notebook and then click Create Notebook. Alternatively, I 

could right-click up where it says Notebooks and select New Notebook. Or, if I click on 

Notebooks right at the bottom, I have a plus symbol that says Add Notebook. So I'm going to 

call this Notebook Project Sierra. I'm going to select an account and click on Create Notebook. 

So now I have my new Notebook. And it's created a new Section with a default name and also an 

Untitled Page for that Section.  

Now of course, I'm going to want to rename this particular Section. So I can right-click my 

mouse to pull up the Contextual Menu and say Rename Section. Now I'm going to call this ToDo 

List, and click away to set that and then I can name my Page. So let's say Today's List. What 

you'll notice is right at the bottom if you want to start adding more Sections and more Pages, you 

can. So I'm going to click Add Page, Tomorrow's List. Add Page Next Week's List, so on and so 

forth. And I can do the same with Sections.  

So let's say Add Section, Things to Remember. And then maybe I want to name this Page 

Emails, so on and so forth. So, pretty easy to create Notebooks, Sections, and Pages. And of 

course, if you click that drop down, this is where you're going to see a list of your Notebooks. 

And if I had more than one, I can easily switch between them from up here. If I right-click on 

this Notebook, you can see that I have other options that are similar to the Desktop version. For 

example, I can change the Notebook Color to something that's a bit brighter. So let's say pink. 

And another thing I can do here is if I want to close this Notebook, and essentially remove it 

from my list, if I right-click, I have an option to close the Notebook from here.  

Now when it comes to things like sorting or moving, rearranging Sections and Pages around 

again, the process is very simple, it's just drag and drop. So if I want to reorder these Pages, for 

example, if I want to move Tomorrow's List above Today's List, I can click and drag just to 

reorder those. The same thing goes for Sections. So I can click on Things to Remember and drag 

it above ToDo List just to reorder those items. I also have a Sort button over here. So I can sort 

these Pages in alphabetical order by Date Created or Date Modified.  

Now you can also create Subpages in this version of OneNote. So let me Add-in a couple more 

Pages, I'm going to call this one Monday. Let's add another one and call it Tuesday. And what I 

want to do is make Monday and Tuesday Subpages of Next Week's list. So what I can do here is 

select both Monday and Tuesday, right-click my mouse to pull up the Contextual Menu, and you 

see all of the different options you have in there related to Pages. So I can Delete my Pages, I can 

Cut, Copy, and Paste, I can Move them to other Sections, and I can also make these two selected 

Pages, Subpages. So, let's click that option.  

You can see that they indent very slightly, and Next Week's list is now a collapsible and 

expandable menu item. And of course, if I want to go in and right-click and say, Move this 
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particular Page, I can then select where I want to move it to. So let's say Things to Remember, 

and I can say Move, it's going to move that across. And now when I click on Things to 

Remember, I can see that Page sitting there.  

So in this case, it's really important where you're clicked when you right-click. If I right-click on 

a Section, I get a Contextual Menu full of options related to that Section. Whereas if I right-click 

on a Page, I get a completely different Contextual Menu that allows me to select options related 

to managing this particular Page.  

Now what I'm going to do here is select Tuesday, right-click, and say Delete Page. And if at any 

point when you're working in OneNote for Windows 10, you want to get rid of this navigation 

pane to give yourself a little bit more room, if you click on the Hide Navigation icon, it's going to 

minimize that down and now you have loads of room from which to type your notes.  

So that is it. That is all the information that you need in order to get started working in OneNote 

for Windows 10. 
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Section 3– Creating a Note 
 

Video: Creating a Note 

 

Deb: Hello everyone, and welcome back to the course. We're down to Section 3 now. And in 

this Section, we're going to explore all the different tools that you have available for adding 

content into your Notebook. And really, this is what a Notebook is all about. Of course, once 

we've created our Sections and our Pages, we're going to start to want to add content to each of 

those Pages.  

And in OneNote, there are so many different types of content that you can Add-in, so that what 

you end up with in the end is a really nice, functional, informative, and interesting way of storing 

notes. And throughout most of this Section, we're going to be focusing on the Insert tab up here. 

Because this is where you'll find all the different types of content you can insert into your 

Notebook.  

Now before we get onto some of the more interesting and exciting aspects of OneNote, we're 

going to start out with the basics, and that is adding a Text Note onto a Page. Now that might 

seem fairly straightforward, I have my cursor flashing flush with that left-hand margin. And as 

you could probably imagine, I can start typing a note. And that is very true. Now when you type 

a Text Note in OneNote, it does work a little bit differently to something like Word.  

In Word, when we have a document open, we start typing from the left-hand margin and work 

across the Page. And unless we use things like Tabs, or maybe Indents, we're pretty much limited 

to starting our typing from the left-hand side of the Page. Now OneNote works in a slightly 

different way. Because what you can see is I can literally click my mouse anywhere on this Page, 

my cursor starts flashing, and I can start typing. So it has much more of a scrapbook-like quality.  

So what I'm going to do is I am going to click over towards the left-hand margin, and I'm going 

to start to type my first note on the Overview Page. So this is my first note, just a little bit of 

information about the rollout. And what you're seeing is that when you type in a Text Note, it 

kind of puts it in this little placeholder, and this is kind of like a movable textbox in a way. You 

can see that if I hover over the gray bar that runs across the top, I get our crosshair. It just means 

I can pick this note up and I can literally drag and drop it anywhere on the Page that I like.  

So, it is a lot more flexible than when you're typing text directly into a Word document. What 

you'll also notice is that on the end here, I have these two arrows. And that just allows me to 

resize this placeholder. So, I can drag it in if I want to make it smaller, and drag it out if I want to 

make it wider. And as you would imagine, if I right-click my mouse on this gray bar, I get a 

Contextual Menu that has options in it relating specifically to this particular placeholder and the 

text contained within it.  

Now if I want to edit any of this text, I just click back in the placeholder. And I'm going to add a 

little bit of a title here, I'm going to hit Enter. And let's call this Rollout Dates. And of course, I 
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can treat this like any other text across all of the Microsoft applications, and I can apply 

formatting. Now if we jump up to the Home tab, this is where you'll find all of your text 

formatting options. So it might be that I want to change the Font Style of all of this text.  

Now what I can do there is because the text is contained within one placeholder, I can just select 

that placeholder, I can jump up and I can change this to something else. So I'm going to do my 

favorite font Segoe UI, hit Enter, and it's going to change that. And if I want to make this 

heading stand out a little bit, I can maybe make it slightly bigger. So let's make that 12. And I 

might want to make it bold, I can change the color, I can do all different kinds of things. And if 

you've used any of the other Microsoft applications, you'll know that this is fairly standard when 

it comes to font formatting.  

Now I'm going to add a little bit more text into here. So I'm going to press Enter a couple of 

times. And now I'm going to add some bulleted text. So again, up to the Home tab, into that basic 

Text group, and we're going to utilize our bullets, and I can add my bulleted text much like I 

would in any other application. Now everything that I've typed so far has been contained within 

this one placeholder. You don't have to carry on typing absolutely everything within the same 

placeholder. You could click somewhere else and start to type in some more text, like so. And 

then I'm going to add some more Bullet Points in, like so.  

Now one thing you'll notice here is that as soon as I started typing in a different placeholder, it 

switched back to the Default Font, which for me is Calibri. So if you want to keep things 

consistent, then you'll probably have to go in and change that font to match the rest of the font in 

this particular document. I can then pick that up and I can drag it underneath. So what I'm trying 

to say here is don't think that you're limited to just always typing in one placeholder, you can 

have multiple going on on the same Page.  

Another thing you can also incorporate into your Text Notes is that you can utilize Styles, and 

you'll find those on the Home tab in the Styles group. And this can sometimes make it a little bit 

easier to achieve a level of consistency when it comes to the headings that you're using in your 

Notebooks. So for example, instead of going through and manually formatting the headings, like 

I did with Rollout Dates, I could select the Heading and utilize a Style instead, which has 

preformatting already applied.  

So I could say Heading 1 to change that. And I know that every time I add a Heading 1 is going 

to look exactly the same throughout the entire Notebook. So don't forget about those you have 

Headings 1 to 6. And you also have other styles in here for Page Title, Quotes, anything else that 

you want to Add-in.  

Now the final thing I'm going to do in my Text Notes is I'm just going to highlight the dates that 

this rollout is going to start and end, just so it's super clear to everybody who is looking at this 

Notebook. So I'm going to highlight January the first 2021, and I'm actually going to apply some 

highlighting, like so.  

Now I want to apply the same highlighting to the 31st of July 2021. So I could repeat the same 

process. Alternatively, I could utilize the Format Painter. So I'm going to highlight January the 
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first 2021, I'm going to go up to the Home ribbon and select Format Painter, let go, and it's going 

to apply that highlight for me. So Format Painter is a great tool if you just want to copy 

formatting from one piece of text to another, it can save you a lot of time, particularly if you 

have a lot of manual formatting applied to a specific piece of text or paragraph. And we're going 

to be utilizing Format Painter quite a lot as we work our way through the course.  

So, for the time being, that is the basics of adding in a Text Note into your Notebook Page. Over 

the next few modules, we're going to move into adding all different types of content in and we're 

going to start out by taking clippings from webpages and pulling those into our Notebook. So, 

I'm going to head over to the next module now, and I look forward to seeing you there. 
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Video: Sending Content to OneNote 

 

Deb: Hello everyone, and welcome back to the course. We're down in Section 3, where we're 

talking about adding content to OneNote. And in the previous lesson, I showed you the very 

simple task of adding Text Notes to your OneNote Pages. So we're going to move up again now, 

and we're going to start to add content from other sources.  

Now, there are many different ways that you can do this in OneNote, and we are going to explore 

all of them over the balance of this Section. But I want to start out by introducing you to a little 

tool that you can install, that's going to make your life a lot easier in certain respects. And that is 

the Send to OneNote tool.  

Now you won't find this when you're actually working in OneNote, there is no button on any of 

the ribbons called Send to OneNote. This is a little app that you can install, which makes it super 

easy for you to send things like Excel Spreadsheets, or Word documents, or even emails directly 

to a specific Page in OneNote. So I'm going to show you first of all, how you can install the app, 

it's very, very simple. And then I'm going to show you how to use it.  

So the first thing you're going to want to do if you don't have this app installed, is just open up 

your preferred web browser. So for me, that is Microsoft Edge, and then search for Send to 

OneNote app, and hit Enter. And the first link you're going to get takes you to the Microsoft 

webpage. And you can see, there it is, Send to OneNote, we have a little description underneath. 

So it says; “Send to OneNote lets you print from any app to a OneNote Page. Once it's in 

OneNote, you can access it from any device even if you're offline”.  

So this is also great if you have maybe something like a PDF document, and you want to bring 

that information into your OneNote Page, so it's viewable to everyone. So what you do from here 

is you can see over on the right-hand side it is actually a free app, which is always good. I'm 

going to click on Get, and that's going to ask me to open the Microsoft Store. 

So it's jumping me across to the application within the Microsoft Store. And from here, I can 

install it. Now the first thing you'll notice is that I actually already have this product installed. If 

you don't, what you'll see here is an Install button where I currently have Wish list.  

So, all you need to do is click Install, it takes a few seconds for that to download. And that is 

pretty much it. Once you've done that, you are good to go. So, let's take a look at how we would 

then use it. So, I've jumped across to Outlook just to show you an example of how you can 

utilize Send to OneNote. Once you've downloaded and installed the app, and you might have to 

restart your applications in order for this to show.  

But for example, on the Home ribbon in Outlook, you can see in the Move group, I now have 

this little icon here, Send to OneNote. And that's going to allow me to directly send any email 

message that I have selected to a specific Page in my OneNote Notebook. So I can see here that I 

have an email, which is all about Team Leader Assignments for this rollout project. And it has a 

File Attachment there as well. So this is important information that everybody is going to need to 

know. So this would be great content for me to Add-into my Notebook.  
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So I'm going to click the OneNote button, and you can see what I get. So underneath all 

Notebooks, I have Project Artemis. Now I'm going to click on the plus to expand that out. And 

you can then see all of my different Sections and Tabs. Now if I have a specific Page in OneNote 

that I want to send content to, I can expand for example, the Offices Section and see all of the 

Pages that I have underneath there.  

So what I might decide to do is select the Overview Page, click on Ok, and there we go. You can 

see that I now have that email added into my OneNote Page. It's telling me the subject, who it's 

from, who it's to, the date it was sent, and I also have the attachment just here.  

So what I can do is double-click on this attachment, and it's going to open it up. And the cool 

thing about this is if any changes are made to this particular Spreadsheet, those are going to 

update because you're essentially you've just created a link to the original Spreadsheet. Now it 

might be that now that I have this email on the Overview Page, I think to myself, actually, you 

know what, this needs to go on a different Page.  

So what I might want to do is create a new Section. Let's click on plus, and I'm going to say 

Important Emails, and I'm going to call this Page, Team Assignments. And what I'm going to do 

is I'm simply going to move that content across to this new Page. Now I can do that by selecting 

the placeholder, and the simplest way of doing this is to do a Cut and Paste.  

So I can either jump up to my Home ribbon and select Cut from there, or I can utilize the 

keyboard shortcut of Ctrl + X. I'm going to jump across to Important Emails and the Team 

Assignments Page, I can do Ctrl + V to paste or select my Paste button just to paste that in. So, a 

nice simple way of adding content using that Send to OneNote tool.  

And just to show you another example of how you can utilize this, if I had this information in a 

Word document as opposed to an email, I can also send this directly to OneNote as well. So any 

content you have in Spreadsheets, documents, PowerPoint presentations, once you've installed 

this app, when you go to the File area, and go down to Print, underneath Printer, you can select 

OneNote Desktop.  

And then when you click on Print, you're going to get the same thing. You need to select a 

location in which to print this piece of content to. So, I'm going to expand Offices again, I'm 

going to select Overview and click on Ok. And you can see exactly what it does there it's going 

to pull that information in.  

Now one of the drawbacks of this, which you can see immediately is that it's brought it in with a 

load of whitespace at the bottom, so everything else gets pushed down underneath. Now I have 

scoured the internet trying to find a way to get around this and there doesn't appear to be any 

particular method of cropping out all of that whitespace. So, just think about that before you 

utilize it to send Word documents and Excel Spreadsheets to your Notebook.  

But for now, that is how you utilize Send to OneNote. In the next lesson, I'm going to show you 

how you can use OneNote’s Clipping tool. So I'm going to head over there now, and I look 

forward to you joining me. 
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Video: Using the OneNote Clipper  

 

Deb: Hello guys and gals and welcome back to the course. We're down in Section 3, where 

we've been taking a look at how we can add different types of content to our OneNote Notebook. 

And in the previous module, we saw how we could download and install the Send to OneNote 

app in order to send documents, different Files, PDF content to OneNote.  

Now we're going to stay along similar lines. And when we say similar lines, I just mean that 

what I'm going to show you next is also an app that you have to install. And that is the OneNote 

Clipper. Now OneNote Clipper is pretty much the same as any other clipping utility that you 

might find in Microsoft applications.  

Most of the applications these days contain some kind of Screen clipping tool, which makes it 

super easy for you to grab content off of different applications or maybe even web browsers, and 

pull that into whichever application you happen to be working in. Now the cool thing with 

OneNote is that there is a specific Clipper extension that you can Add-into your browser to make 

clipping things off the web super easy to pull into a specific Page in OneNote.  

So what I'm going to do in this module is to show you where you go to install the OneNote 

Clipper, and then we'll do a quick demonstration. So the first thing you need to do is open up a 

web browser of your choice. And for me, I'm using Microsoft Edge, but you could be using 

Chrome, Firefox, Safari, whatever it is that you choose. Now, depending on what your web 

browser of choice is will depend what you search for when looking to install the OneNote 

Clipper.  

So for me, because I have Edge, I would search for OneNote Clipper app Edge. If you're using 

Chrome, you might want to type in OneNote Clipper app Chrome, so on and so forth, just to 

make sure that you get the correct download. So I'm going to click on Search, and I'm going to 

click on this link just here, which is going to jump me across to the Microsoft Store.  

Now what you'll see here is the Web Clipper app. And because I've already installed this, I only 

have a Remove button. If this is the first time that you're using this, then you'll have an Install 

button just here. So you just need to click it, run through the process. Again, it just takes a few 

seconds, it's a very small, little app. And once you've installed it, you should then see a button in 

your web browser in the toolbar running across the top that says Clip to OneNote. And you can 

see mine just there.  

So, once you have it installed, let's take a look at how you can use it. So, I've just jumped across 

to the Microsoft 365 homepage. And this is a webpage that just gives me some information about 

Microsoft 365 and the different subscription plans. So maybe I want to Add-into my document 

some information related to the business plans for Microsoft 365. So, I'm going to scroll down 

and see if anything takes my fancy. And I can see here we have some information relating to the 

costs of subscriptions.  

So this might be something that I want to Add-into my rollout plan for when we're trying to work 

out our budget. So what I can do is I can clip this information and send it directly to a Page in 
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OneNote. And I'm going to do that by clicking on my Clip to OneNote tool. Now if this is the 

first time that you're using it, it's going to ask you to sign in with a Microsoft account. Now once 

you've signed in, you're going to have a few different options when it comes to clipping. And by 

default, it's going to clip a Full Page.  

So, if I wanted to send everything on this Page to OneNote, that is my default option. Now in this 

particular case, I don't want to send the Full Page, I just want to select a Region. So, let's select 

Region. And you'll see it says; “Drag and release to capture a screenshot”. The other thing you'll 

notice is that the Page background has kind of faded out very slightly, and my cursor has 

changed to a crosshair. So this means that I can just click and drag over the Region that I want to 

clip. And you can see it adds it to this clipboard, ready to send to OneNote.  

Now if I have lots of different things that I want to clip off of a certain webpage, then I can just 

select to add another Region, and then scroll through and find the next piece of information that I 

like to clip. So, let's say for example, I want to Add-in this, I'm going to select it, and it's added 

that to this clipboard as well. And I could carry on going collecting different pieces of content. 

Now once I'm finished and I want to send these to my Page in OneNote, I then need to select the 

location.  

So if I click this drop down, you'll see it's going to show any OneNote Notebooks that I have and 

the one that we're working in is Project Artemis, so I'm going to click to expand. And then I can 

see all of my different Sections. Now with this, you can't select a specific Page, you can only 

select a specific Section. So I'm going to select Offices, and I'm going to say Clip. It goes away, 

it clips those Regions, it tells me it's been successful, and I can either choose to view in OneNote, 

or I can just pull it up from my taskbar.  

And what you'll then see is if you look at all of the Pages for this particular Section, right at the 

bottom, I have a new Page. And when I click on it, it's labeled it Microsoft 365 for business, and 

there are my clips. And another really useful thing that it does is it gives you a direct link back to 

the Page where these clips came from. So if you essentially want to view the source, or maybe 

read more information, you have the link there. You can simply click on it, and it's going to jump 

you back to that specific Page.  

Now, of course, because you weren't able to select a Page in your Notebook to send this to, you 

might want to do some rearranging at this point, you might want to copy and paste this 

information into a different Section. So I'm going to select this entire placeholder simply by 

clicking on it, and I'm going to do a simple Cut from the Home ribbon.  

I'm going to go to the Overview Page, I'm going to click my mouse at the bottom, and I'm going 

to say Paste, and that then paste that content in. I can resize it to make it a bit neater, but I 

essentially have my nicely clipped content with a link back to the original document.  

Of course, what I would then need to do would be to go in and delete that temporary Page. So 

over in my Pages list, I'm going to select it, right-click, and I'm going to say Delete just to get rid 

of that. So very simple and very straightforward to utilize that clipping utility.  
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In the next module, I'm going to show you how you can add Pictures and Video to your OneNote 

Notebooks. So I'm excited, I hope you are too. Please join me in the next module for that. 
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Video: Sending Screen clippings 

 

Deb: Hello everyone, and welcome back to the course. We're down in Section 3, where we're 

talking about adding content to our OneNote Notebooks. And in the previous module, I showed 

you how you can utilize the OneNote Clipper app in order to clip the information content from 

the web and pull it through into OneNote. So now what I want to do over the course of the next 

few modules is show you how to add Pictures, Video and different types of content into your 

Notebooks. So for this, we're going to need to be on the Insert tab. And we're going to focus on 

this Images group just here.  

Now the first thing that we have in Images is a Screen clipping utility. Now you might be 

thinking to yourself, well, why on earth would I need that, you've just shown me how to use the 

OneNote Clipper? Well, the OneNote Clipper is an installation for your browser, so essentially 

only really allows you to clip content from the web. Now, the Screen clipping utility that you 

have available within OneNote allows you to clip anything that you have open on your PC.  

So maybe you want to clip something from a PDF document, or maybe an Excel Spreadsheet, or 

from a PowerPoint presentation, pretty much anything that you can open on your PC, you can 

clip using the Screen clipping utility within OneNote. And you can see as I hover over here, we 

get the ScreenTip that tells us what this is going to do. So it's going to allow us to take a snapshot 

of parts of your screen and add it to the Page.  

It says; “OneNote will hide while you capture webpages, documents, or anything else”. And one 

interesting point to note that we're going to get onto a little bit later when we cover Searching is 

that OneNote can search for text in Screen clippings. And that's a really cool little feature. If you 

clip something so maybe a paragraph of text, you can make it searchable. But more on that 

specific aspect a bit later on. Let's concentrate on utilizing this Screen clipping utility.  

Now what I've done here is I'm still in the Offices Section, but I'm clicked on the London Page, 

and I've added a Text Note that gives the address of the London office. Now what I might also 

want to do here is maybe Add-in a map that shows where the office is located. So I've opened up 

Google Maps, and I've navigated to the address of the office. And maybe what I want to do is 

take a Screen clipping of a certain Section of this map. Now because this is in a web browser, I 

definitely could utilize my Clip to OneNote utility. But I'm going to do this a slightly different 

way, I'm going to utilize the Screen clipping option.  

Now one of the things that you have to be careful of here is that whatever it is that you want to 

clip needs to be opened directly behind OneNote. Because what happens is as soon as you click 

on Screen clipping, it minimizes OneNote and allows you to clip whatever it finds behind it. So 

if you want to clip a Section from a Word document, you need to make sure that that is directly 

behind OneNote. So the way that I do this is I want to clip this, so I want to have it as the last 

thing open. And then I'm going to open up OneNote on top of it. So, let's click on Screen 

clipping.  
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You'll see it minimizes down and shows what's directly behind it. My screen has kind of faded 

away, and I have my cursor as a crosshair. So I'm going to clip a certain Section of this particular 

map and pull it through to OneNote. So let's just drag a big region over here and I can see 

Ropemaker Street in the middle. Let go and like magic, it pulls it directly into my Page. What 

you'll also see when you take a Screen clipping in this way is that you have underneath the date 

and time that this Screen clipping was taken.  

Now if you don't want this Screen clipping information, you can delete it out. And the easy way 

of doing that is as I hover over this text, you'll see I get this little arrow or tab at the side. If I 

click on that, it's going to highlight that text and I can just press the Delete key to get rid of it. I 

can of course then click on the image and I can resize it if it's a little bit too big. And as I 

mentioned at the beginning, if I right-click on this image, I can choose to make the text in the 

image searchable.  

Now I'm not going to do that right now because we're going to do that a bit later on. But just hold 

that piece of information in your minds until we get to that Section. Let's do another Screen 

clipping but this time of something that's not on the web. Now earlier, I showed you how you 

can send a Word document to your Page in OneNote utilizing the Send to OneNote tool under 

File Print. But if you remember when we do it that way we get a lot of white space in the bottom. 

So what I could do instead is use the Screen clipping utility just to clip out that part of the Word 

document.  

So again, I need to make sure that I have the word document open directly behind OneNote, I'm 

going to jump to Screen clipping, it minimizes down and I can then just clip this specific area 

and pull that through. So you can see that's a much neater way. I don't have loads of blank space 

at the bottom, and once again, I can resize that as necessary.  

So, Screen clipping is a tool that I use all the time in OneNote just to grab different pieces of 

content, I find it a lot quicker and a lot easier than other options. And if I'm adding content where 

I'm not too concerned about it being updated dynamically, then Screen clipping is just a great 

way to get information into a Page.  

In the next module, we're going to start adding some life to our Pages by adding Pictures. So, 

please join me for that. 
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Video: Adding Pictures and Online Pictures 

 

Deb: Hi guys, and welcome back to the course. This is still, Deb and we are still down in Section 

3, where we're looking at the different methods that you can use to add different types of content 

into your OneNote Notebooks. And so far, we've seen how we can add Text Notes, we've seen 

how we can add Screen clippings. And now I want to show you how you can insert Pictures into 

your Pages.  

So once again, for this, we're going to be working predominantly on that Insert ribbon. And we're 

sticking within this Images group. Now you'll see within here, we have two options, we have 

Pictures, and we also have Online Pictures. So if you have a particular image that you want to 

Add-into your Notebook, and you have that image already stored off locally, maybe into your 

My Pictures folder, then you would use this option just here.  

However, if you want to browse online for a Picture to use, you could do that through the Online 

Pictures option. And I'm going to show you an example of both of these. So let's start out with 

Pictures that I have already saved off. So currently, I am clicked on the Europe Page within the 

Offices Section. And what I have on this Page is just some suggested activities for free time in 

both of the European office locations, so London and Paris.  

So, if this is a rollout project where maybe sending trainers to these different offices around the 

world, and those trainers might have to stay there for a couple of weeks, they're going to have 

some free time, we want to give them some ideas of things they can do whilst they're there. And 

in order to illustrate that point, make it a little bit more interesting, we're gonna add some 

Pictures in.  

So you can see here I have Free Time Suggested Activities, and I've applied a Heading 1 style to 

that particular piece of text. I then have London underneath, and I have a Heading 2 style applied 

to that. And what I now want to do is Add-in a couple of Pictures of some of the main sites in 

London. So I'm going to jump up to the Insert tab, I'm going to jump into Pictures, and it's going 

to open up File Explorer.  

So all you need to do now is navigate to whichever folder you have those Pictures stored in. And 

there we go, I can see a selection of Pictures. So I'm going to Add-in Tower Bridge, I'm going to 

hold down Control, and also select the London Eye and click on Insert. And it's going to pull 

both of those Pictures through.  

Now one thing to note when you insert multiple images in this way is that they will become part 

of the same container, the same placeholder. So maybe if I want this bottom image to be next to 

this image of the London Eye, if I click on it, when I drag I'm essentially dragging it out of that 

particular placeholder. Now you might think to yourself, well, why is that a problem?  

Well, if I then wanted to add some more text in, if I hit Enter a couple of times, it's going to 

move down one image, but this image is going to stay where it is. So just be aware of that if you 

do drag an image out of its original placeholder, you may have to reorganize its placement on 

your particular Page.  
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Alternatively, I'm going to Ctrl + Z a couple of times just to put this back how it was. So now 

what I might want to do here is click next London, press Enter a couple of times, and then just 

add some Bullet Points, which has London Eye, Tower Bridge. And of course again, if you don't 

like the font, you can go in and change the font for any of the text in your Notebook. Now what 

I'm going to do is I'm going to click somewhere over in this blank space on the Page, and I'm 

going to create another placeholder and this one is going to be called Paris.  

I'm going to double-click and give that a Heading 2 format so it matches London. I'm going to 

drag the placeholder out and just reposition that very slightly. Now when it comes to lining 

things up because really I want this Paris heading in line with this London heading, you are a bit 

limited with options. But one thing I will generally do is jump across to the View tab and turn on 

Rule Lines. So, this just gives me some paper lines running across the Page, and I just find it a 

little bit easier to line things up when I have these turned on.  

So now I'm going to add some Bullet Points. We're gonna have Eiffel Tower and Sacre Coeur. 

Let's apply some formatting so it matches the rest of the document. And now I'm going to Add-in 

my Images. So up to Insert, across to Pictures, it's going to default to the last folder that I was in, 

I can pick up the image of the Eiffel Tower, hold down Control, select Sacre Coeur, click on 

Insert, and it's going to add those images in for me.  

And of course, these images can be resized if you need to do that. But there we go, fairly 

straightforward to insert Pictures that you have stored off locally. So now let's take a look at how 

we can Add-in Online Pictures.  

Now this is pretty much exactly the same as jumping into Google or a different web browser, 

googling an image, saving it off and inserting it but it's just a little bit quicker as we're missing 

out some of those steps. What I can do is click on Online Pictures, and it's going to jump me 

across to an image gallery browser, which is powered by Microsoft Bing. And what I can do is I 

can utilize images in any of these galleries. Alternatively, if I know what I'm looking for, I can 

just type my search term into that Online Pictures search bar.  

So I'm looking for an image of Big Ben. I'm going to hit Enter, and there you go. So let's select 

this one, and click on Insert. And it's inserted that very nicely into the bottom of this document. 

I'm going to do the same thing, but I'm going to add an image for Paris this time. So let's jump up 

to Online Pictures once more, and I'm going to type in notre dame, and hit enter. This image 

looks pretty good to me, I'm going to select it.  

But one thing I want to point out here is when you are adding Online Pictures into your 

documents, it's really important that you check this little setting just here. You want to make sure 

that you're searching and using only images that have a Creative Commons license. So, it 

basically means you can use that image for not-for-profit reasons. So if this is just a OneNote 

team Notebook that's going to be shared between me and maybe three of my colleagues, then 

that's absolutely fine. Any of these images I can use because I'm filtering for Creative Commons 

license.  
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Now, even when you have this filter on, if the Notebook that you're adding it into is going to be 

used for any kind of commercial purpose, so if you are going to demonstrate this to a wide 

audience, or if you're going to create a YouTube Video, something that you're going to get 

money from, then you need to delve a bit further as to whether you can use this image. A lot of 

people make the mistake when it comes to copyright by thinking that if they have Creative 

Commons selected, they can use any image that comes up in any type of document. And that's 

simply not the case.  

And a lot of people have been caught out by this. If you're using it for a noncommercial purpose, 

then yes, normally, it's fine. But otherwise, you might want to review. And you'll see here right 

at the bottom, it says; “You're responsible for respecting others rights, including copyrights”, and 

then you have a link to learn more here. So if you're not entirely sure what Creative Commons 

licenses are, then it's definitely worth having a read up about that before you start to use these 

images in any commercial projects.  

Now, just while we're in here, we do also have a Filter button, which allows us to search for 

specific types of images. So I can search by Size, I can search by Type. So if I want to 

photograph a clipart, or if I want something that has a transparent background. And this is an 

option I use fairly frequently. Sometimes maybe I'm looking for an icon or maybe a logo, but I 

don't want to have any background.  

Even if it's just a white background, I just want images that have transparent backgrounds. And 

you can also do things like search for images by their Layout. So Square, Wide, Tall, and also 

Color or Black and White photographs only. So don't forget about those filters that you have 

within this little area.  

Now for this particular image, I don't need to do any of that, I'm going to click on Insert. And it's 

going to pull that through. And once again, I can just go ahead and resize that as necessary. I'm 

going to jump up to the top of this document and just Add-in another Bullet Point. So I'm going 

to say Big Ben. And then for Paris, we're going to say Notre Dame, like so. So pretty simple and 

straightforward to add Pictures into your Notebooks. If you've used Microsoft applications for a 

while, this will be like second nature to you.  

We're going to move on to the next module now, where we're going to talk a little bit about 

inserting Video into your Notebooks. So, I'm looking forward to that, I hope to see you over 

there. 
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Video: Embedding Online Video 

 

Deb: Hello everyone, and welcome back to the course. In the last lesson, I showed you how you 

can insert Pictures both online and locally saved Pictures into Pages in your OneNote Notebook. 

But did you know that OneNote also has the ability to embed Videos right into your Pages? And 

adding Videos really make your Notebooks come alive. And they're particularly good if you're 

creating an interactive Notebook to share with others.  

It's worth noting at this stage that inserting Video is a little bit different to inserting Pictures. 

When it comes to Video, you cannot insert a Video that you have saved off locally. So if you've 

got your own Videos stored off to File Explorer, there isn't an option to browse your local drives 

to upload that Video and add it into your Notebook. What you can do, however, is pull in Videos 

from other Video sites. So Online Video, essentially. And if you take a look at that Insert ribbon, 

in the Media group in the middle, you'll see exactly what I mean, we just have one option here, 

which is Online Video.  

So if you have a Video that you've uploaded to YouTube, then you can essentially embed that 

link into the Page. Now, if you're wondering which sites you can embed Video from, I would 

advise you to jump onto the Microsoft Help Page. If you search for embedding videos in 

OneNote, you'll get to this Page and that goes through and shows you all of the currently 

supported sites and services. And you'll find in there, most of the ones that you're going to want 

to use are listed there.  

So we have things like DailyMotion, Vimeo, YouTube, TED Talks, all of those kinds of things. 

And Microsoft do advise that you check back here periodically, as they're consistently adding 

more and more Video sites to this particular list. So let's jump back to OneNote, and let's take a 

look at how we can add an Online Video.  

Now for this, I'm going to go across to my Courses Section group, and I've got the Excel Section 

selected. And what I want to do here is Add-in a tutorial video related to Excel PivotTables. So 

this might be something that we want to send out to different staff members in offices to back up 

the in-person training that they're going to get when we roll out Microsoft 365. Now if I was to 

click on Online Video, what you'll see is that immediately, it asked for the Video address. And 

you'll see underneath it says; “View supportive video”, which is going to jump you to that help 

Page that I was just showing you.  

So really, what you need to do here is jump onto YouTube, or DailyMotion, or Vimeo, grab the 

URL, and then come back to this option. So that's what we're going to do. I've just jumped into 

YouTube, I have the PivotTables in Excel open, I'm going to copy the URL, Ctrl + C, jump back 

to OneNote, and then go to Online Video, Ctrl + V to paste it in. If I click on Ok, it's then going 

to embed that Video into my Page. And what I get here is a clickable link.  

So if I click this, it's gonna take me to YouTube where I can view the Video, but I can also view 

the Video from within my OneNote Page. So if I click on Play, that Video is going to start and I 

can move through the Video as I work on YouTube or any other Video application. So super 
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straightforward. You just need to make sure you grab the URL first, and then just paste it in to 

embed that Video. That's it for now, I will see you in the next module. 
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Video: Adding Files 

 

Deb: Hello everyone, and welcome back to the course. We're down in Section 3, where we've 

been taking a look at adding different types of content into our OneNote Notebooks. And in the 

previous few modules, I've shown you how you can Add-in Screen clippings, Pictures, Online 

Pictures, and also Online Video.  

Now in this, in the next couple of modules, we're going to concentrate on adding Files into our 

Notebooks. And adding Files is just another way of gathering together information that's going to 

be useful to anybody who has access to this Notebook. It's also a great way of saving time. So for 

example, instead of retyping information, or maybe relying on links to documents that might 

become unavailable if you go offline, you can bring content that you need directly into OneNote, 

either as an attachment or as a Printout you can annotate, and you'll find these options on the 

Insert tab in the Files group. And it's these three that we're going to concentrate on over the next 

couple of modules. So let's start out by taking a look at inserting File Printouts.  

Now, when you insert a Printout, it basically allows you to select a File that you have stored in 

OneDrive or locally. And that could be any kind of File, it might be a Word document, an Excel 

Spreadsheet, PowerPoint, PDF, anything like that. And it's going to print the contents of that File 

into wherever you're clicked. So in my case, I'm in the Schedule Section, and I'm clicked on the 

Course Plan Page. So let's click on File Printout. And you can see it's going to jump me across to 

File Explorer, and I have a Word document here called Cost Descriptions that I want to Add-into 

this Notebook.  

Now, it's worth noting that I just have some junk text inside this Word document to demonstrate 

this, but hopefully, you'll still get the idea. So I'm going to click on Insert, and you'll see exactly 

what that does. So it prints the contents into the actual Page. Now it's worth noting that this is a 

copy. So when I click on this Page, I get my resize handles at the side. But it doesn't let me 

directly edit the text from within OneNote. However, if I did want to update this text, you'll see 

just above, I basically have a link back to the original Word document. So, what I can do if I 

want to update is I can double-click to open in Word, I can go in, and make my changes, save the 

document, and I'm going to close down Word.  

Now what you'll see when I go back to OneNote is that it doesn't automatically update, you can't 

see that text that I've just added on to the beginning of the first paragraph. What I do have just 

above it says; “The Printout below may be out of date, right-click here to refresh”. So all I need 

to do is right-click, and then in the Contextual Menu, I have a Refresh Printout option. So if I 

click this, it basically reloads their print out, and now you can see that my changes have updated. 

So that's one important point to know.  

When you insert it, you're essentially getting a copy that you can't edit within the Notebook. But 

you can edit the original and then just refresh the Printout to update it. Now if you come across a 

situation where you have inserted a Printout, and then maybe you want to copy and paste this 

first paragraph into another Page, well you can do that as well. If you click on the Printout, and 

right-click your mouse, you'll see you have an option here for Copy text from this Page of the 
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Printout. So I'm going to click to copy and that's going to copy everything. It doesn't allow me to 

select a specific paragraph, so I'm going to just quickly add a new Page. And if I right-click and 

paste, it's going to paste all of that text in and I can then jump into the text. And this is in fact 

editable.  

So I can make some changes, I can select different paragraphs, copy and paste elsewhere, so on 

and so forth. So that's a really useful little option, as it essentially makes the text editable and 

allows you to do other things with it. So let's add another Page and move on to the next option, 

which is File Attachment. So this is more like adding a File Attachment like you would in an 

Outlook email or something along those lines. If I click File Attachment, again, it's going to 

jump me into File Explorer, and I can select a document to attach.  

So this time, I'm going to select the Course Descriptions PDF, click on insert and I get a choice 

of attaching the File or inserting the Printout. Now if I was to select Insert Printout that is 

basically exactly the same as selecting File Printout from here. So we've pretty much just run 

through how that works. So, let's go for Attach File instead. And as you would expect, this looks 

a lot like an email attachment, it just gives you a link to your document. And of course, you can 

double-click to open that up. And because it's a PDF, it is opened in a web browser for me.  

Once you're in here, of course, you then have lots of different annotation tools if you do want to 

make changes to it. But essentially, what you have here is a link to the original documents. So, 

any changes made in that document will automatically update the next time you open, you're 

going to see the latest version. So that's all very straightforward. Now before we carry on, so we 

don't get too crazy, I'm going to rename some of these Pages. So I'm going to title this one 

Course Details. And the other Page that we created, I'm actually just going to delete that one out.  

Now the final option we have in here is to insert a Spreadsheet. And if you click the drop down, 

you have two options, you can insert an existing Excel Spreadsheet, or you can create a new 

Excel Spreadsheet. So let's go for Existing Excel Spreadsheet first of all. Again, it's going to 

jump me into File Explorer, I can then select an Excel Spreadsheet, click on Insert, and this time, 

I get three different ways that I can insert this File.  

So I can attach the File, which means it's going to show very similar to this PDF, it's going to be 

a link back to that original document. I can insert the Spreadsheet, or I can choose to just insert a 

specific Chart or Table. So, let's go for the insert Spreadsheet option. And there we go. So I'm 

going to move this over, like so. Now this Spreadsheet had four different workbooks. So I had a 

Chart which you can see there, I then had some data, and I then had a list of employees. And you 

can see here it's brought everything in that workbook into my OneNote Notebook.  

And once again, if you do want to make any changes, if I double-click on where it says Course 

Plan Europe it’s going to open up in Excel. And let's just make a simple change. Let's make a 

formatting change here, I'm just going to change the color of these bars to a dark red color. I'm 

going to Save and Close down. And this time, you'll see that it has automatically updated with 

those changes that I've made. So, works slightly different to inserting a Printout. Even though it 

looks fairly similar, it does link directly back so any changes you make to the original document 

will automatically update in your OneNote Notebook.  
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Now I'm going to scroll all the way down to the bottom here, and let's take a look at this final 

option, which is New Excel Spreadsheet. So what this essentially allows you to do is create a 

new Excel Spreadsheet directly from within OneNote. And you can see here I have an Edit 

button. And if I click on Edit, it basically opens up the temporary Excel Spreadsheet for me. And 

I can start to add data.  

We're just going to add a couple of columns, click on Save, close it down, and you can see that 

that data then updates. So, a great way of creating a Spreadsheet kind of on the fly if it doesn't 

already exist somewhere on your system. So, those are all the different ways that you can add 

Files and documents into your OneNote Notebooks.  

In the next module we're going to move on to talking about Recording, and I'm going to show 

you how you can add Audio and Video Recordings into your Notebooks. So I'm going to head 

over there now, I look forward to you joining me. 
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Video: Recording Audio and Video 

 

Deb: Hello everyone, and welcome back to the course. We're still down in Section 3, where 

we've been taking a look at adding different types of content into our OneNote Pages. And what 

we're going to take a look at now is how we can Record and add to our Notebooks, Audio and 

Video Files.  

Now, it might be at some stage when you're working in your Notebooks that you want to maybe 

take a quick Audio note or record a Video. And the cool thing about this little feature in OneNote 

is that if you do record a piece of Audio or a piece of Video and insert it into your Page, if you 

type any notes as you're Recording your Audio or Video, the notes will essentially bookmark 

within the Audio or Video File, so you can easily find the place in the Recording where you 

typed your note. So let me show you an example of both.  

So we're working up on the Insert tab, and you can see that I've just added a new Page to the 

Travel Section called Recording Audio and Video. I'm going to click my mouse somewhere on 

this Page. And then in the Recording group, we're going to choose Record Audio. Now what this 

does is that as soon as you click on that button, it's automatically Recording everything that you 

say. And you can see the Audio Files sitting there nicely in the OneNote Notebook.  

Underneath we have the time that the Audio Recording was started. And if you take a look up to 

the ribbons at the top, you can see I now have a Contextual Ribbon that's called Recording. And 

this contains all of the options I might need in order to manage this Audio Recording.  

So currently, because it is Recording, I have a Pause and a Stop button. And you can see as I 

hover over those, they both have keyboard shortcuts. Now it might be that you are taking a 

Recording of a meeting, or maybe a lecture or something like that. And as you're Recording, you 

might also be making notes. So let me show you how this works.  

So if I take some notes just here. So I'm gonna type; “Taking notes for audio recording”. And if I 

was to type something else, so I'm just going to type in Test, test, test, two test, I could carry on 

going. But now when I stop this Recording, so I'm going to press Stop on that Contextual 

Ribbon, I now have a couple of different ways that I can play this Audio Recording back. If I just 

want to play the whole thing, you can see if I hover over this File, I get a little Play button next to 

it, and I can click Play.  

Now what this does is that as soon as you click on that button, it's automatically rec. But 

alternatively, what I could do is if I hover my mouse over my notes underneath, you'll see that 

each line of notes also has little Play button next to it. So this is essentially bookmarked in the 

Recording where I was when I was taking this note. So what I can do is just click on Play. So if I 

take some notes just here, and I could do the same for the line underneath Recording. So, it 

essentially keeps track of what was being said at the point that the note was written.  

Now this also works for Video as well. So if we go back to the Insert tab and click on record 

Video, this is going to pop open a window; “Hi everybody, nice to see you”. And it's going to 

allow you to take a Recording in exactly the same way. So if I'm again working through this and 
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typing in some notes, so I'm gonna say; “Typing notes for video recording”. Again, that's 

bookmarking where I am in my Recording when I typed that note. So now if I press Stop on the 

Contextual Ribbon, I can choose to either playback the entire Recording, or just the part where I 

took the note.  

If I'm again, working through this and typing in some notes, so I'm gonna say; “Typing”, and it's 

as simple as that. Now you'll also notice that when these Recordings start to play, some of these 

other buttons in the Playback group become active. So you can do things like rewind for 10 

minutes, rewind for 10 seconds, and also fast forward. And then right on the end here we have 

Audio and Video Setting.  

So this is where you can customize how OneNote creates and plays Audio and Video 

Recordings. And this is essentially going to jump you into your OneNote Options where you can 

set up things like your Default Audio Recording Device, and also your Video Recording 

Settings.  

So, this is particularly helpful. I find if I'm ever in a training course or there is something that 

someone is saying that I want to make sure I get correct, you can start a quick Recording, record 

it all and then you can type your own notes. That is it for this module, I will see you in the next 

one. 
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Video: Inserting Links 

 

Deb: Hello everyone, and welcome back to the course. We're still in Section 3, and in this 

Section, we've been looking at adding content. And it's now time to look at adding Links into our 

Notebooks. And this is a very simple process. Again, if you're used to using Microsoft 

applications, then you're not going to find this difficult at all, because it's pretty similar to every 

other application.  

So occasionally, you might need to add Links to external websites or even Links to other 

documents into your Notebooks. So for example, I'm currently clicked on the Travel tab, and I've 

created a Page and I've called it Flights. So what I might want to have in here are some Links to 

websites where you can book flights. And to do this we’re staying on the Insert tab. And you'll 

see right in the middle, we have a group called Links, and we only have one option in there.  

You can see as I hover over, it says; “Create a Link to webpages, Files, or other places in your 

notes”. And the keyboard shortcut to bring that up quickly is Ctrl + K. So let's click and see what 

we get. Now the first two Links that I'm going to add are Links to external websites. Now there's 

a couple of different ways that you can approach this. The first box you have to fill out here is 

Text to display.  

So I'm going to put in here, Expedia, I now need to Add-in the Link to that particular website. 

And you can see just to the right, I can choose to browse the web from here. Or if I already have 

the website open, I can just jump across and copy and paste the Link. So I'm just going to go to 

Microsoft Edge where I have a few different websites open. And the first one here is in fact, 

Expedia. So all I'm going to do is click in the URL bar to highlight that web address, Ctrl + C to 

copy, I'm going to jump back to OneNote and Ctrl + V to paste it into the address field. I can 

then simply click Ok, and it adds in that Link.  

Let's do another one, but in a slightly different way. I'm going to hit enter, I'm going to go back 

up to Link. This time, I'm going to display a Link to Skyscanner. But I'm going to use the 

Browse the web option. So let's click and this time it opens up the Default Page in my default 

web browser, which for this is Microsoft Edge. I can then simply navigate to 

www.skyscanner.net. I can then copy the Link, Ctrl + C, jump back to OneNote, and then paste 

that address in. It's pretty much exactly the same, just a slightly different way of getting to your 

web browser.  

And now I've managed to Add-in another Link. Now I'm just going to give these a little bit of a 

title, Recommended sites for booking flights. And then I have my two Links to my webpages. 

And of course, if I hover over I can see the URL. If I click, it's going to jump me to that 

particular webpage. So, all very straightforward and simple. Let's look at some other options that 

we have underneath Link.  

Now what we can also do is we can choose a File to Link to. So if I click Browse for File just 

here, I can navigate to where I have my File stored. And it's this one just here flights.docx. Click 

on Ok. I'm going to have the Text to display as Suggested Flights and click on Ok. So now 
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essentially, I've created a Link to a document. And you'll see when I click, it's going to open that 

document up in Word.  

Now the final option that I have in here is I can Link to other Sections within my Notebook. So 

you can see at the bottom here, I can expand the Project Artemis Notebook. It’s going to show 

me all my different Sections, and I can choose any one of these Sections to Link through to. So, 

I'm going to Link to the Overview Section. The Text to display is Guide for Flight Dates, click 

on Ok, and that's exactly what I get. So if I now click, it's going to jump me to that particular 

Section.  

So, those are the different kinds of Links that you can Add-into your Notebooks. And of course, 

if you right-click on any of these, you get a Contextual Menu which is going to allow you to 

jump in and edit that Link if you need to make any changes. You can also remove the Link from 

here, select it, or copy it. And that is pretty much it, it is as simple as that.  

In the next module, we're going to explore how to add Equations and Symbols into our OneNote 

Notebooks. So, please join me for that. 
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Video: Inserting Equation and Symbols 

 

Deb: Hello everyone, and welcome back to the course. We're heading towards the end of Section 

3, and I just want to start to round out this Section by running through a few other things that we 

haven't looked at yet, which you can insert into your OneNote Notebooks. And what I'm going to 

go through in this module is inserting Equations and Symbols.  

Now, I will say when it comes to Equations, this isn't particularly relevant for the Notebook that 

I'm constructing. But you may find there are times where you need to insert some kind of 

Mathematical Equation into your Notebooks. And fortunately, one no provides an Equation 

Editor to assist you with this. So let's take a look at some of the things that you can do.  

Now again, I'm still working on the Insert tab. And if we go all the way across to the last group, 

that's called Symbols, you can see we have in there an Equation button. And this is a two-part 

button so I can click on the top-half, or I can click on the lower-half. So let's click the lower-half, 

first of all, and what you'll find in here is a whole host of predefined Equations that you can just 

click and insert into your Notebook.  

So for example, if we take the top one just here, which works out the area of a circle, I can click, 

and it's going to insert that equation into its own little placeholder in my Notebook. And of 

course, you can format this however you like using your tools on the Home ribbon. Now, when I 

insert this equation, another thing that you'll notice is that I then get the Equation Contextual 

Ribbon. And remember, Contextual Ribbons are ribbons that only appear as and when they're 

needed.  

So from here, you have lots of different options for manipulating this particular equation. You 

have a large Symbols group in the middle. So if you need to change any of the Symbols or add 

Symbols, then you can definitely do that. And then in the Structures group, there's all these other 

different types of fractions that you can Add-in to your equation. Now remember, all of these 

buttons are for adding to the current equation that you have. You'll see if I was to click away, 

that Equations ribbon disappears. So just be aware of that. You must be clicked in your equation 

in order to see this ribbon.  

But for example, if I was to press Space, just here, go up to Structures and click the Fractions 

drop down, I could choose this first option just here, which is a stacked fraction. If I click it, it's 

going to add that to my equation. And of course, then I can add numbers to this and customize it 

to my needs.  

Now if I click away from this equation to get rid of that Equations ribbon, what I could also do is 

jump back to my Insert tab, and I could create my own equation from scratch. There's a couple of 

different ways I can do this. If I click the lower-half of the equation drop down, you'll see right at 

the bottom, I have an Insert New Equation button. And the keyboard shortcut for that is Alt + =.  

Alternatively, and a much quicker way of doing this is to click the top-half of the button, which 

then just gives me essentially a blank placeholder. And I can construct my own Equation from 

here. And you'll see once again, I get my Equation ribbon back again. And I can go in and 
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choose whatever equation it is that I want to Add-in. And everything within these Equations can 

be modified simply by clicking in the placeholder and replacing the characters or the operators.  

Now, if you are somebody who is using a Touchscreen device, then you also have a few extra 

options. So once again, let's jump up to Insert and I'm going to insert a blank equation. So if you 

have some kind of Stylus that you use with your Touchscreen device, what you can do is 

handwrite out your equation and then OneNote will do its best to convert it to text for you.  

So in this first group here, the Tools group, we have a button called Ink Equation. And it says; 

“Insert Mathematical Equations using your handwriting”. So let's jump into here, and we get our 

Insert Ink Equation box. And what I can do is I can now write my equation using my Stylus and 

get OneNote to convert it for me. Now what I'm going to do is I'm going to drag this box out to 

make it a bit bigger, and I'm going to use my Stylus because I am using a Touchscreen device to 

write out my equation. And let's just use Einstein's most famous equation E=MC2.  

So I'm going to do my best to write this out. But there we go. And you can see just above it's 

giving me a preview of what it thinks I've written and in this case that looks to be correct. Now if 

I need to make a correction when I'm writing this out, you can see at the bottom we have some 

options for manipulating our handwriting. So I could choose Select and Correct. And then I can 

draw around, whatever it is that I want to correct. And OneNote is going to provide me a few 

different options that it thinks I might want to do from this little menu.  

Now, in this case, I don't want to correct it, I'm just gonna click on Close, and I can also erase, 

any of my handwriting as well. So if I click on Erase, once again, I can just drag it over whatever 

it is I want to get rid of. And of course, if I want to clear the whole lot and just start again, then I 

have a Clear button down here. Now I'm going to go back into write mode and just add that two 

back in, like so. And I'm fairly happy with that, so I'm going to insert it into my Page. And there 

we go, we have our little equation. So that's particularly good.  

If you have a very bespoke, long equation that you want to Add-in, instead of going through all 

of these different Structures and Symbols, you can simply open up the equation editor, write it 

down, and then OneNote will do its best to convert it and you can make any corrections that you 

need to make. So Equations, probably not something you'll use all that frequently, but just know 

that it's there, and you can use it if you need to.  

Finally, let's jump back up to Insert and quickly look at Symbols. Now again, this is fairly 

straightforward. This will just allow you to insert any Symbols into your OneNote Pages. And 

you can see there I have a selection of a few that I've used most recently. Now if I want to see the 

full list of Symbols, I can just say More Symbols, and it's going to bring up that full list. And I'm 

going to insert one of these Symbols. And let's just move that window out of the way. But 

because I'm going to go to the Offices Section, I'm going to select the London office. And you 

can see here I have the office address.  

So what I'm going to do is just click at the start of office address, and just Add-in a little symbol, 

I'm going to add this little envelope one, so I'm going to click Insert, Close. Now I want to put a 

little bit of space in there so it just adds a little bit more interest into my OneNote Page. So don't 
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forget, you have a whole host of different Symbols that you can use in your Pages as well. 

Again, this is a feature that's available across all of the other Microsoft applications.  

So, that's it for this module, very straightforward Equations and Symbols. Use them when you 

need to. That's it for this module, I will see you in the next one. 
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Video: Copying and Pasting Content 

 

Deb: Hi guys, welcome back to the course. We're down into the last module of Section 3. And in 

this Section, we've been seeing how we can add all different types of content into our OneNote 

Notebooks. So I'm just going to finish up this Section by running through the options that you 

have when it comes to Copying and Pasting content from other documents into your Notebook.  

The first thing I'm going to do here is create a new Page. So I'm going to jump into my Courses 

group, I'm going to click the plus to create a new Section, and we're going to rename this one 

OneNote and hit Enter. And this Page is going to be called Training Script. And what I want to 

do is I want to take the Training Script what I'm going to say in this particular course from a 

Word document and paste it into this Page in OneNote, and this is fairly straightforward.  

If you're used to Copying and Pasting things across different Microsoft applications, you're 

probably not going to have too many worries. But let's run through it because there are a couple 

of things when it comes to pasting that you need to be aware of. So I'm going to jump across to a 

Word document. And all you need to do is make your selection, so select the text that you want 

to copy and paste.  

So I'm going to say I want these first few paragraphs. And then of course, you need to copy it. 

And you can use whatever method you want to use in order to copy this text. So that might be 

Ctrl + C if you like your keyboard shortcuts. Alternatively, up on the Home ribbon, you have a 

Copy button, or you could right-click your mouse and select Copy from the little Contextual 

Menu. So let's click Copy and jump back to OneNote.  

So now what I'm going to do is I'm going to paste this text in. Now you'll find your Paste options 

on the Home tab in this first Clipboard group. Now again, this is a dual button. So it's split into a 

top-half and a lower-half. Now if you click the top-half of this button, it's exactly the same as 

doing a Ctrl + V to paste. And what OneNote will do is it will use your Default Paste Option in 

order to paste that text in. Now if you're wondering what your Default Paste Option is, if you 

click the lower-half of the Paste button, whatever icon you have showing first is going to be your 

Default Paste Option.  

So for me, that is to Keep the Source Formatting. So what that means is if I just do Ctrl V, it's 

basically going to retain all formatting from the source document. So if I have my font formatted 

in Times New Roman in the source document, if I was to choose Keep Source Formatting, when 

I paste, it's still going to be in Times New Roman in OneNote. Now of course, I have a few other 

options in here, I could choose to Merge Formatting. So that means whatever my Default Fonts 

are in OneNote, when I paste text in from another document, it's going to take on the formatting 

that is set in OneNote.  

The third option I have is to Keep Text Only. So, that's going to bring across unformatted text, 

and you can do whatever you like with that. Or, I could choose to insert the text as a Picture. 

Now I'm just going to do that just to show you the difference with this option. Let's select 

Picture. And what you'll see is that within the placeholder, if I click, I now get these handles 
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around the outside. So OneNote is treating this as a Picture, which means I can't just jump into 

this text and edit it. So just bear that in mind if you decide to use that option. Now I'm going to 

Ctrl + Z just to Undo that. And what I'm going to do is I'm going to select Keep Source 

Formatting, paste that in, and there we go.  

And you can see with this option, I can jump in and I can make any changes I need to this text. 

And what you'll also see at the bottom is that I have a Link back to the original document if I 

need to refer to it at any stage. So that was Copying and Pasting text from a Word document into 

OneNote, let's run through one more example of Copying and Pasting something from Excel into 

OneNote. So I'm going to go back a level, and I'm just going to jump to where it says Schedule 

and click somewhere down here.  

Now if I go to Excel, you can see I have an Excel worksheet here that has the Course Plan table 

on it. So what I could do is select this entire table, I can click on Copy, jump back across to 

OneNote, and then once again, I have my different Paste options. So this time, I'm going to select 

Merge Formatting to pull that through, and it's going to take on the default formatting that I have 

in this OneNote Notebook. If I Ctrl + Z just to Undo that, and do it once more. But this time, I'm 

going to say Keep Source Formatting. You can see, I get something slightly different because it's 

bringing across the formatting from the original source document.  

So, the main takeaway from this lesson is just be aware of those different Paste options that you 

have, and how they can affect the look and feel of the content that you're pasting in. That's it for 

this module, that is it for this Section. In the next Section, Section 4, we're going to move into 

taking a deeper look at Formatting our notes. So, I'm excited. Grab yourselves a coffee, and I 

will see you over there. 
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Video: Windows 10 Adding Content 

 

Deb: Hello everyone, and welcome back to the course. It’s time for us to take a look at some of 

the options that we've run through in this Section in OneNote for Windows 10. So we are pretty 

much picking up from where we left off in the last Windows 10 tutorial. And if you remember, 

we created a project called Project Sierra.  

We created some Sections and some Pages, and then I showed you how you can make Subpages. 

And we also took a look at the main options that we have in the OneNote for Windows 10 

interface. So let's move on a little bit now and start taking a look at how we can insert items into 

our Pages.  

Now this is fairly straightforward in OneNote for Windows 10, all of your insert options are 

found on the Insert tab. And from here you can insert various different items like Tables, Files, 

Printouts, Pictures, and Online Video, as well as things like Links and Audio, Meeting Details, 

Symbols, so on and so forth. So fairly similar in that way to the Desktop version. Now when it 

comes to Typing notes, this works in exactly the same way, you just click somewhere in your 

Page, and type your note. And you'll see that the note appears in a very similar placeholder that 

you can pick up and move around.  

You can also resize it by dragging it out, give yourself a little bit more room. And you can pretty 

much place this wherever you want on your Page. Now when it comes to formatting text that you 

have within placeholders, if we jump back to the Home tab, this is where you're going to find all 

of your formatting options that you have available. So I can make this Bold, I can make it Italic, I 

can Highlight it, I can even do things like Copy the formatting using Format Painter, or add 

things like Bullet Points and Numbered Items.  

Now, I'm gonna do Undo a couple of times just to take that back to the plain text, because what I 

want to focus on in this particular lesson is things that you can insert into your Notebook. So let's 

jump back to the Insert tab. And let's start out by taking a look at how we can insert a Table. So, 

I'm going to click the Table button. And again, this is probably fairly similar to what you're used 

to. I'm going to select how big I want my table, and very quickly, I've managed to insert a nice 

Table into here. And I can now start to Add-in my required data.  

Now, I'm going to select that placeholder and just delete that out and just show you a couple of 

other options that you have on this ribbon. Because most of them are pretty much the same as the 

Desktop version. So let's click on File, and I'll just show an example of inserting a File into your 

Notebook. So I'm going to select this Word document just here and click on open. And I can 

choose to upload it to OneDrive and insert a Link to it, I can insert it as an Attachment or as a 

Printout. So I'm going to say Insert Attachment. And just like that, we have that document sitting 

there ready to open.  

We can insert Pictures in pretty much the same way. We can choose to insert a Picture that we 

have saved off, we can choose to select one from a camera, or from an online source. So if I was 

to select from online, it's going to open up a pane where I can then search for a particular Picture, 
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so let's just say London, I can then choose the Picture that I want. And it's going to insert that 

very quickly into my Notebook.  

Now once again, I'm going to click on Undo to get rid of that. Now when it comes to something 

like Online Video, again, this is where you're going to need to know the exact URL of the Video 

that you want to insert. So you might have to jump on to YouTube or Vimeo, grab the URL, 

paste it in here, in order to put your Video into your Notebook. Now pretty much everything else 

in this Section is exactly the same in the Desktop version, as in this one.  

When it comes to Copying and Pasting, you can utilize exactly the same keyboard shortcuts. So 

for example, if I press Ctrl + C to copy, click down here and Ctrl + V to paste, that's going to 

work nicely. Now if you're looking for your Cut, Copy, and Paste options on that Home tab, 

you're going to need to click on the Clipboard and then you'll see a drop down menu with those 

there available in there.  

So when it comes to inserting items into this particular version of OneNote fairly 

straightforward; Insert tab. There you have your options, and for the most part, it works pretty 

much the same as the Desktop version. That's it for this module, I will see you in the next one. 
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Section 4 – Formatting Text 
 

Video: Formatting Text 

 

Deb: Hi everyone, welcome back to the course. This is still Deb, and we are down into Section 

4, where we're going to be taking a deeper look at formatting notes. Now, formatting is 

reasonably simple. But it's a very important process because it makes your text more readable, it 

allows you to emphasize certain points, and also gives a bit more structure to content that you 

have on your Page.  

And I've been utilizing font formatting throughout this course so far, but in this particular 

module, I just want to delve into all of the options that you have so that you're clear and can 

format your notes effectively. So I'm currently clicked on the OneNote Section in the Training 

Script. And you can see here currently, I have a few paragraphs of completely unformatted text. 

Now I can see in here, I have some spelling errors that I might want to correct. And I'll do that 

later. But for now, I want to give this a bit more structure and make it a little bit more interesting 

by formatting my paragraphs.  

Now, in OneNote, you can choose to format everything that you have on your Page, or you can 

select specific paragraphs to format. So let me show you examples of both. Now if I click on my 

text, you can see that I have this placeholder around the outside. Now if I select that placeholder, 

I'm effectively selecting everything contained within the placeholder. So any formatting that I 

apply at this point is going to apply to everything within the placeholder. What you'll also see is 

that as soon as I clicked on that placeholder, I get my mini toolbar just above. And the mini 

toolbar holds lots of different formatting options to make it a bit more convenient when it comes 

to formatting.  

Now, currently, I'm clicked on the Home ribbon where I have all of my formatting options. But it 

might be that I'm clicked on a different ribbon, and I want to format some text. So instead of 

having to jump back to home to get to those formatting options, the mini toolbar gives me quick 

access to them wherever I am. So the first thing I'm going to do here is I'm going to change my 

Font Style. So currently, I have this set to Calibri. And if I click the drop down, this is going to 

give me a list of all of the inbuilt fonts within OneNote. You'll see at the top, I have my most 

Recently Used Fonts. And then I have a list of all the fonts within OneNote in alphabetical order, 

which makes them a little bit easier to find.  

Now, if you know the particular font that you want to use, you can scroll through the list and 

look for it. Alternatively, you can just start typing the name of that font, and it will jump you to 

the correct place in that list. So for me, I'm going to use Lato Light. And you can see as I type it, 

it's found that in the list, it's the last one just here. If I click it, it's gonna apply that font to 

everything I have within that placeholder. Now currently, I have a little title here called What to 

expect from this course. And it doesn't really stand out from the rest of the text.  
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So what I could do is just select that line of text as opposed to the entire placeholder, jump up to 

my font drop down, and this one, I'm going to select Lato again, but this time, I'm gonna choose 

Lato Black. So what I'm doing here, and this is quite important is I'm sticking within the same 

font family. I've used Lato Light for my paragraphs, and I'm using Lato Black for my heading. 

And this ensures that my fonts aren't going to look too different to each other as they're within 

the same family. It just gives a more consistent overall look and feel.  

There's something else I might want to do here is I might want to select that heading again, and 

increase the Font Size. So once again, from the drop down menu, currently, I've got 11 point font 

selected, but I could choose something that's a little bit bigger, just to make that heading stand 

out a little bit more. Now underneath those two options, we have some additional ways of styling 

up our text. We can make text bold, and you can see the keyboard shortcut there Ctrl + B, Italic, 

we can underline, we can add a strike through to cross something out. And then we have a choice 

of subscript or superscript.  

So for example, if you type the word H2O, you could use superscript to make that look correct. 

So let's just apply some of these options. I'm going to take the let's just take this first sentence. In 

the second paragraph, I can make it bold. I can make it italic. I can underline it, I could strike 

through. And if I type in H2O, what I could do is select the number to jump up to my superscript 

and subscript button that make it superscript. So that looks a little bit more accurate.  

Now I don't actually want all of this formatting applied. So I'm going to delete out the word 

H2O. And what I'm going to do is I'm going to highlight this whole sentence again. And if we go 

up to our Basic Text group, you can see here I have a Clear All Formatting button. Keyboard 

shortcut, Ctrl + Shift + N. And you can see it says it removes all formatting from the selection, 

leaving only the normal unformatted text. So when I click this, it's going to remove absolutely 

everything, including the Font Style that I selected.  

Now, in this case, it's a little bit quicker for me to use this button and then just go back in and 

reselect Lato Light to apply that font. But in some cases, it might be quicker for you just to 

highlight the sentence and undo all of the formatting that you applied. Now a couple of other 

options in this second group that we have here, we have a Text Highlighter. And I showed you 

how to use this before, it's a really nice little option if you want to highlight or make something 

stand out in your bulk of text. So let me take this sentence here where I'm introducing myself.  

And if I go up to Highlights, I click the drop down, I have a choice of different highlight colors. 

So let's highlight this in a bright green. And there we go. And once again, if I wanted to remove 

that, I can select the text. And I can go back into here and choose No Color. Or I could clear the 

formatting. But remember, it's going to clear that Font Style as well and take it back to your 

default. And then of course, if we highlight this first paragraph, I can change the Font Color. And 

I have a selection of theme colors to choose from, and then a selection of standard colors.  

Now if I'm not finding the color that I want in this palette, I could click on More Colors, and I 

can choose from a standard color selection, or I can go to Custom and get super granular about 

the color that I'm choosing. So I can move around this color palette. And let's go for a purple, I'm 

going to go for a lighter purple. And you can see in the bottom corner, it's showing me what that 
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color is going to look like. Click on Ok, and then it's going to apply that to whatever paragraph I 

have selected. Now I'm going to Ctrl + Z just to put that back to black.  

Now the final few options that we have in here are the Increase and Decrease indent. So once 

again, if I wanted these first two paragraphs to be slightly indented from the rest of the text, I 

could select them and choose to increase my indent position. And it's going to indent those. And 

if I want to do the opposite, again, I can select I can choose to decrease my indent position to 

move that back again.  

Then finally underneath I have some Alignment options. So currently, my text is all aligned to 

the left. Now for this, I'm actually going to select the entire placeholder, and I'm going to say 

align to center. And you can see I get a completely different layout for my text, I could also 

choose to align to the right. And that's sometimes useful. If you want to move your text box over 

to here, it gives it a different look and feel. Now again, I'm going to Ctrl + Z just to pull that back 

to align left. And then right at the bottom, we have some Paragraph Spacing options.  

So, currently, you can see the spacing in between my paragraphs is reasonably small. So it might 

be that I want to increase that to make it a bit more obvious and prominent. So if I go down to 

Paragraph Spacing options, I can choose how much space I want to set before the paragraph and 

how much space after. And I'm going to say I want 20 point spacing afterwards, click on Ok, and 

you can see I get a much wider gap after each paragraph. And the final button that we have in 

this little Basic Text formatting group is the Delete Item button.  

So, this is just another way of being able to very quickly select a paragraph. So if I hover over 

the second paragraph, you'll see I get a little arrow at the side. I can click it to select the 

paragraph, and I can click Delete. And it's pretty much the same as pressing the Delete key on 

your keyboard.  

So, that is it, a very quick run through of all of those font formatting options that you have 

available. In the next module, I'm going to show you how you can utilize Format Painter. So, 

please join me for that. 
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Video: Using Format Painter 

 

Deb: Hello everyone, and welcome back to the course. We're down in Section 4, where we're 

taking a look at formatting. And in the previous module, I showed you the different options that 

you have when it comes to formatting paragraphs of text in your Notebooks. Now in this 

particular module, we're going to follow on from the previous one, and I'm going to introduce 

you to the Format Painter.  

Now again, this is something that I use towards the beginning of this course, but I want to make 

sure that you understand exactly how to use it, because there are a couple of things that aren't 

immediately obvious. So once again, I am working in the Training Script Page. And I've added a 

bit more text into this Page. Now if you take a look at the text that I've actually added, I have 

some times, 10:00 to 12:00, and also 2:00 to 4:00 a bit further down. And I want to make those 

stand out from the rest of the text on the Page.  

So once again, what I can do is I can hover my mouse over the little arrow that appears in the 

margin, and click to select that piece of text. Now, if I want to select another piece of text, I can 

hold down my Control key, click to select that line as well. And I'm going to make both of these 

bold, like so. And then underneath I have a list of items that I'm going to cover. And then 

underneath each of these headings, I have essentially a list of agenda items.  

So again, what I might want to do here is apply some formatting to make them stand out and give 

this Notebook a little bit of structure. So the most obvious thing I might want to do with some 

kind of list would be to either add Bullets or Numbering. And if we jump back up to our Basic 

Text options, you can see I have a whole host of different Symbols that I can use as Bullets. So 

I'm going to pick this little tiny black square, click to add that in.  

Now an alternative option to adding in just Symbols as Bullets is that you can number items as 

well. So if I go up to the button next to Bullets, we have a Numbering option. And this is going 

to pull up the Numbering library. And it shows me all the different Styles of Numbering that I 

could choose. So again, it really depends on what your personal preference is, or what matches 

the overall theme of the Notebook that you're working in.  

So for this one, I'm actually going to choose these Roman numerals, click to add those in. And 

when it comes to things like Numbering, you'll notice that if I click on one of the numbered 

items, it selects them all. So if I wanted to change to a different Styles of Numbering, I can just 

jump back up to Numbering and then choose whatever it is that I need to.  

Now the final thing I want to show you in this lesson is how to utilize the Format Painter. So 

what I'm going to do is I'm going to press enter, and you'll see that automatically, it's going to 

give me my next numbered item. Now I don't want to have a numbered item here, I want to 

create a new heading. So all I need to do is I can just click on Numbering, but you'll see that it's 

going to leave my cursor indented.  

So if I want to pull it back, so it's flush with that left-hand margin, this is where I would use my 

Decrease indent position. And when I click that, it pulls it back to where I need it to be. So I'm 
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going to add another heading in here we're going to say 4:00 to 6:00. And I'm going to Add-in a 

few more items.  

Now a quick way of me formatting this new list, the same as this I have above is to utilize the 

Format Painter. And what the Format Painter does that allows you to select a piece of text that 

already contains formatting, and then essentially transfer it to another piece of text. So in this 

example, I want this heading 4:00 to 6:00 to look exactly the same as the one just above 2:00 to 

4:00.  

Now in practice, this just contains bold formatting. So it's not too much of a hassle for me to just 

apply bold. But if I had multiple pieces of formatting applied, so if I select it, and maybe if I 

change the color, maybe I've gone in and I've made it bigger, maybe I've made it Italic, I've now 

applied a number of different steps.  

And so to recreate those manually for this particular title, it's going to be a little bit time 

consuming. A much quicker way of doing it would be just to select the text that contains the 

formatting you want to copy. And in the clipboard group, click on the Format Painter and you 

can see the keyboard shortcut there is Ctrl + Shift + C. Now I'm going to click the Format Painter 

once and you'll see that my cursor changes to a paintbrush, and now all I need to do is paint over 

and let go and it's gonna copy that formatting across.  

Now one thing you'll also notice is that as soon as I've done that my cursor returns to just that 

standard cursor. So what do I need to do if I want to carry on painting this format? So we're 

going to do the same again, but this time, I'm going to copy the formatting to multiple items. So 

it's the same process, I'm going to select the text. But this time, I'm going to double-click on the 

Format Painter. I can then paint over this heading, scroll up and paint over this heading. And you 

can see that my cursor is still showing in paint mode.  

So if you click on Format Painter once, you only get to paint once. If you have a lot of painting 

or copying or formatting that you want to do, you need to double-click on that Format Painter. 

Once you're done with your formatting, you can just click on Format Painter to turn it off. 

Alternatively, you can press the Escape key on your keyboard and that will take you back to your 

regular cursor.  

So, Format Painter is a great way of working a little bit more efficiently, saving time, and also 

ensuring that your formatting is consistent throughout your Notebook. That's it for this module, I 

will see you in the next one. 
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Video: Using Styles 

 

Deb: Hello everyone, and welcome back to the course. In this Section we're taking a look at 

everything to do with formatting notes to give our Notebooks structure and make it easier for the 

reader to decipher exactly what they're looking at. And in the previous module, I showed you 

how you can utilize Bullets and Numbering and also use that Format Painter to copy formatting 

to other pieces of content. And we're just going to start out by finishing that up.  

So if you remember right at the end of the last lesson, I added in another list of items. And 

currently, these don't have any Bullets or Numbering apply to them, like the previous two 

Sections. And I want everything in here to be consistent, I want everything to have Bullets 

applied as opposed to Numbering.  

So once again, I'm going to select the text that contains the formatting I want to reuse, and I'm 

going to double-click on my Format Painter. And I'm going to paint over the list below. And then 

I'm going to paint over the final list. And then I'm going to click on Format Painter to come back 

to my regular cursor.  

So now everything is starting to look a little bit more uniform. And this is a really important 

point when you're working in any application, not just OneNote, making everything look 

consistent is really important when it comes to the readability of the document that you're 

creating. And something that can help you with that is Styles. And you'll see on the Home ribbon 

in the middle, we have a Styles drop down.  

And again, this is something we took a look at very briefly in one of the earlier modules. But let's 

just delve into it a little bit deeper, so you understand exactly why these can be useful. Now 

Styles are essentially pre-formatted pieces of text, which are available as standard in OneNote. 

And you can see from this drop down, you get a little preview as to what each of these will look 

like when you apply them to any piece of content in your Notebook.  

And the idea of this is to give your document consistency and also structure. And it also makes it 

a lot easier for you to very quickly apply formatting without having to manually apply it from 

your Basic Text formatting options. So let's take a look at how we might use these. Now at the 

top here, I have the heading, What to expect from this course. And I just applied manual 

formatting to this. I changed the Font Style, I increased the Font Size to 14, and I also made it 

bold. So that's essentially three clicks to get the result that I want.  

What I could have done instead was select this heading, go to Styles and select Heading 1. And 

that's going to apply that Heading 1 Style and all of the formatting to that heading. And if 

whenever I have a heading in my Notebook, I consistently use Heading 1 that's going to make 

my document look a lot more tied together. And it also saves me a lot of time because it just 

requires one click.  

Now I'm going to go in and I'm going to add a subheading here called Agenda. I'm going to 

select it and I'm going to give this a Heading 2. I'm then going to select 10:00 to 12:00, and I'm 

going to give this a Heading 3. So you can see that each of these headings as I'm applying them 
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are slightly different from the previous one, but they still give a cohesive look. So let's apply 

Heading 3 to this one as well, and also Heading 3 down here. Now of course I could carry on 

going, it really depends how many subheadings I have in my document. But I can utilize all of 

these throughout to give a consistent feel. You'll also see that I have some other Styles available 

in here, which I could also use.  

So if I have a Page title, I might decide to apply this particular Style. If I have a citation or 

maybe a quote, and what you'll see is if I just show you, if I select this paragraph, maybe this is a 

quote and I want to emphasize that, I could use the Quote Style. And when I click on it, you can 

see the formatting that's applied for this Style. So it's Calibri font, its size 11, it's italic. And if I 

click the Font Color drop down, you can see the Font Color that it's using highlighted in the 

theme colors palette. So I can see all of the individual properties that essentially make up that 

Quote Style. Now I'm going to Ctrl + Z because I don't need that to be a quote.  

Now I'm going to leave you to have a little play around with these, see which ones you like, 

which ones you don't. But they are a super quick way of just applying some kind of structure to 

your document. That's it for this module, I will see you in the next one. 
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Video: Organize Content with a Table 

 

Deb: Hello everyone, and welcome back to the course. In this Section, we'll be taking a look at 

some of the options that we have when it comes to formatting our text notes. And I want to move 

on from that a little bit in this module and run through some options that you have when it comes 

to organizing information on your Page. And we're going to start by taking a look at Tables.  

Now once again, we're going to be working predominantly on the Insert ribbon. As that is where 

we will find Add Tables option in the second group just here. Now again, if you've worked in 

other Microsoft applications, such as Word or maybe Excel, you may be pretty familiar with the 

concept of Tables. Now if you are used to using Tables in those applications, then you might find 

the option in OneNote a little bit limited. There's definitely not as much that you can do with a 

Table in OneNote compared to something like Word.  

But nevertheless, it can still be super useful for organizing text, making things easier to read, and 

also lining up items on a Page. So in this module, I'm going to show you how you can insert a 

Table and we're going to run through the formatting options that you do have. So I'm clicked on 

the Training Script Page. And what I'm going to do here is I'm going to Add-in a Table, which is 

essentially going to replace these Bulleted items. So currently, the way I have this laid out these 

Bulleted items take up quite a bit of room. So I've decided that these would look a little bit better 

if I organize them in a Table.  

So, I'm going to click after the word Agenda and hit my Enter key to put me on to a blank line, 

I'm going to jump up to Table and at this point, I have a couple of different options. I can select 

how many columns and rows I want in my Table simply by dragging over the grid. Alternatively, 

I can click on Insert Table, and manually type in the number of columns and the number of rows. 

Now for me, I always find it a little bit easier just to drag over the grid. So, I'm going to create a 

Table that is seven rows by three columns, click to insert. And what you'll see is you get this 

rather small kind of cramped up Table.  

Now of course, this is a little bit small for me to be able to work with effectively. So the first 

thing I want to do here is resize these columns. And it's a simple case of hovering your mouse 

over the column boundaries until you get that double-sided arrow, and just dragging out the size 

that you want. And of course, you can adjust these later if you don't have it quite right at the 

outset. So let's make this Table a little bit bigger, like so. Now one thing that you'll notice, again, 

is that when I'm clicked inside this Table, if you cast your eyes up to the ribbons, you can see 

that I now have a contextual ribbon called Table.  

And this ribbon contains all of the options that I have in relation to formatting and organizing 

this Table. So I have a Select group, first of all, that will allow me to select the entire Table. I can 

select specific columns so wherever I'm clicked, it's going to highlight. Again, I can select 

specific rows, or I can just select a specific cell. And all of these selection options are really 

dependent on where you're clicked within your Table.  
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Now, of course, when it comes to selecting, you can also utilize this little gray arrow in the 

margin. If I want to select the first row, I can click the grey arrow to select it. And if I hover just 

above the Table, you'll see that I get that black, downward facing arrow, which is going to allow 

me to select different columns. I can of course drag my mouse. So if I want to select a few 

different rows, I can definitely do it that way. Or maybe if I want to select a few cells within one 

column, I can do it that way as well. So a few different options there when it comes to making 

selections.  

The next group along is Deleting so we can delete our entire Table, we can delete specific 

columns that we've selected or specific rows, and then we have an Insert group. And this is going 

to allow us to insert additional rows either above or below where it clicked, or additional 

columns to the left or to the right of where we're clicked. We then have a group that contains 

some formatting options. So if I want to Hide all the borders of a Table, I can do that. And that 

will look a little bit more useful when we actually have some content within the Table. I can also 

choose Shading.  

So if I want to change the Background Fill of some of the rows or maybe a specific cell or 

column, then I can definitely do that. And then I have Alignment options. And this relates to the 

text contained within each cell. I can choose to align to the left, to the center, or to the right. Now 

we have a couple of other options on the end here which I'm going to cover at the end of this 

module. Let's just focus on the ones that we've just run through. So what I'm going to do here is 

I'm going to start to add some content in. And in this first cell, I want to have the text 10:00 to 

12:00. So I'm going to select that text, and I'm going to do Ctrl + X, which will cut.  

Alternatively, you could have used the Cut command on the Home ribbon, or you could right-

click and select Cut from there. I'm going to click in this first cell just here, and I'm going to 

press Ctrl + V to paste that in. And you'll see that it's pasted with all of its original formatting 

because I use Ctrl + V, which essentially invokes my default paste option, which is to keep the 

source formatting. Now underneath here, I'm going to type in Agenda Item. We're going to have 

Description, and then I'm going to have Time.  

Now one thing you might notice is that the Font Style has gone back to Calibri because Calibri is 

my overall Default Font. It's not picking up the Lato Light that I changed everything in this 

Notebook to be. So probably what I'm going to want to do here is select the entire Table. And to 

do that, again, I can jump up to the Table ribbon. And in the first group, I can click Select Table. 

And then I'm going to go to Home and I'm going to change all of the font to Lato Light. So that 

now ensures that everything that I'm going to type into this Table is going to have the correct 

Font Style.  

Now another thing I'm going to do here with these column headings is I'm going to select the 

entire row, and I'm going to make them bold. And now I'm going to take these Bulleted items, 

and I'm going to cut and paste into the Table. So let's select the first one Ctrl + X to cut, Ctrl + V 

to paste. And I'm going to do exactly the same for all of the others, like so. Now you can see 

because I've just done a direct cut and paste, it’s brought across those Bullets as well. Now it 

might be that once you put them in the Table, you don't have any need for the Bullets. So all you 
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need to do to get rid of those is select all of the Bulleted text, jump up to the Home ribbon and 

just deselect Bullets to put those back.  

Now when I talk about Tables in OneNote being slightly less functional than in other 

applications, I mean for things like this. So for example, this first row where we have the Times, 

if I was working in a Table in say Word, what I would probably do here would be to merge all of 

these cells so we just have essentially one cell running across the top. But you'll notice if we go 

to the Table ribbon, we don't have any Merge options. So you kind of have to keep it in this 

format.  

What I'm going to do now is just go in and type in some text into the Description fields. So there 

we go. I've added in a brief description for each of these agenda items. And also the time that 

each item is going to start. now it might be that I want to add another column that contains the 

room that this course is taking place in. So what I'm I want to do here is first of all, I'm going to 

drag this Table border in as I don't need as much space here. I'm going to select this last column, 

and I'm going to say Insert Right to insert another column.  

Now you'll see as soon as I do that OneNote is going to resize my Table to accommodate the 

widest item in that column. Now normally, this is fine. But if you want to widen then you're 

going to have to go in and manually widen these columns again. So I'm going to say Room. And 

I will say Room A, Room B, C, D, and E. Now some other things I can do in here to liven up my 

Table, if I click in this heading row, I can jump up to my Select group and say Select Rows. And 

just to make this stand out a bit, I'm going to apply some Shading. So let's apply some Lilac 

Shading to that heading row.  

I'm also going to click where we have the Times, I'm going to say Select Cell. And for this, I'm 

going to apply Bold Formatting. And then I'm going to select the Time column. So all of these 

items just here just by clicking and dragging my mouse. And I'm going to make these Italic. Now 

something else I also could do is hide these Table borders. So if I jump up to the Format group, I 

have a Hide borders option, which is just going to give me that. So essentially, it’s still in a Table 

and you can resize still by dragging, but you're just not seeing those Table boundaries. So 

sometimes, that does tend to look a little bit neater and a bit more professional.  

Now just for demonstration purposes, I'm going to bring those borders back. And remember, I 

can highlight two columns of content and maybe I want to Center Align those two. Now another 

option I have up here is the Sort option. So I can choose to sort the items in my Table in 

ascending order, so A to Z. Or descending, Z to A. And this is really important, here, it's got a 

tick next to Header Row. My Table is a little bit different to most Tables that you might create 

because my first row isn't actually my heading row. Really, where I have these column headings, 

that essentially is my heading row.  

So for me, if I wanted to sort in ascending order, and I have Header Row ticked, OneNote is 

going to think that the first row is my Header Row. And so when I sort, it's going to look a little 

bit strange. So for me, I can't actually do that. If I just want to sort the items. So maybe I want to 

sort these agenda items into alphabetical order, I would need to select them, go up to Sort, and 
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say Sort Selected Rows. I'm going to sort by Column 1 in ascending order, click on Ok, and now 

you can see that that has worked. So just be aware of that Header Row option.  

Now, essentially, what I want here is this Table for each of these different parts of the training 

course. Now what I find is, the easiest way is just to copy this particular Table, I want everything 

to look pretty much the same. So I'm going to click in my Table, up to my Table tools, select 

Table, and then going to go to the Home ribbon and say Copy or Ctrl + C if you want. And then 

I’m gonna place my cursor where I want the new Table to be, and I can do Ctrl + V to paste that 

in. So once I've done that, I have all my formatting, everything that I need. And all I would have 

to do is go through and replace the items in the Table.  

So once again, I could do a Ctrl + X, but this time, I'm going to say Paste and Merge formatting 

to take on the formatting of the Table. Let's do a couple more, I'm going to select, Ctrl + X, I'm 

going to do Paste and Merge formatting. And I'm going to carry on going through repeating this 

process for the rest of these agenda items. So this now looks a lot more interesting and also a lot 

neater and more organized now that I'm using Tables.  

I'm just going to make a few further changes to these Tables. So I'm going to click in the second 

Table in that second row, I'm going to go up to the Select group and select the row. And I'm 

going to change the Shading to green. I'm going to do the same thing for the final Tables, select 

the row. And let's change the Shading to a yellow color. And one thing you'll notice is that with 

this Table at the bottom, we don't have quite as hefty a schedule in the last part of the day. And 

so I have a blank row at the bottom here that needs to be deleted.  

And again, this is a simple process, you can either click in the margin to select the row. 

Alternatively, click on the Select rows button, and then you can utilize your Delete options. So 

I'm going to say Delete Rows just to remove that. And then finally at the top here, we have an 

option to Convert to an Excel spreadsheet. 

So what I could do is I could click in this Table, I'm going to say select Table and click Convert 

to Excel spreadsheet. And you can see what I get now. I'm now working within essentially a mini 

Excel window. And if I click on the Edit button, it's going to open that up in Excel, which then of 

course widens what I can do with this data because I have all of Excel’s functionality to hand.  

So it might be at this point that I choose to merge these cells. So I'm going to say Merge cells, 

like so. Click on Save. And when I close the Excel spreadsheet back down again, you can see 

that those cells are now merged. So it gives the Table a bit of a different look and feel and it 

really depends what you want to do. But this is a great way of having a Table in OneNote but 

having access to Excel functionality.  

So, lots of options you have in there for organizing your data with Tables. That's it for this 

module, I will see you in the next one. 
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Video: Create a To Do List 

 

Deb: Hello everyone, and welcome back to the course. In this module, I want to start to 

introduce you to the concept of Tagging in OneNote. And we're going to start out with the most 

basic tag that you can add and probably one that you will use most often. And that is the To Do 

Item Tag.  

Now the To Do Item is great if you want to create like a To Do checklist. So for example, for 

this project, Project Artemis, there are lots and lots of different tasks that need to occur before 

this project can go ahead. Anything from organizing which team members are going to be sent to 

the different locations, to booking the training rooms, organizing flights and hotels, writing the 

training content, all of those different kinds of things.  

So in its most basic form, what you can do in OneNote is you can add a list of items or To Do 

Items, utilize the To Do Tag, and then check them off once they're done. So let's take a look at 

how this works. So I've created a new Section called To Do List, and I've called this Page To Do 

Items. I'm going to click my mouse right at the top there. And on the Home ribbon in this Tags 

group, you'll see that I have a To Do Tag. Now what you also might notice is that To Do also 

appears at the top of this Tags list. And that's because it's probably one of the most popular ones 

you're going to use.  

Now there is a keyboard shortcut to insert this particular tag of Ctrl + 1. And we haven't covered 

Tags yet, you can see we have a lot of items in this big, long list. We are going to go through 

some of these so you understand what they all do and how helpful they can be. For the time 

being, we're just going to concentrate on this first one. So let's click on To Do and you'll see that 

it enters in a placeholder with a little checkbox. And I can then type in my To Do Item. So 

Assign Team Members to locations.  

If I hit the Enter key, you can see I get another To Do box. Hit Enter again, I get another one, so 

on and so forth. And I could carry on going adding my different To Do Items. And that's pretty 

much all it is. It's a very simple utility, but it just allows you to keep track of the things that you 

need to do. And once they're done, you can just click in the box to tick those off. Now you can 

make some very minimal modifications to how these To Do boxes look. So if I right-click my 

mouse, you can see I have options to uncheck the box, I can also remove the tag entirely. I'm 

going to talk to you about Find Tags a bit later on, but the one I want to go into is Customize 

Tags.  

So I'm going to select the To Do Tag at the top and I'm going to say Modify Tag. So if I wanted 

to, I could change the display name of this particular tag. But I can also do things like change the 

Symbol, the Font Color, and the Highlight color. So you have some limited customization 

options. So for example, if I click the Symbol drop down, you can see I can change to any of 

these Symbols.  

Now I actually like having a checkbox. But it might be that I want something that looks a little 

bit different, maybe this green star checkbox. And you can see in the preview below what that's 
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going to look like. It might be that I want to change the Font Color. So let's change that to a dark 

green color. And if I wanted to, I could add a highlight. Now I don't particularly want that I'm 

going to say None. And one important thing to know is it says underneath; “Customizations to 

not affect notes you've already tagged”. So if I click on Ok, and Ok again, you can see that the 

checkboxes I've already added aren't affected. So I'm not getting that updated formatting. But if I 

was to click somewhere else, and then select To Do from Tags, I'm going to get that new Styles.  

But of course, if I did have quite a long To Do list and I wanted to change the formatting, I could 

just select the current Tags, jump up to my Tags group, and click the newly formatted To Do 

Tag. And that's going to replace all of those. Now there's a whole heap of other things that you 

can do with Tags, including the To Do Tag, which I'm going to show you a bit later on because 

we have a whole module dedicated to exploring all of the Tags that you can see in here and using 

them in a meaningful way.  

But for now, that's how you create a very simple To Do list with checkboxes. That's it for this 

module, I will see you in the next one. 
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Video: Checking Spelling 

 

Deb: Hi guys, and welcome back to the course. We're heading steadily towards the end of 

Section 4. And in this Section we've been taking a look at formatting tools and how you can 

organize your information within OneNote effectively. And no essential formatting would be 

complete if I didn't run you through the options you have when it comes to Spellchecking.  

Nothing makes a document or a Notebook look unprofessional, quite like misspelled words. 

Particularly if you're going to be sharing this Notebook with your team colleagues, or maybe 

even a manager, you want to make sure that every time you create a Page, you do run through a 

spellcheck.  

Now I want to start out just by taking you into the backstage area, just so you can see where all 

of your Spelling options are, because that's really going to determine how you spellcheck your 

Notebook. So let's go up to File, and we're going to go all the way down into our OneNote 

options. And the Section that we're interested in is the Proofing Section. Now, I would advise 

you to jump into here and just review the options that you have turned on. But the thing I want to 

draw your attention to is this Section at the bottom.  

So underneath here, you can see that I have selected to Check my spelling as I type. And I've 

also got Check grammar with spelling as well. So what that basically means is that as I'm typing 

my notes in OneNote, OneNote is checking to make sure I’ve spelt words correctly. And if I do 

spell something incorrectly, it's going to indicate that and I have an option to correct it as I go. 

The same thing applies with grammar because I have this option selected as well.  

Now some people don't like their applications checking their spelling as they go, they'd rather 

just wait until the end and then spellcheck the entire thing. And that's entirely up to you. If you 

do want to turn off that option, makes sure you select Hide spelling and grammar errors. 

Now I'm happy with mine set as they are. I'm going to click on Ok, and just show you what I 

mean. So if I was to type a word, let's spell something incorrect, I'm going to say Mocrosoft 

instead of Microsoft. And you can see automatically OneNote has recognized I've spelt that 

wrong, and I have a red squiggly underline. So if I right-click my mouse, you can see straight at 

the top, it’s going to give me some suggestions of what I might have been trying to say. And in 

this case, it’s picked up that I probably wanted to say Microsoft. So, I can click to make that 

correction, I can choose to ignore, or I can choose to add it to a dictionary.  

Now the Add to dictionary option is really useful, particularly for things like names. So, 

OneNote won't necessarily recognize your manager's name. And so it might think that that's an 

error when you type it into the Page. And if you're always typing your manager's name, it’s a bit 

annoying to have to go in and ignore the error each time. So what you could do is add the word 

to the dictionary instead. So the next time you type it, OneNote knows that that's an actual word, 

and it doesn't highlight it as an error.  

But in this case, I'm going to select Microsoft. And you can see it updates that word. So I'm 

going to double-click to delete that out because I don't need it. But hopefully you get the idea. So 
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if you want to check your spelling and your grammar as you go, just make sure you turn on those 

two little options. Now the alternative thing that you can do is you can spellcheck each of your 

Pages at the end. So if I jump up to the Review tab, you can see I have a Spelling group here. 

And the first option is Spelling. So let's click that button. And you can see it's telling me 

straightaway, the spelling check is complete.  

So essentially, I've been pretty good here. I haven't got a misspelled word or a grammatical error 

on this Page at all. Let's click on Ok to get rid of that. Now let me jump to a Page where I know I 

do have some errors. I'm going to go into my Courses Section group. And on the OneNote Page, 

let's run our spellcheck again. Now this time, you can see that I have the spelling pane opened on 

the right-hand side. And it's picked up the word Powerpoint. And that's because I've used a 

lowercase p within this word, and it should really look like this. And you can see that I've got 

some suggestions underneath which I can choose from.  

So I'm going to say I meant PowerPoint with a capital just to replace that word, it's been picked 

up the word wont. So you can see that I've missed out an apostrophe. Now as I'm going through, 

you can also see that the word that I'm currently spellchecking is highlighted in the Notebook. 

And this is a good opportunity for you to see the different visual indicators applied to different 

errors. So because this is a grammar error, as opposed to a spelling error, the word has a blue 

double underline or a spelling errors have that red squiggly underline. So once again, the 

suggestion I have here is correct.  

I'm going to select it to replace it moves on to the next one and I can see Hear that this is actually 

a spelling error. So this should say; “I can't wait to dive into it”. So once again, the suggestion 

here is correct, I'm going to select to change it to wait. And then I have another grammatical 

error. Once again, I've missed out an apostrophe. So I'm going to accept this suggestion. And 

now my spelling check is complete. Now, it's worth noting with this spellcheck that you can only 

check one Page at a time, there isn't any feature that allows you to define the scope of what 

you're checking.  

So I can't say to OneNote, check the entire Notebook, which would include all Sections and all 

Pages, I just have to check each Page separately. So how you want to manage that whether you 

want to do it as you go or do it right at the end is entirely up to you. Now let's do one final 

spellcheck. I'm clicked on the Schedule tab in the Course Plan group. And I can already see here 

I have the word SharePoint repeated throughout this little table, which has a red squiggly 

underline. So it's telling me that it's a spelling error.  

So I can jump back up to Spelling, I can see that once again, it's because I haven't capitalized that 

p. So, I'm going to select the suggestion and replace that for each of these by simply clicking. 

Again, there's no way to replace them all in one go, unfortunately.  

So that's it for this module, and also for this Section. We're going to be moving across into 

Section 5 now where I'm going to show you some more tools available to organize your content. 

So, I'm looking forward to it. I hope you will join me. 
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Video: Windows 10 Formatting Notes 

 

Deb: Hi guys, and welcome back to the course. So now let's take a look at some of the things 

that we've learned in this Section in the Windows 10 version of OneNote. So the first thing I'm 

going to do here is I am working in Project Sierra, I'm on the ToDo List Section, and I'm 

currently clicked on the Monday Page. And currently I have a single note in there that says 

Remember to call the bank.  

Now, what I'm going to do here is I'm going to press Enter, I'm just going to add a bit of a title, 

and I'm going to call this Important Things. And what I want to do here is apply some formatting 

to this title. And you'll see as I highlight Important Things, I get that little mini toolbar pop up, 

that's going to give me some of those formatting options that I might find useful. And if I click 

on the three dots, it’s going to give me access to a lot more options as well. Now it just so 

happens that the option that I want to use isn't on this mini toolbar.  

So, I'm just going to select Important Things and go up to the Home tab. Because, what I want to 

do here is I want to apply one of those Heading Styles to really make this title stand out from the 

points below. So I'm going to go all the way across this ribbon to where we have Heading 1, 

click the drop down, and I'm going to give this a Heading 2 heading. So once again, when it 

comes to applying Styles, it works in exactly the same way as OneNote for Desktop.  

Now what I want to do is I want to add some Tags. And again, we're working on our Home 

ribbon. And if we go over to this little checkbox item and click the drop down, this is where we 

can find all of our Tags. Now the list in OneNote for Windows is not as comprehensive as what 

you'll find in that Desktop app. If you remember, we have a very long list of Tags to choose 

from, but we have a few really important ones. So the To Do List checkbox, the Important Tag, 

Questions, Remember for later, and also Definition.  

And of course, if you want to, you can jump into here and create your own Custom Tag. So 

maybe I want to be able to tag contacts. So I'm going to call this one Contacts, I'm going to select 

an icon. Now for this, I'm going to jump to All Icons, and let's see what we've got in here. I'm 

going to select this one, click on Create, it's telling me my tag was created successfully. So now 

if I click that drop down, I should be able to find my newly created tag in here. And of course 

right at the bottom, I have the option to Delete my Custom Tags, which at the moment is only 

this Contacts one. Now I don't want to delete it.  

So let's just go back because the one that I want to choose is the To Do Tag. And that's going to 

give me that all important checkbox. And then when I hit Enter, I can carry on going through and 

typing in my checklist items. Now, if I wanted to create another list down here, and I'm gonna 

say Medium Priority, it might be that I want this to take on the same formatting as the Important 

Things heading. So what I could do is I could jump up to the Home tab and just apply Heading 2, 

but I could utilize my Format Painter.  

So I'm going to select Important Things because that contains the formatting I want to use. And 

then on that Home tab, in the middle, I have a Format Painter icon. So let's click it once to 
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activate. And then all I need to do is paint over my text to apply the same formatting, hit Enter. 

And I can now enter my Medium Priority To Do Items, like so. And once again, I could tag these 

if I wanted to. I'm going to select both items, jump up to my Tags, and this time, I'm going to say 

that these are Important.  

Now one other thing we took a look at in this Section was utilizing Spellcheck. Now with 

OneNote for Windows 10, if you go through all of these Ribbon tabs, then you won't find an 

option on here for checking spelling. And that's because OneNote is set up to check your spelling 

as you type. So for example, if I was to go into here and make a blatant spelling mistake, so let's 

say I say like that, once I click away, then OneNote is going to highlight that to me by a red 

squiggly line letting me know that I have a spelling error just there.  

So what I can do is right-click, go to Proofing, and it's going to give me some suggestions. I can 

also choose to Ignore or Add to the dictionary from here. So I'm going to choose the correct 

spelling which is priority, and it fixes that spelling error for me. The same thing is going to apply 

with grammar. Now if you want to check what you have set up for your Spelling settings, if you 

go up to the three dots in the top corner, and then choose Settings and go to Options, if you scroll 

down, you'll see that underneath Proofing, you want to make sure that you have Hide spelling 

errors toggled off.  

This means that OneNote is going to check as you type. So if you know that you have a spelling 

error but OneNote isn't recognizing it, it's probably because you've got this setting toggled on. 

So, don't forget to check that. So, that is it for this Section, I will see you in the next one. 
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Section 5 – Searching a Notebook 
 

Video: Searching a Notebook 

 

Deb: Hello everyone, and welcome back to the course. We're down into Section 5. And in this 

Section we're going to explore some of the tools that you have when it comes to organizing 

content. And we're going to start out this Section by talking about Searching.  

Now one of the main advantages of using OneNote instead of a more traditional paper Notebook 

is its ability to quickly search through all of the content that you've collected and retrieve 

important notes based on the criteria that you've selected. So the ability to search is a lot more 

efficient than having to look through every single Page in your Notebook in order to find the 

content that you're interested in.  

And one of the coolest things about OneNote is even if you've inserted some kind of picture, or 

maybe a Screen Clipping, you can make those searchable as well. You can even search for 

spoken word notes in things like video and audio recordings. So the Search feature is extremely 

powerful. It's also very simple to use. So let's dive in and take a look at a couple of examples. So 

currently, I'm clicked in the Offices Section on the Overview Page. And if you cast your eyes 

over to the right-hand side, where we have all of our Pages listed out, if you look just above 

there, you'll see that there is quite a small Search bar, the keyboard shortcut is Ctrl + A.  

And this is where you can search for a keyword or a phrase throughout all of your notes and even 

across multiple Notebooks if you need to. Now before we type in our keyword, I want to draw 

your attention to this little drop down arrow next to the Magnifying Glass icon. Because this is 

where you can come to set the scope of your search. So it might be that you want to just search 

on the Page that you're currently on, you might want to search the entire Section. If you're 

clicked within a Section Group, you might want to limit your search to that, you can search This 

Notebook, or you can search across All Notebooks.  

So if you have more than one Notebook open, you can search across multiple. So for this 

particular search that I'm going to run, I'm going to search in this Notebook. And straightaway, 

it's going to pop open this little Search pane. And you can see here some of my recent search 

results. So now I've set my scope, I just need to type in my search term. So let's type in the word 

“team”. And you can see straightaway what it pulls through. So it's telling me that it's found the 

word “team” twice on two different Pages. So To Do Items, and also Overview.  

Now Overview is the Page that I'm currently clicked on. And you can see yes, in fact, it has 

highlighted the word “team”, wherever it's found it. You'll also see it's picked up “team 

assignments”. So if I click on this, it's going to jump me across to that particular Page. And once 

again, I have the word “team” highlighted throughout this Page. If I click up here and type in the 

word “Europe”, once again, it's showing me that it's found that word on the Course Plan Page, 

and also in my Overview Page, and once again on the Offices Page. And you can just click to 

jump to those respective Pages.  
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Now if of course I was to change the scope of my search from All Notebooks to Find on This 

Page, it's telling me I have two matches, and it allows me to scroll through using these arrows. 

So currently, I have the document Course Plan Europe highlighted. If I click the down arrow, it's 

going to move to that heading of Europe in the table. And of course, when you're done with a 

search if you just click on the cross to clear that, and you can then perform a different search.  

Now one thing you can also do in this particular window is right at the bottom, you can pin your 

search results. And you can see the keyboard shortcut for that is Alt + O. So if you find that 

there's a search that you're running all the time, instead of having to go in and recreate the 

keyword each time, you could choose to select the search that you want to pin, click Pin Search 

Results. And then you can essentially rerun any of these searches.  

Now also from this drop down where we set the scope, if you find that you always want to search 

across All Notebooks or maybe you only ever want to search in This Notebook, you can choose 

to set the scope as Default. So for me normally when I'm searching, I want to look across every 

Page that I have in my Notebook. So I'm going to say that I want to set All Notebooks as my 

default. So every single time I run a search, I know that I don't have to go into here and select my 

scope because All Notebooks is going to run automatically.  

Now I mentioned at the beginning, one of the coolest things about working in OneNote is that 

you can make Screen Clippings, Pictures, texts contained within them searchable. So for 

example, if I scroll down to where I have my Team Leader assignments, if you remember, this is 

actually a Screen Clipping. And you can see underneath, I have Screen Clipping, and it shows 

me the date that this clipping was taken. So the text contained within here, I can't actually click 

on it to edit it, but I can make it searchable.  

Now, if I right-click, you'll see right at the bottom, I've got a menu item that says; “Make text 

image searchable”. And I can then select the language. So I'm going to click English United 

States. And then if I was to search for something specifically within this image, so let's go back 

to our Search bar and clear the search. And I'm going to search for five weeks. And you can see 

here my search result is telling me that it's found this word on the Overview Page, which is what 

I'm currently on. And you'll see that it's highlighted within this image, essentially, where I have 

five and weeks. You'll notice that it takes both words and searches for them.  

So it's picking up the start date to the 5th of January 2021. It's picking up five weeks, but it's also 

picking up anything that also contains the word “weeks”. So if you want to be a bit more specific 

and only search for this particular term, so where it says “five weeks”, if you come back to the 

Search bar, and put it within quote marks, and then run your search, you can see now it's simply 

highlighting that exact word. So just be aware of that. If you have two words, you'll need to put 

them in quote marks.  

So, if I click the cross, and for example, if I wanted to search for “Selected Team Members”, I 
would put that in quotes. Once again, now you can see that it's looking for that particular phrase. 

Now one thing you also might notice is right at the top of the screen, we have another Search 

bar. So, this works a little bit differently as it's more for searching for specific commands. So if I 

wanted to know how to insert a table, I can type that in and it's going to show me exactly where I 
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need to go in order to insert a table into my Page. But also underneath you can see it says, “Find 

in Document”.  

So, essentially, this part is doing exactly the same as what we do over in this little box on the 

right-hand side. So in this case, it's looking for the phrase “insert a table” throughout my 

Notebook, and then finding the bottom out allows me to very quickly access Help on how to 

insert a table. So this Search bar at the top is slightly different but can be utilized in a similar way 

to the Search on the right-hand side.  

So, a few different options there when it comes to searching through your Notebooks. But I hope 

you agree, all very straightforward. That's it for this module, I will see you in the next one. 
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Video: Tagging Notes 

 

Deb: Hello everyone, and welcome back to the course. We're down in Section 5, where we're 

taking a look at how we can organize information effectively in OneNote. And in the previous 

module, we took a look at how we can search for different items throughout our Notebook or on 

specific Pages.  

And in this module, I want to talk to you about Tagging notes. Because this is a really cool little 

feature that's really going to help you organize your notes better, and find important information 

quickly. Now, Tags are essentially a way to categorize and prioritize notes in OneNote. So with 

Tags, you can quickly return to important items, you can remind yourself about action items, and 

you can filter out the notes that you might possibly want to share with others. And when it comes 

to Tagging, you can Tag a single line of text, or you can Tag an entire paragraph. So let's take a 

look at how it works.  

Now Currently, I'm clicked on the To Do List. And if you remember in a previous module, we 

used the To Do Tag to insert these little To Do Item checkboxes. So we're going to stay on this 

Home ribbon, and we're going to go to the Tags group. Let's expand so we can see all of the 

Tagging options that we have. And you can see that there are many. Now all of these Tags can 

be customized if you want to change the icon or maybe change what the Tags says. But let's start 

out by using some of these Default Tags, so you can see exactly how they work.  

Now for this, I'm going to jump across to the Offices Page. And I'm going to start out Tagging on 

this London Page. So you can see at the top here I have an Office address. Now this might be 

quite important information that someone might need to get to quickly. If you can imagine if a 

staff member is going out to do some training, they might quickly need to access the map and 

also the address of the location. So what I could do is Tag this piece of information.  

So I've positioned my cursor just in front of Office address, I'm going to go up to Tags, and I'm 

going to browse through for an appropriate Tag for this piece of content. And you can see I have 

one here that's called Address. So let's click, and you can see it adds that little icon next to the 

Office address. Now I'm going to go through this Notebook and Tag other items. And then at the 

end, I'm going to show you why this is particularly useful. So let's go back to the Overview Page. 

And on this Page, I have the dates that this rollout is going to commence.  

So again, this might be information that's quite important, and someone might need to access 

quickly. So I'm going to click at the front of the sentence, go up to Tags, and I'm going to take 

this as Important Information. I might also decide that the Team Leader Assignment is pretty 

important. So once again, I'm going to Tag that as important. And I'm also going to Tag the 

Rollout Order as Important Information. Let's move across to the Travel tab, and here I have 

some websites. Nevertheless, I'm going to Tag all of these.  

So I'm going to select them all, go up to my Tags, and you can see I have a little website to visit 

Tag just here. Click it, and it applies a Tag to all of them. Let's jump across to Costs. I'm going to 

select this placeholder because this is a clipped image, up to Tags, and we're going to say that 
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this is Critical Information. Let's jump across to Schedule, and here I have the Cost Plan for 

Europe. And it might be that I want to discuss this in a Team Meeting. So I'm going to select the 

Cost Plan Europe. And I'm going to Tag this with a little checkbox to remind me to schedule a 

meeting. And then finally, we'll go across to Important Emails. And, I'm just going to select the 

signature at the bottom here and Tag this as a Contact.  

Now I could carry on going through but hopefully you get the idea you just run through and add 

your Tags wherever necessary. So how is this useful? Well, it becomes more useful when we go 

to the Find Tags option in the Tags group. Because this allows us to view all of our Tagged 

notes. So let's click on Find Tags. Now I can choose how I want to group these Tags. So 

currently, I'm grouping by Tag name.  

So you can see here underneath, it’s showing me everything that I've tagged with the Address 

Tag, which is just one item. It's then showing me everything I've tagged with the Contact Tag, 

the Critical Tag, the Important Tag, Schedule a Meeting, To Do, and Websites to visit, and it's 

searching across all of this Notebook. Now of course you can come in here and change the scope 

if you’re just interested in Tags on a specific Page or in a specific Section. But, I'm gonna keep 

mine on This Notebook. And you could also choose to Group By something else.  

So instead of Tag name, you might want to group by Section. So now you're seeing Costs, and 

all of the Tags I have in there; Important Emails, Offices, so on and so forth. Now, I normally 

prefer to group by Tag name. So this enables you to kind of jump around your Notebook by Tag. 

So for example, these Important Items just here, it's very simple for someone to just click on the 

item, and it's going to jump them to that specific Page. Now another thing that I really like about 

this is right at the bottom, you have the option to create a Summary Page. So let's click this and 

see what we get. So, it basically creates a brand new Page for me.  

And if I just get rid of the Tag summary, you can see at the bottom, it's just got the default name 

of address, which I'm probably going to want to change. So I might change this to Tagged Items. 

And then it lists out all of the Tags and the contents contained within them. So you can 

essentially have all of your Tagged Items, all of the Important Information, things you need to 

reference on one Page, regardless of where they are within the Notebook. So this can be a super 

helpful little feature to really filter out the noise of things you don't need to know and highlight 

the important stuff.  

Now of course, once you have added Tags in, you can remove those Tags. So for example, if I 

go back to where I tagged the Office address, I can right-click, and I have the option to remove 

the Tag, and then it's not going to appear in your Tag results. And if you want to remove multiple 

Tags at the same time, you just need to select all of the texts where you have Tags and press Ctrl 

+ 0 to get rid of all of them.  

Now, as I briefly mentioned, you can also customize your Tags. So if we click the More drop 

down once more, you'll see right at the bottom, we have a Customize Tags option. And we 

actually did this because we customized our To Do Tag. We changed the style of the checkbox, 

and we also change the color of the text to display. But you can select any of the Tags and 

customize them to your needs. So if I scroll down, I can see here I have a Tag called Project A, 
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what I'm going to do is I'm going to select it, I'm going to modify the Tag, and I'm going to call 

this Project Artemis, I'm going to give it a different symbol.  

So let's just give it a green triangle, I'm going to change the font color again to a darker green. 

And I could choose to have a highlight color if I wanted to. Click on Ok. And now whenever I 

use that Tag, it's going to look like this. You can also create your own Tags from scratch, 

utilizing the New Tag button. So maybe I want a Tag called Important Dates. I'm going to 

choose a symbol for that. So I'm going to use this little red square. I'm going to change the font 

color to a bright red. And I don't want to have any highlight color. Let's click on Ok, and now I 

have that Tag available.  

And of course in here as well, if you want to reorder your Tags and have the ones that you use 

most often at the top, you can. So if I select Important Dates, I can use my arrow just to move 

that all the way up to the top just underneath my To Do Tag. So let's click on Ok. I'm going to 

jump back to my Office's Section and into the Overview Page. I'm going to click at the start of 

this first sentence, which contains the dates that the Rollout will commence on and also end on. 

I'm going to jump up to my Tags, and I'm going to utilize my Important Dates Tag. And you'll 

see that it changes that text to red so that it really stands out from the rest of the document.  

So pretty easy to add Tags that are already contained within OneNote, modify them, and also 

create your own and apply them to your Notebook. And then, use that Find Tags option to create 

a Summary Page, which is essentially going to list out everything that you've tagged, and filter 

the important stuff from the unnecessary noise.  

I hope you found all of that useful. Definitely start playing around with Tags because that's 

something that's really wonderful in OneNote. That's it for this module, I will see you in the next 

one. 
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Video: Organizing the Interface 

 

Deb: Hello everyone, and welcome back to the course. We’re still down in Section 5. And in this 

Section, we've been taking a look at how we can organize different pieces of content in our 

OneNote Notebooks. So what we're gonna do in this module is we're going to take a look at how 

we can organize our Interface. So how we're actually looking at our Notebooks and our Pages. 

And for this, we're going to be working predominantly on the View tab, and you can see that that 

is currently the tab that I'm clicked on.  

Now, if we start in the first group, the Views group, you can see that the Normal View is 

currently highlighted with a gray box. So that indicates to me that currently, I'm working in 

Normal View. And in Normal View, you have this kind of standard layout. So I can see all of my 

ribbons, I can see my Quick Access Toolbar. And of course, I can see my Notebooks, my 

Sections and my Pages. And in general, this is probably the view you're going to find yourself 

working in most of the time.  

However, we do have a couple of other options when it comes to how we're viewing our screen. 

So, let's explore them. Let's switch into the next option that we have in this Views group, which 

is the Full Page View. Now you'll see as I hover my mouse over that there is a shortcut key, 

which is going to allow you to quickly switch into this view, and that is F11. And you can see 

underneath in the ScreenTip it says, “Feeling cluttered? Show only the Current Page”. So that 

gives you a little bit of an idea as to what's going to happen when we click on this button.  

Pretty much everything collapses down. And you're just left with a Full Screen View of the 

Current Page that you're working on. So this is particularly good. If you have a lot of information 

on the Page and you feel you would work better if you had a bit more space, then switching into 

this view can be quite helpful. Now if you're wondering where all of your other Pages have 

disappeared to, if you cast your eyes to the top right-hand corner, you can see that up here it says 

Project Artemis and Offices. And if I click the little drop down, it's going to allow me to switch 

into different Pages.  

So, if I wanted to quickly jump to the London Page, I can click it. And we're going to switch into 

there, click on the Page, and I'm now working in this particular Page. So you're not simply just 

stuck on the Page that opens first, you can switch between them simply by selecting them from 

this Section in the corner. Now if at any point, when you're working in this view, you need to 

access something that's contained on the ribbons, then you can pull those down temporarily as 

well. 

So, if you look just above where my cursor is currently clicking, we have this gray bar, which 

changes to purple as I hover over it, and there's three little dots right in the middle. So if you 

click just here, it's going to temporarily drop down those ribbons for you. And you can then go in 

and select whichever option you need. When you click back on your Page, that ribbon is going to 

collapse back up again. And if you want to come out of this view entirely, if you click on the 

diagonal, double-headed arrow in the top right-hand corner, that's going to switch you back to 

Normal View.  
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So Full Page is a great view if you want to just declutter the screen and focus in on one particular 

Page. Now the next little option that we have in this Views group is Dock to Desktop. So let's 

hover over and take a look at the ScreenTip. Once again, we have a keyboard shortcut to quickly 

switch into this view of Ctrl + Alt + D. And it says, “Keep your notes visible by anchoring this 

OneNote window to the side of your desktop. Your notes will stay on top whilst you work in 

other programs”. So this is a great little view if you like to write notes, but still working other 

programs.  

So for example, imagine that you're on a Zoom call or you're in a meeting, you want to be able to 

see that Zoom call, see the meeting, but maybe you want to write some notes, you could use this 

option for that. Or maybe you're working in a Word document and you want to copy and paste 

content very quickly between Word and your OneNote Notebook, this is a good view for that as 

well. Or maybe you're working with your Outlook emails, and you want to be able to refer to 

them as you type up some notes. This view is going to allow you to do all things like that.  

So let's click on this view. And there we go. So you can see what happens is that you get kind of 

a split screen going on just here. And three quarters of that screen is pretty much made up of one 

application. In this case, it's Outlook, which is what I had directly beneath OneNote. And then a 

small part of the screen is showing your notes. So if I was looking through my emails and I 

wanted to take some notes, this is a nice way of doing that. It means you don't have to keep 

switching between applications because you've got them both on the screen. And this is actually 

what we call Linked Notes. And we're going to talk more about Linked Notes in an upcoming 

module. So for now, what I'm gonna do is I'm just going to click to switch back to Normal View. 

Now a few other options you have on this View tab, when it comes to organizing the Interface 

are located in this final group, the Window group. So what I can do here is I can choose to open 

a new window, keyboard shortcut Ctrl + M, and it says; “Open a second window for your 

documents so you can work in different places at the same time”. So if I click New Window, it's 

basically going to do just that.  

So if I wanted to work in two different Pages at the same time, so let's maybe select, let's select 

something different, maybe I wanted to work in the Costs Notebook. And what I could do is 

utilize the Snapping abilities of Windows 10, and snap it over to one side of the screen, and then 

open up my other workbook in the other side of the screen. So essentially, I can work on 

different Pages at the same time. So that is your New Window option.  

The second option we have is New Docked Window. So this is going to open a new OneNote 

window and anchor it to the side of your desktop. And your notes will stay on top whilst you 

work in other programs. So let's click that. And this is pretty much the same as that Dock to 

Desktop option as well. So this window is always going to stay on top no matter which 

application you have open. And it allows you to quickly take notes whilst viewing information in 

other applications.  

The next option in here is New Quick Notes. Now Quick Notes isn't something that we've 

discussed thus far. You'll see the keyboard shortcut there is Ctrl + Shift + M. And it allows you 

to quickly jot down your thoughts in a new window. So the idea behind Quick Notes is, 
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sometimes you're not as organized as you might like to be. So it's all very well and good creating 

a new Section with a nice heading and then some Pages with some titles. But occasionally, you 

might get a flash of inspiration when you're least expecting it. And you want to quickly jot down 

a note without necessarily going through creating a new Section, creating a new Page.  

So, if I click on New Quick Note, it opens up this little window, which is kind of like a little 

notepad. There's not a great deal on here. But it allows me to quickly jot down a note. And of 

course, with these windows, I can drag to make that window bigger, I can click in the Title bar to 

pull down my ribbons, or I can switch back to Normal View. Now if I just click Close on this 

window, you might be thinking, Okay, well, where has that note gone? Well, if we click the little 

drop down arrow, next to Project Artemis, you can see right at the bottom, here, we have a Quick 

Note Section.  

So if I click on Quick Notes, it's going to jump me through and show me those notes. And it 

keeps all of these little Quick Notes together in one place, so they're easy to find. And it might be 

at a later date, you want to copy and paste this information into the main workbook, or possibly 

delete them when you're finished. But that's the idea behind Quick Notes.  

And then finally, we have a little pin icon that says Always on Top. And this is pretty much what 

it says on the tin. If I click this is always going to keep this window on top. So, even if I try and 

switch to another applications, so if I try and switch across to Word, it's not going to do it. Excel, 

it's not going to do it. So, there might be occasions where you find that particularly useful. Now 

I'm not going to use this option at the moment, so I'm just going to toggle that off by clicking 

back on the button.  

So, those are pretty much the options that you have available on that View tab for organizing the 

way that your Interface looks. In the next module, we're going to move on to talking about 

Linked Notes. So, I'm going to head over there now, and I hope to see you there. 
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Video: Linking Notes 

 

Deb: Hello everyone, and welcome back to the course. We're still down in Section 5, where 

we're taking local organizing content in OneNote. And in the previous module, we went through 

some tips and tricks for organizing your OneNote Interface. And if you remember, I briefly 

mentioned Linked Notes. So what we're going to do in this module is explore that a little bit 

more fully, so you understand how you can use it and why it might be useful to you.  

Now, essentially, Linked Notes let you dock OneNote to the side of your computer screen so you 

can look at websites or other applications and take notes in OneNote. And when you do take 

notes in this way, it means that they're automatically linked to whatever it is that you're 

researching. Now, there's a number of different applications, which will allow you to take Linked 

Notes, so things like Internet Explorer, Word, PowerPoint, and even other OneNote Pages. So, 

let me run through a couple of the options that you have.  

So, this might look a little bit strange to you, because you'll notice that I've opened up a Word 

document. Now this Word document just has the heading of Course Details and then I have a 

load of junk text in there. But again, the content doesn't really matter. At this point, it really is the 

process that you need to learn. Now the reason why I'm in here is because if you take a look at 

the Review tab, which I'm currently clicked on, and cast your eyes all the way over to the end of 

this ribbon, you'll see that I have a group called OneNote and a button in there called Linked 

Notes.  

So when I hover over this button, you can see the ScreenTip says that, “OneNote will keep links 

back to this document for each line of notes”. You can open the OneNote notes by clicking this 

button again. So let's click it and see what happens. Well, the first thing it does is it docks 

OneNote over to the right-hand side, like we've seen in previous modules, but it also opens up 

the Select Location in OneNote dialog box. So I really need to tell OneNote, where I want these 

notes to be stored. So I'm going to say this is related to Course Details.  

So let's expand the Schedule Section, and I'm going to choose Course Details for these particular 

notes, and then click on Ok. So what it then does is in the OneNote window that’s docked on the 

right-hand side, it jumps me to that particular Page. And if you recall, the only thing that we have 

on this Page is a PDF file attachment to the Cost Descriptions, which we placed into this Page a 

bit earlier on in the course. And my cursor is now flashing and I'm ready to type my notes. Now 

any note I typed, I've essentially linked to this document. So let's type in a few lines of notes.  

Now you'll see as soon as I start to type, I get this little pop up message. It says; “Linked Note 

taking is running when OneNote is docked”. And then it says; “Will automatically create links in 

your notes to the documents or web Pages that you're looking at, so you can easily find them 

later”. And then it says; “If you want to turn this off, go to File options and Advanced”. So the 

first time you start to take Linked Notes, that's going to come up and I'm going to say Don't show 

me this again, and click on Ok.  
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So now I'm done taking my notes, I'm going to close down this Word document and also close 

down this docked window. So now if I jump across to the Schedule tab, now what you'll see here 

is that I have my Linked Notes at the bottom. And if I click in them, there's a couple of different 

places you can go in order to access any Linked Notes. So if you cast your eyes over to the top 

right-hand side of this particular Page, just next to this arrow, we have an All Linked Notes 

option. And what you'll see is when I hover over this icon, it's telling me that Linked Note taking 

is disabled. And that's because this will only show as active when you have OneNote docked.  

So if I quickly switch to View and go to Dock to Desktop, you'll now see that that red circle has 

been removed and Linked Note taking is now enabled. So essentially, it will show as disabled 

until you start taking Linked Notes. So, just bear that in mind. I'm going to make this window a 

little bit bigger, because what I'm interested here is viewing the original document that my notes 

link to. So what I can do is click this drop down. And if I hover over Linked Files, you can see 

there is the Word document that these notes are linked to. And of course I can just click to open 

that document in Word Online.  

Now another thing I can do from here is delete all the links on this Page. So if I no longer wanted 

it to be linked to this particular Word document, I can definitely delete the links. And then right 

at the bottom we have some Linked Note options. So this is going to jump you into your 

OneNote options into that Advanced area. And there's only really a couple of options that you 

can modify in here, you want to make sure that you have Allow creation of new Linked Notes 

checked if this is a feature you want to use. And then it's also good to have the second option 

checked, which says Save documents snippets and Page thumbnail for better linking to the right 

place in the document.  

Then finally at the bottom, we have another way that we can remove our links from Linked 

Notes. So a few different options that you have in there. Now alternatively, if you right-click 

your mouse on your notes, you'll also see that you have Linked Notes available in the Contextual 

Menu, where you can choose to open the link file, you can copy the link, edit it, remove the link, 

or jump back into those Linked Notes options.  

Now I've just switched back into that Word document again, I'm going to click on Linked Notes. 

Because there's one other little feature I want to show you in here. When you are in the middle of 

taking Linked Notes like I am right now, if you click the little chain link drop down at the top, 

you can choose to stop taking Linked Notes at any time. So it might be that you want to take 

notes, but only link some of them back to this document. So if I say Stop taking Linked Notes, 

I'm going to click down here and just type something in, switch back into Normal View, and now 

I can see my notes just here.  

But if I hover over and right-click, you'll see that I don't get the Linked Notes option because this 

piece of text isn't linked. The same thing if I click the chain link drop down and go to Linked 

Files, the only Linked Files on this Page are the ones from the previous placeholder. So that is 

how Linked Notes work. A really nice way of being able to take notes whilst working in another 

application, and have those linked back to the original document or source.  
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That's it for this module, and that is it for this Section, a very short Section this time. We're going 

to move on to Section 6, where we're going to be taking a look at formatting our Pages and 

working with some Page Setup options. So I'm looking forward to it, I hope you are too. I'll see 

you over there. 
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Video: Windows 10 Organizing Content 

 

Deb: Hi guys, and welcome back. So let's review some of the skills that we've learned in this 

Section for OneNote for Windows 10. Now if you recall, the last time we were working in 

Windows 10, I showed you how to add Tags to To Do Items. And we also went in and created 

our own Custom Tag.  

Now one thing that I didn't show you how to do in relation to Tags is how to search for specific 

Tags. We can basically create a Summary Report where we can see all of our Tag groups and 

then the items that belong to those categories. Now we can do a similar thing in Windows 10. 

And for this, we need to go over to the Menu bar on the left-hand side.  

So the second icon that we have here, the Magnifying Glass that says “Show Search” when we 

hover over, if I click that, it's going to pop open a pane. And this is where you come to search for 

keywords in your Notebook. But also where you can essentially search by Tag. So you can see 

here that it's picking up that in my Notebook, I've utilized two different types of Tags; the To Do 

Tag and the Important Tag. And if I just want to search by the Important Items, I can select it. 

And it's going to show me underneath all of those items.  

I can choose to toggle to Page and it's going to show me the Page that those items reside on. So it 

works a little bit different to the Desktop version, it's not quite as functional, as in, you can't 

create a Summary Page. But you can still search by Tag. Now if we just remove Important from 

here, because this is also where we come to search for any keyword across our Notebook. So if I 

was searching for the word, let's say “important”, you can see here, it's going to highlight it, it's 

going to tell me what Page that word is located on. So, a very simple search, but does the job.  

Now something else you also have under here is the ability to show your Recent Notes. So if I 

click on this little clock icon, that's going to show me all of the recent notations that I've made 

and what Page they're on. And of course, I can click on any of these to jump to that specific 

Page. Now something else that we covered in this Section was organizing the Interface.  

Now when you're working in OneNote for Windows 10, you'll find the options that you have on 

the View tab. Now we don't particularly have a great deal of options in here, we can create a new 

window. So this is good if you want to work in two different parts of your Notebook at the same 

time, you can display the Notebook into separate windows and maybe utilize the Windows 10 

Snapping functionality in order to get those to display nicely in each half of the screen.  

You also have the Immersive Reader option, which is going to open your Notebook in the 

Immersive Reader, it makes your text a lot bigger. And it essentially clears everything else off 

the screen. So this is good if you are reading something that's reasonably long, you want to clear 

away all the clutter and just focus on your notes. You can of course utilize the icons at the top to 

change things like the Text Size if that's a bit too large. You can change the font and also the 

theme to make it a little bit easier on your eyes.  

You can set your grammar options. And if you want to have syllables highlighted in the words. 

So this can also assist your reading. And if you want to, you can really highlight different parts 
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of speech. So if you want to highlight all of the nouns, you can turn this on. And you'll see that 

those are going to highlight in pink or whatever color you've chosen from the color palette. I can 

also turn on verbs, so on and so forth. So all of these things here just to make it a little bit easier 

for you to focus on what you need to focus on and read what you have on the screen.  

And then finally, I can open up the reading preferences pane and adjust how many lines I want to 

focus on. So maybe I want to focus on three lines at a time or maybe a few more, or maybe just 

one line. And then I can also choose to translate to another language. So the Immersive Reader 

can be pretty useful. Now the other ways that you can organize your Interface obviously you 

have some Zoom buttons just here.  

So you can zoom out or zoom in to make things a little bit bigger. You can set your Zoom to 

100%, you can set it to the Page width, and you have some further options when it comes to 

organizing your Interface available through the ellipses and Settings and Options. So for 

example, I'll just point out a few of them in here. If you scroll down, you can do things like turn 

on Legacy Navigation pane, or enable Print Previews. You can specify where you want new 

Pages created.  

So if you want them to be created below the selected Page, at the top of the Pages list, or at the 

bottom of the Pages list. You can set your Default Font from here and also options related to how 

you’re pasting your content. Whether you want the default to be Keeping Source Formatting, 

Merging Formatting, or Keeping just the Plain Text Only. So a few other things in there.  

But again, with this version of OneNote, you don't have quite as many as you do in the Desktop 

version. That's it for this module, I will see you in the next Section. 
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Section 6 – Page Setup Options 
 

Video: Page Setup Options 

 

Deb: When working in OneNote, it's important to be familiar with Page Setup options, and 

customize them to reflect your personal style and workflow preferences. Now, OneNote has 

many features that can be customized to maximize the interface, and also improve your 

efficiency when completing tasks.  

Now most of your OneNote Page Setup options can be found on the View tab in the Page Setup 

group. And from here you can do things like change the Page Color, Add Rule Lines or 

Guidelines, Hide the Title, or even set the Paper Size if you want to print. There are also some 

cool options you might want to change in the File, OneNote Options area.  

For example, you might want to set up OneNote to use a specific Font or Font Size as the 

default. Or maybe you want to customize the look of the interface. Maybe you want to choose 

which navigational options appear on the screen, or maybe even do things like set the Default 

Zoom Size.  

Now all of these things come under the Heading of Page Setup. So with all that said, let's jump 

into the next module and start exploring Page Color and other stylistic settings. 
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Video: Page Color and Background 

 

Deb: Hello everyone, and welcome back to the course. We're down into Section 6, where we're 

taking a look at the different options we have when it comes to formatting our Pages. And in the 

first module of this Section, I just gave you a quick overview of the different Page Setup options 

that you can customize and apply. So let's now start to explore some of those in detail. And we're 

going to start out in this module by taking a look at our Page Backgrounds.  

Now, by default, any new Page that you create in your OneNote Notebook, it's just going to have 

this plain white background. Now, it might be that you're completely happy with that, and that is 

totally fine. But it also might be that you want to apply a Background Color, or maybe even 

utilize Page Colors to visually group together Pages that are related, much like we did with our 

Section, Tab Colors.  

So to make any changes to the Background Color of your Page, if you jump up to the View tab, 

in the Page Setup group, we have a Page Color option. And when we click on the drop down 

there, you can see that we get a palette of pastel colors. And of course, it's a simple process of 

just clicking to apply that color to the Page. Now if you decide that you no longer want the Page 

Color, just jump up to that Page Color drop down again, and make sure you select the No Color 

option.  

Now another thing that you could do with your Pages is use an image as the Page Background. 

Now there are some drawbacks to using an image. The main one being that if you set a nice, 

colorful or very busy image as the background, sometimes it's really hard to be able to see your 

notes over the top. Particularly if the color varies greatly in the picture, it's not really going to 

matter if you change the font to black or to white, it's going to be quite hard to see.  

So first, I'm going to show you how you can utilize an image as a background to your Page. And 

then I'm going to show you a slightly better way of doing it so that you can actually see the notes 

that you place on top of the image. So what you could do is jump up to Insert and go to your 

Images group and utilize a picture either one that you have saved off locally, or one that you've 

browsed for online. And I'm just going to pick something that I have in here. Let's do this one 

here, London Eye, and click on Insert.  

So we could insert this picture. Maybe I want to resize this to make this a lot bigger, so it takes 

up the entire Page, and maybe I just want to reposition that a little bit, like so. And maybe I've 

decided that I want to have this image as the background on the Page. Now currently, this is just 

an image contained with its own placeholder. So I can click on it, and I can move it around. 

However, if you want to have this as a background image, meaning that you can place other 

things on top of it, all you need to do is right-click on the picture, and you have an option here, 

Set Picture as Background. And you'll see exactly what that does.  

So now I have a placeholder just here, which I can start typing in. But it's sitting on top of the 

image because the image is now essentially part of the background. But you'll see the problem 

that we have here, if I just start to type some junk text, you can see that it's quite hard to see. And 
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that picture is very distracting. Now the main point of having notes in OneNote is that so 

everybody can see things easily and clearly. So for me a lot of the time, an image inserted in this 

way doesn't particularly work too well.  

So let me show you a way that I prefer to do this. I'm going to Ctrl + Z a few times just to get rid 

of everything out of here. Because what I prefer to do is if I do want to utilize a background 

image, I prefer to create one in something like PowerPoint, first of all, adjust the transparency on 

the image, and then insert into OneNote. Unfortunately, OneNote doesn't really have any image 

editing capabilities. So any editing you do to the picture really needs to be done outside in 

another application.  

So I've jumped across to PowerPoints. And what I have here is that same image of London, but 

what I've done is I've adjusted the transparency. So you can see here I've got my Transparency 

options. It started out like that, but I've taken it all the way down to something super light. So I'm 

still getting a bit of that image peeking through, but it's not going to overpower any text that I put 

on top of it. Now once you've set that, what you can do is then right-click and save it as a picture. 

And I've actually already saved this previously, so I'm just going to say London background and 

click on Save. I'm going to say Yes to replace.  

And then when I jump back to OneNote, I can do the same process. I can insert the picture, 

London Background, click Insert, and then I can resize this as well if I wanted to take up the 

entire Page. And then right-click and set the picture as a background. Then every note I type on 

top is a lot easier to see. So if this is something that you do want to do, I just wanted to show you 

there are a couple of ways that you can do it. But there are definitely a few things in there, which 

you really need to think about prior to using a background image. Now for me, I tend to be fairly 

happy with just one of these pastel Background Colors. They're quite plain, but just add a splash 

of color.  

Now something else you might want to add here are Rule Lines. And you'll see in the Page Setup 

group, if I click the Rule Line drop down, we have two groups in there, Rule Lines and Grid 

Lines. So this is just going to add guidelines Rule Lines of various different heights to your Page. 

So I can choose to have Narrowed Rule Lines, I can make them a bit wider by selecting College 

Rule Lines. And then I have even wider ones, Standard Ruled, and then finally, we have Wide 

Ruled.  

And you also have a selection of grid lines if you would prefer to use those. Now I'm going to 

keep mine on College Ruled. So what these do is they kind of tend to mimic a manual paper 

Notebook in many ways. But I find these particularly useful when I'm working with OneNote on 

a Touchscreen device. So if I'm using a Stylus, and I'm handwriting my notes, these are a great 

way for me to make sure that all my notes are straight and organized. Because if I don't have any 

Rule Lines, I tend to write in a little bit of a diagonal fashion, it never looks the neatest. So that is 

where I find Rule Lines can be super useful.  

Now of course, you have a couple of other options in here. If you want to change the Rule Line 

color, you can definitely do that as well. And if you want to make sure that every time you create 

a new Page in OneNote, it's always created with Rule Lines, you can tick this bottom option so 
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that when you add a new Page, there are your Rule Lines. So those are the options that you have 

within Page Setup to add a bit of style, a bit of flair, and also a bit of functionality to your 

OneNote Pages.  

In the next module, we're going to continue talking about Page Setup options. But this time we're 

going to dive into the OneNote Options in the backstage area. So I'm going to jump across there 

now, and I hope to see you over there. 
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Video: Changing Font Themes 

 

Deb: Hello everyone, and welcome back to the course. In the previous module, we started to 

take a look at the options that we have when it comes to customizing the Background of our 

Pages. And we've been working predominantly on this View ribbon tab.  

So what I want to do now is just jump across into the File menu, the backstage area, and check 

out some of the OneNote options related to Page Setup. So we're gonna click on File, and let's 

jump into our Options. So we're on the General tab. And the first thing I want to draw your 

attention to here is this Default Font Section.  

So you can see currently, the Default Font in use for OneNote is Calibri, size 11, with a font 

color just set to automatic, which in this case is black. And whenever I create a new Page in 

OneNote, this is going to be my Default Font size and font color. Now, it might be that you 

prefer to use a completely different font, maybe something that's a bit larger, or maybe even a 

font in a slightly different color. And whilst you can utilize the Home tab and manually change 

the font, it's always going to go back to your default when you create a new Page.  

So if you want it to be a certain font size and font color, every time you create something new, 

then you're going to want to change the Default Font. So I'm going to click the drop down, and 

I'm going to go down, I'm going to choose something different. Let's go with one of my favorites 

Segoe UI, and I'm going to say that I want my font size to be 12 points, so a little bit larger than 

what it currently is. And I could even change my font color to a dark purple, and click on Ok.  

So now if I was to click somewhere on my Page and start typing my notes, you can see that the 

font that's in use, if you look at the Home ribbon is Segoe UI, it’s size 12, and you can see that 

this is kind of that very dark, aubergine, purple kind of color. And every time I create a new 

Page, I'm gonna get those same font settings. So definitely worth jumping into File and Options 

and just reviewing your Default Fonts.  

Now another thing you might want to do and again, this is more of a stylistic preference is 

change your Office Background and your Office Theme for OneNote. So this falls under the 

personalizing your copy of Microsoft Office. So I'm I want to change my Office Background to 

let's do clouds. And I could even change my Office Theme to something like dark gray. So when 

I click on Ok, you'll see what happens.  

Now the Office Background is quite hard to see. Up in this header where you can see my name, 

you can see a very faint pattern in the background there. That apparently is clouds. So that's what 

you're changing when you modify that background. However, the more important change that 

I've done here is I've changed my overall theme. And because I changed it to dark gray, you can 

now see the interface, the ribbons, the commands are all showing in that dark gray color.  

Now you may decide that you don't like this, but I do know that a lot of people find it a lot easier 

on their eyes, if they have either a dark gray or even a black Background Color. So again, that's 

something worth investigating, playing around with, and seeing which one suits you. Now I'm 
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going to change mine back to colorful as that's my preference. Let's now jump across to the 

Display area.  

Now this is where you can come to control how your interface looks, I'm just going to highlight a 

couple of options in here. You can see that we have, “set to create all new Pages with Rule 

Lines”. So if you decided you no longer wanted that, you could uncheck that checkbox. Now an 

option that I don't have checked in here is Page Tabs appear on the left. So if you notice, when I 

create a new Page, it's always on the right. But if I wanted to, I could check this option. And 

you'll see in a moment that those are going to switch to the other side of the Page. I can also 

choose where I want my Navigation bar to appear.  

If I want Vertical Scroll bars to appear on the left-hand side. Or even if I want my notes to show 

in those containers or those placeholders on Pages. So let's click on Ok. And what you'll see is 

that that change that we've made, I now have my Pages showing on the left-hand side of the 

screen. And I know a lot of people prefer to have them displayed over here as opposed to on the 

right. But again, this is entirely personal preference. So that's it for this module, I will see you in 

the next one. 

 

  

http://www.simonsezit.com/


OneNote Desktop and Windows 10 

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved. 

Video: Setting Paper Size 

 

Deb: Hello everyone, and welcome back to the course, we're down to the last module in Section 

6. And I just want to finish out this Section by just running through a final couple of options 

when it comes to Page Setup and formatting your Pages. So the first thing I want to talk to you 

about is Paper Size. And if you come right up to the View tab and into that Page Setup group, 

you'll see that we have an option in there to change the Paper Size.  

Now I will say that Paper Size is most relevant if you intend on printing your Pages or your 

workbooks. You always want to make sure that the Paper Size you have set corresponds to the 

Paper Size that you generally use. So let's click on Paper Size. And what you'll see is that we get 

a pane over on the right-hand side, where we can go in and choose our Paper Size options and 

also set our print margins.  

Now by default, whenever you go into Paper Size, it’s going to say Auto in the size field. And if 

you click that drop down, you're going to get a whole host of other options. So for example, if 

you are in the US, then I believe that Letter Size is a very popular one for you guys to use. 

Whereas in the UK, and I think also in Europe, we tend to use Paper Sizes of A3, A4, A5, so on 

and so forth. And you can see that we have all of those options in here, along with some other 

options as well.  

So, I'm going to select A4 from here. And you can see what effect that has on my notes Page. It's 

now resized that Page so that if I was to print it on A4 paper, everything's going to be nicely 

lined up not running off the Page or not too narrow for the Page. If I change this to Letter Size, 

you'll see it's slightly wider than A4. If I change to something like an Index Card, you can see 

that that's very small. Or I could go for something like A3, which in general is a bit larger. You 

also have a choice of setting the Orientation, so either Portrait or Landscape. And again, this 

really depends on how you want this to look when you print it out.  

Now if you have a very specific Paper Size that you use, and you can't see it listed anywhere in 

this drop down, then you do have the options to go in there and just manually define the width 

and the height of the paper that you're using. And then underneath this is where you can set your 

print margins. So the margins would be the space that you get on the top, bottom, left, right of 

the Page, when you print it out. In general, you don't want your notes or your text starting right 

where the Page begins, you normally want a little bit of breathing room.  

So it's much the same as having margins around a document in Word. And of course, you can go 

into here and you can manually define what you want those print margins to be. Now I'm happy 

leaving mine on the default at this stage. And remember, if you want to actually take a quick 

look at what this is going to look like when you print it out, if you jump up to File, and go down 

to your Print option, and click on Print Preview, and this is going to show you exactly what that 

looks like.  

So you can see it's currently going to print just the current Page, and it's picked up my Paper 

Size, which currently is A3, it's picked up the Orientation that I've set, which is Portrait. And it's 
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also going to automatically add a Page footer for me. Now, I'm not going to go into these options 

too much at this stage, because we do have a Section a bit later on on printing. But just if you 

want to take a quick preview as to what those Paper Sizes gonna look like when you print, you 

can jump into the Print Preview.  

Now one interesting thing here is that if I close this Paper Size down, and if I create myself a 

new Page, and then go and check the Paper Size, you can see that it goes back to those default 

settings. So the Paper Sizes that I set for this Page Setup Page don't actually carry across when I 

create a new Page, they just go back to the default. Now it might be that you want to always 

create new Pages that are a specific size or have maybe specific margins. And that is where you 

would create a Page Template. And you can see we have a link for that right at the bottom. It 

says, Save current Page as template.  

And what you can do is you can create numerous different templates, utilizing all different Paper 

Sizes if you want to, and then apply those templates to your Pages as required. And this is the 

subject that we're going to cover in the next Section. So for the time being, I'm just going to close 

this pane down and just jump back to my Page Setup Page. Because the final option I want to 

show you in this Section is one that we haven't covered yet. And if we jump up to Page Setup 

again, on the View tab, it's Hide Page Title. So this is pretty much what it says on the tin. If I 

click this, it's going to hide the Page Title, Date, and Time.  

So I'm going to say Yes, and it gets rid of it. And you can see it changes it back to an Untitled 

Page. Now what I can do here is I can right-click and I can say Rename. But as soon as I do that, 

it's going to pull the Page Title back again. So the point I'm really trying to make here is that if 

you do choose to hide the Page Title, and you don't actually want any title on the top here, this 

Page is always going to be called Untitled Page. Now, I don't know how useful you're going to 

find that but just to let you know that that option is there if it's something you think you're going 

to use.  

So that is it for this module, and that is it for this Section. As I mentioned, in the next Section, 

we're going to explore the wonderful world of Templates. I'm going to show you how you can 

save Pages as Templates and also apply some of the inbuilt Templates that you have available 

from within OneNote. So I'm going to head over there now, and I look forward to you joining 

me. 
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Video: Windows 10 Formatting Pages 

 

Deb: Hi guys, and welcome back to the course. We're now down into our Windows 10 module, 

and we're going to just run through some of the things that we've learned throughout this 

particular Section in relation to Page Setup.  

Now when it comes to the options that you have available in Page Setup for OneNote for 

Windows 10, there definitely aren't as many as you have in the full Desktop version. But let's run 

through the ones that we have. So again, I'm working predominantly on the View ribbon for this 

particular lesson. And a couple of things that we can do is we can change the Page Color and we 

can also add Rule Lines. So I can click on Page Color, and it's going to open up a palette of 

pastel colors. I can choose one of these colors from the palette. Alternatively, I can go to More 

Colors, and it's going to give me a wider range.  

So maybe I want something like a nice light blue. What I can also do is select to add Rule Lines. 

And this is fairly similar to that desktop version. I have numerous different options to choose 

from when it comes to Ruled Lines, and also for Grid Lines. So I'm going to select College 

Ruled. And much like the Desktop version, we can also choose to create new Pages 

automatically with Rule Lines. So that's an option you can toggle on if you want to.  

Now one thing to note with this version is that there isn't any options with regards to changing 

Paper Size or anything like that, but we can change our Theme. So for this, we're going to go up 

to our three dots in the top right-hand corner, and we're going to jump into Settings. Now the 

first option you have up here is Color. And I'm currently just using the default system setting. 

But what I could do is click here and I could choose Dark and that's going to change the entire 

look and feel of OneNote.  

And as I said before, a lot of people find this little bit easier on their eye and prefer the Dark 

setting. You could also change this to Light, which is kind of a light gray color. And I'm just 

using the system setting which happens to be this light gray color.  

And that is pretty much all you have when it comes to customizing your Page Setup. So just a 

few little things in there that you can change. That's it for this module, I will see you in the next 

one. 

 

  

http://www.simonsezit.com/


OneNote Desktop and Windows 10 

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved. 

Section 7 – Template 
 

Video: Applying a OneNote Template 

 

Deb: Hi guys, and welcome back to the course. We're down into Section 7 now, and we're going 

to be taking a look at how you can work with Templates in OneNote. And a OneNote Template 

is really just a Page design that you can apply to new Pages in your Notebook to give them a nice 

looking background, a more uniform appearance, or a consistent layout. And it's also quite good 

for things like To Do Lists as if you select a To Do List layout, it's going to give you all of the 

To-do checkboxes. So you don't actually have to insert them yourself.  

Now there's a few different ways that you can create or apply Templates to your Pages. And in 

this first module, we're just going to explore some of the inbuilt Templates that you'll find within 

OneNote that you can very simply apply to your Pages using just one click. So if you do want to 

utilize a Page Template, you'll find all of them on the Insert tab, which is where I'm clicked right 

now.  

And if we move across our different Groups, the second from last Group is the Pages Group, 

where we have a big old button here called Page Templates. And once again, this is one of those 

double-sided buttons. And if I click the lower half of the Page Templates button, I get a drop 

down. Now what I'm seeing in here is a list of the last Page Templates that I use. So the last 10 

or so, are always going to be listed first in here to make them quick for you to reuse them.  

However, if I want to see all of the Templates that are available in OneNote, I'd go straight down 

to this bottom option, click on Page Templates, and it's going to open up a pane on the right-hand 

side. And I can then browse through the different categories looking for the Template that I want. 

So we have five categories here: Academic, Blank, Business, Decorative, and Planners. So let's 

take a look at an example Template from each of these Groups.  

So I'm going to click the drop down next to Academic. And we just have a few in here we have 

Simple Lecture Notes, Detailed Lecture Notes, Lecture Notes and Study Questions, 

Math/Science Class Notes, and also History Class Notes. So things are very much aimed at 

education, academia. So let's select Detailed Lecture Notes. And you can see exactly what that 

does. Now it's worth noting that when I applied this Template, I was actually clicked on the Page 

Setup Page.  

Now, what you'll notice is that it hasn't applied the Template to this Page, it's instead created a 

brand new Page ready for me to type into. Now the reason for that is that many Template designs 

include content that appears in specific places on the Page. And this is why OneNote Templates 

can really only be applied to new Pages that don't already contain any notes. So if you actually 

want to apply a Template to a Page that already has notes in it, what you would need to do would 

be first create a new Page from the Template you want, and then copy your existing notes into it.  
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Now if we just take a look at this Template that we have applied the Detailed Lecture Notes, it 

allows us to add a Title, so I'm just going to call this Lecture Notes like so, and that is now the 

Page name. And then you can see it's put in Placeholders. It's also added some Tags for me. So I 

can list all of the homework that I have. I have some bullet points over here. So I can Add-in 

today's topics that we're covering in the lecture. And then I also have some More Tags down here 

tagged as important for any important notes, those key takeaways.  

And then of course, at the bottom, I just have a space where I can start typing in my notes. So 

this gives me a kind of pre designed layout. It's added in some functionality by the way of 

tagging. And it's also given me a slightly more interesting background. Now I will say one thing 

that I really feel that Microsoft should update is some of these backgrounds that they use, 

because to me, they are a little bit old school, they're very 1990s to me, and you'll see that as we 

go through and take a look at a few more of them. So let's expand the next Group, which is the 

Blank Group.  

So again, this is just if you want basically a blank Template, but you wanted maybe a specific 

size. So if I was creating index cards, I might select the Index Card Template. Once again, it's 

given me a new Page, and it's adjusted the Paper Size to that of an index card. So I'm just going 

to call this Index Card so we know exactly what it is. Now I'm going to collapse that Blank, and 

also Academic and go down to Business. And in here we have some Templates relating to 

Meetings. So if you want to take meeting notes, then these are quite nice. And we also have one 

for Project Overview.  

So let's take a look at Detailed Meeting Notes. And there we go. So a similar kind of theme we 

can Add-in our Meeting Title, our Meeting Details such as the Date and Time, the Location, and 

the Agenda. We might even want to attach that as a Word document, we can add the Attendees 

in, any Announcements. And then we can Add-in Action Items, Summaries, and then also some I 

Information about the next meeting. So again, this is just a nice Template which removes some 

of the hard work for you.  

Let's carry on down to Decorative, and we've got quite a few in here. Let's go down and take a 

look. Let's do something like Globe. And this one is fairly plain, it just has a globe in the 

background. If I was to select something like Day Planner, you can see what that looks like. So 

these are reasonably plain, they're just adding a background image to give them interest. And 

then the final Group that we have right at the bottom is Planners. So this is where you'll find 

things like To Do List Templates.  

So if I was to select Prioritize To Do List, this is what I get. So we get this kind of header image, 

I have my title of To Do List. And then I have my To Do List checkboxes which I can toggle off 

and on because these are just those Tags. And I can very easily just type in all of the tasks that 

are high priority, medium, and low. And then any other notes I want to type right at the bottom.  

So the key takeaway points here are that if you use a Template from within OneNote, it's going 

to create a new Page, it's not going to apply that Template to Pages you already have that contain 

content. If you do want to do that, you'll need to create a new Template first of all, and then copy 

and paste the content into it.  
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So these are all well and good. They're pretty nice to look at and they make our lives a little bit 

easier because things are a bit quicker, but it might be that you want to create your very own 

specific Template. So in the next module, I'm going to show you how to do exactly that. So I'm 

going to jump across there now and I look forward to you joining me. 
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Video: Creating Your Own Template 

 

Deb: Hello everyone, and welcome back to the course. We're down in Section 7 taking a look at 

using Templates in OneNote. And in the previous module, I showed you how you can utilize 

those inbuilt OneNote Templates, and apply them to Pages within your Notebook. So what we're 

going to do in this lesson is we're going to create our own Template, we're going to get it to look 

exactly how we want it to look, and then use that Template.  

Now, when you're thinking about creating your own Template in OneNote, all you really need to 

do is think about how you want it to look, and what the purpose is of the Template. So for 

example, I'm currently clicked on the Meetings Tab. And I know that in the future, I'm going to 

be having a lot of meetings related to Project Artemis. So what I want to do is create a nice 

Template that I can use every time I'm adding meeting notes to my Notebook.  

So the first thing you need to do is just add a new Page, and then give it a name. So I'm just 

going to call this Team Meeting, I can always change this at a later date. But the important thing 

here is really to start customizing it and setting up so it has the look and feel that you want. So 

I'm going to jump up to the View tab, and I'm going to say that I want all of my Team Meetings 

to have a light blue colored background. And I also want them to contain Ruled Lines. I'm also 

going to set my Paper Size.  

So let's jump into Paper Size. And it might be that I want to print my meeting notes. So I'm going 

to change this to A4, which is the size of paper that I use when I print, I'm now going to start 

adding some Tags into this meeting. So let's go to the Home tab and into our Tags Group, I'm 

going to click the drop down. And I'm actually going to create my own new Tag through 

Customized Tags. And I'm going to call this one Attendees. Let's give it a little symbol, 

something like that. And I'm happy with the font color to be black. And I don't need a highlight 

color. Click on Ok, and now I can select Attendees from my Tags Group.  

And I might want to put in there some default text so that each time I utilize this Template, I can 

just remove Attendee 1 and add the name of the person attending. Let's Add-in another attendee, 

and let's do a final one. Like so. And then I might want to have just a Section for Notes which 

I'm going to move underneath. And let's make that a bit bigger. And I might want to make this 

font bold. And then I could go through and possibly Add-in some things like To Do Checkboxes 

for any items that might come up.  

Now, obviously, you're going to have a lot more time to think about this and to do this so you 

can make this look a lot nicer than what I have here. But the point I'm trying to get across is just 

go in and set it up how you want it to be set up. And then, you need to save this as a Template. 

So to do that, we need to go back to our Page Templates button. So let's go to the Insert ribbon, 

we'll click the drop down underneath Page Templates, and open up our Page Templates pane on 

the right-hand side.  

And what you'll see all the way at the bottom is a little link that says Create New Template, Save 

Current Page as a Template. So I'm going to click this. And it's going to ask me to give my 
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Template a name. So I'm going to call this DA Team Meeting Template. And what I could do at 

this stage is say that yes, this is going to be my Default Template for all new Pages created in 

this Section.  

Now, because this is just a meeting Section, then yes, that's probably going to apply to me. So 

I'm going to click this option and click on Save. And you'll see what happens is that in that 

Templates pane, you get an additional Group called My Templates. So when you click the drop 

down, this is where you'll find any Templates that you've created yourself. So it's very simple for 

you to use them over and over again.  

Now I'm going to close this down. And what you'll see that is if I create a new Page, it's going to 

apply that exact same Template. And of course, if I need to make any changes to this, I can. I can 

just go in here and say that this time it's a Project Meeting, and then carry on typing my notes.  

Now the final option that you need to be made aware of is if we jump back into Page Templates, 

you'll see right at the bottom again, you can choose a Default Template. So you can see here it 

says, “Pick a Template you want to use for all new Pages in this current Section”. And because I 

already set that option, it's showing DA Team Meeting Template. Now if I was to jump across to 

another Section, so let's just say Page Setup, it says No Default Template.  

So what I could do is click the drop down and choose a specific Template to use for all of the 

Pages in this Page Setup Section. So let's just choose something like History Class Notes, click 

on Close. And now when I add a new Page to this Section, it's going to give me that Template. 

And I can check that if I go back into Page Templates. You can see it's using the History Class 

Notes Academic for this Page and any new Pages that I create within this Section.  

So that is it. Reasonably straightforward to set up your own Template, save it, and then either use 

it on specific Pages, or apply to all Pages created within the same Section. That's it for now, I 

will see you in the next lesson. 
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Video: Windows 10 Working With Template 

 

Deb: Hi guys, and welcome back to the course. We're back into OneNote for Windows 10 now, 

and in this Section, we've been taking a look at applying Templates to our Pages in the Desktop 

version. So you might be thinking to yourself, well, can I do this in the OneNote for Windows 10 

version? And the answer there, unfortunately, is no.  

If you take a look through the different ribbons, you won't find a Page Templates button 

anywhere on here. The only option that you do have available with regards to Templates, which 

can make your life a little bit easier, is that you can create a Page Template, and then set that as 

the default for all new Pages created.  

So for example, on this Monday Page, I have a blue background. And I also have some rule lines 

on here. So what I could do is I could set this up as a Page Template. Now bear in mind that I'm 

setting everything on this Page as the Template. So when I create a new Page, it's going to 

appear with all of the tagging and all of this text as well. Or what you could do is if you had quite 

a nice design that you wanted to use for your Pages, you could set it as the default, and then just 

go in and delete out any of these placeholders pieces of text that you didn't want to use.  

So what I'm going to do here is right-click on the Page Monday. And then in the Contextual 

Menu, you'll see that we have the option there, Set as the Default Template for this Section. And 

that's a really important point to note there that distinction, it is only for this Section. So if you 

were to add new Pages to the Things to Remember Section, they're just going to be the default 

plain formatting. So I'm going to say, Set as Default Template. I'm getting a message here that 

says, “This action will remove the current Default Template for this Section. And there's no way 

to undo this action. Are you sure you want to continue”?  

So I'm going to say yes. And now if I was to create a new Page, you can see it takes on those 

properties. So if I didn't want these text boxes, what I would do is just come in and delete those 

out. I can modify the title and then add my new notes to this particular Page. So that's the way to 

get around it. But I will admit, it would be quite helpful if there was similar functionality to the 

Desktop version.  

Now, just to reiterate what I was saying, If I jump across to Things to Remember and Add a new 

Page, you can see that because that's in a different Section, it's not taking on that formatting. So 

just be aware of that distinction.  

So with regards to Templates, fairly limited options compared to the Desktop version, but you 

can create quite a nice design and then set that as the default for all Pages in the Section. That's it 

for this module, I will see you in the next one. 
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Section 8 – Working in Pen mode 
 

Video: Working in Pen mode 

 

Deb: Hello everyone, and welcome back to the course, we've made it down to Section 8. And in 

this Section we're going to explore how we can use different Drawing Tools on our OneNote 

Pages.  

Now OneNote lets you draw, sketch, or write notes with your finger, a pen, or even a mouse. 

And you can even do things like freehand draw shapes, or write equations, and convert those to 

Typed Text. So the next few lessons that we're going to go through are particularly useful if 

you're somebody who uses a Touchscreen device with a Stylus. That's by far the most accurate 

way of handwriting notes.  

But just be aware, even if you don't have a Touch device or a Stylus, then you could if you 

wanted to still utilize these Drawing Tools using your mouse. Although I will say it's a little bit 

more difficult to get writing, shapes, things like that accurate when you're drawing with a mouse 

as opposed to with a pen. Now, I will also say here that if you don't have a Touchscreen device 

with a Stylus, and you don't particularly think that you will ever be trying to handwrite text using 

your mouse, then please feel free to skip to the next Section.  

However, I would still encourage you to watch these reasonably short modules, just so you have 

an idea as to the tools that you have on that Draw tab if you ever need to use them. Now because 

this lesson is particularly geared to Touchscreen users, I'm going to switch from Mouse and 

Keyboard mode into Touchscreen mode. And this is something again, that I mentioned right at 

the beginning of this course. So you may have completely forgotten by now.  

But if you take a look at my Quick Access Toolbar, you'll see that I have a little option just here. 

And when I hover over, it says, Touch/Mouse mode. So this is essentially a toggle, which allows 

me to switch between my Mouse and also Touch. And what this does is it basically optimizes 

your screen, your interface for use with Touch. It kind of gives you a bit more space to 

accommodate something like a finger which you might be using on a Touch device. So let's 

switch to Touch.  

And you can see there exactly what it's done. If you take a look at my ribbon, I now have a lot 

more space in between my commands, as it's now accounting for what we like to call fat-finger 

syndrome. Now I am using a laptop that has a Touchscreen and a Stylus. So what I'm going to do 

is I'm going to use my finger to jump across to the Draw tab. And this is where you'll find all of 

your drawing utilities.  

So it's great for doing things like making different types of annotation on a Page, maybe circling 

items of importance, or maybe using the Highlighter tool. And of course, you can modify the line 

thickness and also the color. And you can even do things like draw shapes.  
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Now the first thing that you'll notice when we jump onto the Draw tab is that the first command 

there, the one that says Type, is selected because I have that gray background. So that's telling 

me that I'm currently in a Type mode. So if I was to click somewhere on this Page, I can start 

typing and it's going to use my keyboard. Now I'm just going to delete out what I just typed, 

because I want to switch into a different mode.  

This time, I want to use my Stylus to make some annotations on this particular map. And the way 

that you essentially switch to your Pen mode is you just click the drop down arrow just here. And 

it's going to open up all of the built-in pens in OneNote. And you'll see at the top I have a Section 

called Favorite Pens. So if I use a particular pen, often, I can add it to my favorites and I'll show 

you how to do that in a moment. But underneath we have all of the built-in pens, we have 

various different colors, thicknesses, and also Highlighters as well.  

Now the first option I want to show you is right at the bottom here, this option that says Pen 

mode. Because when I click here, I can choose what I want to use Pen mode for. So currently, 

I'm using Pen mode, which means I can use my Stylus essentially or even my finger to create 

both handwriting and drawings. So I could handwrite notes, and I could also draw shapes. 

Alternatively, I can create drawings only in Pen mode, or create handwriting only in Pen mode. 

And then finally, I can use my pen as a pointer.  

Now I'm going to keep mine on Create both handwriting and drawings. And I'm going to select 

one of these built-in pens from the gallery. So I'm going to choose this one just here, the red pen, 

one millimeter. And you'll see that that now gets highlighted in my Drawing Tools gallery. If 

you look at my cursor, it's kind of changed to a red dot. So what I'm going to do now I'm going 

to use my Stylus and maybe I want to go on to this map and just highlight something in here.  

So if I want to show people exactly where Liverpool Street Station is on this map, I could use my 

pen, and I could just circle it like so. I could then use my pen to open up that gallery and maybe 

switch into another color. So let's do green. And this time, I might want to highlight somewhere 

that's good to go for lunch. And that would be The Brewery, and that's going to be in green. Let's 

click to jump into our gallery one more time, because what I also have in this last column is a 

bunch of highlight colors. So let's stick with the old favorite, yellow. And this time, I can use that 

to highlight anything on this map as well.  

Now next to one of my pens, I have a Color and Thickness option. So because I currently have a 

Highlighter selected, it's taking me straight to the Highlighter, what I can do in here is basically 

change the color of the Highlighter to anything that's within this gallery. So maybe I want a nice 

salmon pink kind of a color, click on Ok, and now you can see that that's changed. And this is 

going to work the same for any of these pens. So if I was to select this red, fairly thick pen, I can 

go into Color and Thickness, you can see it now has pen highlighted at the top. And I can go in 

and choose a completely different color.  

Let's do this hot pink, click on Ok. And then if I type something like that, as I said, I'm not 

particularly great, but hopefully you get the idea. So now I've made a whole bunch of 

annotations on my Page, I might want to leave them there, that's totally fine. Or I might want to 

get rid of them. So as soon as I started moving my mouse around, you can see that my mode 
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switched from Pen mode back to Type mode. And I have an Eraser option in here. And what I 

can do is choose to use a small, medium, or large eraser or even a stroke eraser. And this really 

depends on how big the annotations are on your Page. For me, I quite like the stroke eraser. So 

I'm going to use that. And I can then use my mouse just to get rid of all of the strokes. And let's 

just get rid of everything that we added on here. So, reasonably straightforward.  

Now the next button that we have along here is Draw with Touch. And you can see it says; “Use 

pens, eraser, Lasso, and shape tools with your finger”. So maybe you have a Touch device, but 

you don't have a Stylus, you can still draw with your finger. So let's say Draw with Touch, and 

I'm going to select a pen to use. So let's try this. Let's go for this purple color. And this time, I'm 

going to use my finger just to highlight something on this particular map. And once again, I can 

utilize my Eraser utility and just click and remove those annotations.  

Now, we're going to move on to the next lesson where I'm going to show you how you can draw 

shapes, convert them to text, and also use the Lasso tool to select multiple objects. So I'm going 

to head over there now, and I look forward to you joining me. 
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Video: Drawing Shapes in Touch 

 

Deb: Hi guys, and welcome back to the course. We're down in Section 8, and we are looking at 

Drawing Tools in OneNote. And in the last module, I showed you how you can switch from 

Type mode into Touch mode. And we've had a little play around with some of those Drawing 

Tools. We've experimented with different sizes, different pen types, and I've shown you how you 

can erase annotations from your Page as well.  

So now what we're going to do is we're going to insert some shapes into our Pages. And you'll 

see on the Draw tab, we have Shapes group in the middle. And if we click that, it's going to show 

us all of the different Basic Shapes, graphs, and lines that we can insert into our OneNote 

Notebook. Now, if anybody's used Excel, PowerPoint, anything like that, you'll know that this is 

a very, very limited gallery. We just have some Basic Shapes and also some Basic Lines.  

But we have enough there to do some simple things such as you might want to create some kind 

of flowchart to show processes, or maybe even something like a hierarchy diagram, you have the 

shapes and the lines in there that you need to do that. Now I'm going to select the rectangle from 

Basic Shapes. And one thing you need to know is that before you start to draw your shape on 

your Page, you want to make sure you have the correct pen selected with the Color and 

Thickness that you want.  

So I'm going to click the drop down to jump back into my Gallery. And this time, I'm going to 

choose this one just here. So the orange pen, 3.5 millimeters, and I'm now working in Pen mode. 

So using my Stylus, I'm going to do pretty much the same thing that I did before, I'm just going 

to put some circles round some items on this Page. So let's do the station, the Bad Egg, and also 

Chipotle Mexican Grill. Now, I showed you before how you can utilize the Eraser tool up here in 

order to remove these items one by one or stroke by stroke.  

But if you do have a lot of annotations on the Page, and you want to get rid of either all of them 

or some of them, this can be a little bit tedious. But there is a way that you can quickly make 

multiple selections and get rid of them all in one go. And that is to use the Lasso Select tool. So 

let's click it to activate that. You can see my cursor has changed to a crosshair. And all I need to 

do now is kind of drag my Lasso tool over all of the annotations, and let go. And you can see a 

very faint line around the outside, it's selected them all.  

And I can then jump up to my Draw tab again, over to the Edit group where I have a Delete 

option. And if I click Delete, it's going to get rid of all of those annotations in one go. So don't 

forget you have that because as I said, that can be very tedious if you do have a lot of annotations 

and other things you want to remove on the Page.  

So now what I want to do is I want to draw a shape on my Page. So the first thing I need to do 

here is I need to select the pen that I want to use, with the correct Color and Thickness. So once 

again, for this, I'm going to go to my Gallery. And let's select this one just here, the red pen, 3.5 

millimeters. Once I've selected my pen, I can then choose a shape from the Shape Gallery drop 

down. And you'll see what we have in here, we only have a few different shapes that we can 
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choose from. And I'm going to choose the rectangle shape. And now I'm going to draw and you'll 

see that it comes out with the correct Color and Thickness that I selected from my Drawing 

Tools.  

If I wanted to draw another shape in a different color, I would need to go to my palette first of 

all, select another pen. So I'm going to choose the lavender pen, 1 millimeter. And this time, I'm 

going to choose the oval. And now when I draw, I get an oval. And you'll see that this can be an 

oval or it can be more like a circle. And let's just do one more, because I'm sure you're getting the 

idea by now. I'm going to go up to my Gallery, and this time, I'm going to select the green pen, 

0.35 millimeters. And I'm going to choose an arrow this time. So maybe I want to draw an arrow 

from the circle to the rectangle.  

So, this is all reasonably basic, but it's just different ways that you can use annotations in your 

Notebook Pages. Now, I actually don't want these here. So I'm going to use my Lasso Select. I'm 

going to draw around those shapes that I added to select them all, and then I'm going to say 

Delete. Now the final thing I could do here is I could switch into Draw with Touch mode by 

clicking that button in the middle. Now once I've done that you'll see that I also still have Lasso 

Select selected. So let's click on that to turn that off. So now what this enables me to do is once 

again use my finger, so I'm going to click the Gallery. And let's say I want a blue pen, then I'm 

going to click the shapes drop down. And let's choose a triangle this time.  

And because I'm drawing with Touch, when I use my finger, I can just pull out like that, and it 

gives me a nice, neat triangle. So it's a lot neater than me just freehand drawing it. This time, I'm 

going to go to Color and Thickness, I'm going to choose something that's very thick, like that. 

And let's do a aubergine color, and click on Ok. Let's click the drop down and select a shape. 

Let's do this one just here. And then I can draw it, and it's going to look exactly like that. And of 

course, what I could do with the shapes is if you take a look in the Edit group, I have an Arrange 

option.  

So if I wanted to send this drawing behind the map, I could say Send to Back and it's going to 

put that drawing behind the map. Let's bring it to the front again, I could select the triangle and 

say, Send to Back. So this is how you can arrange your objects on your Page. And then finally, if 

I click this parallelogram, I think it might be, we have a Rotate option as well. So I can choose to 

rotate left or rotate right. I can flip it horizontal, or I can flip it vertical. So a few different options 

that you have in there.  

Now I don't particularly want either of these shapes, so I'm going to click Delete to get rid of that 

one, and Delete to get rid of the triangle. And I'm also just going to deactivate Draw with Touch. 

So that is pretty much it when it comes to inserting shapes and lines in various different ways 

using various different methods into your OneNote Pages. That's it for this module, I will see 

you in the next one. 
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Video: Converting Handwriting to Typed Text 

 

Deb: Hi everyone, and welcome back to the course. We're in Section 8, where we've been taking 

a look at the different types of Drawing Tools that we have available in OneNote. And we've 

been working predominantly on the Draw tab.  

Now in the previous module, I showed you how you can utilize Touch either your finger or 

maybe a Stylus, in order to do things like draw shapes, erase shapes, and also, select multiple 

objects. But one of the best things about having a Touch device when working in OneNote is the 

ability to be able to take handwritten notes, and then convert those to Typed Text. Now 

whenever I want to take any handwritten notes, I always find it super useful to turn on my Rule 

Lines. So that's the first thing I'm going to do here. I'm going to jump up to the View tab, I'm 

going to go to Rule Lines, I'm going to say that I want Wide Ruled Lines on my Page.  

Now the reason why I like to turn this on is because if I'm using some kind of Stylus or a pen on 

a Touch device, it just helps my writing stay straight. So let's jump back to the Draw tab. And 

what we're going to do is I'm just going to show you how we can do some handwriting and then 

convert it to Typed Text if we want to. Now in a real world scenario, if you're going to be using a 

Stylus, you more than likely have some kind of tablet device. And when you have a tablet 

device, it is pretty much just like writing in a Notebook.  

Now I will say that I'm using a laptop here, which has a Touchscreen, so my writing isn't going 

to be particularly neat because my arm is kind of waving around in the air. So you're going to 

have to bear with me, hopefully OneNote will be able to read my very messy handwriting. So 

once again, the first thing you need to do here is you need to select the pen, you want to use the 

Color and the Thickness. So I'm going to click the drop down, I'm going to go to my Gallery. 

And for handwriting in general, I use a fairly thin pen. So I'm going to use black pen, 0.35 

millimeters. Let's click to select.  

So, what I'm going to do now is attempt to do some readable handwriting. So there we go. So I 

hope that's legible for everybody. I did try my hardest, I'm not the greatest at this. But yeah, you 

kind of get the idea. So if you do have a Stylus, you can take handwritten notes as if you're 

writing in a notepad. But the coolest thing here is that once you have handwritten your notes, you 

can convert them to Typed Text.  

So the first thing you need to do here is select your text. So once again, we're going to use the 

Lasso tool, and we're going to click and select all of our text. Now once we have our handwritten 

notes selected, if we jump up to the Convert group, you'll see that we have an Ink to Text option. 

And if I hover over the ScreenTip says it's going to convert my handwriting to text, which is 

exactly what I want. So let's click and see what we get. And there we go. So I can see that it's 

pretty much got most of it right.  

So if you do have a lot of notes, this can be quite useful. And you can then just go through and 

proofread them and make any corrections that you need to make. So I'm going to switch back 

into Type mode, I'm just going to remove that bracket, I'm going to replace that with an I 
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obviously thought my I was a bracket. And then I'm going to right-click, and I'm just going to 

correct my grammatical errors. So I'm going to select you, and there we go, I now have my notes 

as Typed Text. So that's a really nice little option.  

Now, it's also worth noting that in that Convert group, you also have an Ink to Math option as 

well. So it will convert handwritten mathematical expressions to text. So once again, if I go in 

and choose a pen, so let's do a red pen this time. And I'm just going to write out a fraction. So 

let's just say 1/2, like so. And what I could do is once again, use the Lasso Select tool, select my 

handwritten equation and click on Ink to Math. And once again, OneNote is going to make a 

good guess of what I've written. And I can see in this case, it's got a completely right so I'm 

going to say Insert. And it's going to convert that to Typed Text again for me, and I could do the 

same thing.  

So let's select another pen. I'm going to do a purple pen this time. If I was doing something like 2 

+ 3 = 5, I'm going to go to the Lasso. Let's make our selection and say Ink to Math. And I can see 

here that it's got it slightly wrong. So it's picking up Z as opposed to 2. So what I could do here is 

say Select and Correct. I'm going to select the 2 and you can see I get a list of options, and 2 is 

one of the corrections that I'm being offered. I can also see here that I have a little dot there.  

But this time, I'm going to click on Erase. I'm going to go in, I'm just going to erase that dot out. 

And you can see it automatically updates that correction, click on Insert, and I now have my 

typed equation. And I can move that to wherever I need to move it to.  

So now the final thing I want to show you on this ribbon that we haven't yet covered is this Insert 

Space option. So this is a really good way of inserting or removing extra space in your Pages. So 

if you can imagine, if you have lots of different notes on a Page, all in different placeholders, if 

you suddenly decide that you want a bit more space underneath the title and the date and time up 

here, it's a bit of a pain to have to click all the individual placeholders and start moving 

everything down.  

So instead, what you can do is you can click on Insert Space. And when you hover your mouse 

over the Page, you'll see you get this moving bar. So I can click just under where I have the title, 

drag down, and let go. And it's gonna give me that space at the top. So that's a real quick way of 

just adding space into your Pages without having to mess around moving all of the individual 

content placeholders. So, that is it.  

That is everything that you have on that Draw tab, and also how you can utilize Touch. That's it 

for this module, and that's it for this Section. In the next Section, we're going to start to take a 

look at how Outlook integrates with OneNote. So I'm going to head over there now, and I look 

forward to you joining me. 
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Video: Windows 10 using Drawing Tools 

 

Deb: Hi guys, and welcome back to the course. In this Section, we've been reviewing our 

Drawing Tools. And it's now time for us to take a look at what that looks like in OneNote for 

Windows 10. So you can find all of your Drawing Tools on the Draw tab. And if you take a look 

at the commands that we have on this ribbon, you can see the third one in is currently 

highlighted, which indicates that this is currently toggled on. And this is telling me that I am in 

Typed Text mode.  

So if I'm using a Touchscreen, and I want to either use my finger or maybe a Stylus to draw 

shapes, or make annotations, then I'm going to need to switch into Draw with Touch mode. And 

you'll see that I have that option about halfway along this ribbon. And as I hover over, it says 

Draw with Mouse or Touch. So let's switch into this mode and see what we have. So now I'm in 

Draw with Touch, I can choose a pen to use. And we have a few different default options up 

here.  

Now if I was to click this first one, and then click the little drop down arrow that appears, I get a 

whole host of different options in order to customize this pen. So I can make it a little bit thicker, 

or a little bit thinner. And I can choose a color from the color palette. And you can see we have 

some solid fill colors just here, but we also have some kind of cool patterns down here as well. 

So, let's choose the lava pattern.  

If you wanted to, you could select a different color from that More Colors option. And then 

finally, in the bottom, we have a Delete option, which I'm not going to use at the moment. So 

now on my notes Page, I could utilize my finger, or I have a Stylus, so let's do some handwriting. 

And there we go. As always, very messy. But hopefully you get the idea. And we can see that we 

have that lava pattern running through our text. I'm sure you can make this look a lot nicer than 

what I've done here.  

Now if I want to modify my pen, at any point, I can just right-click my mouse over that pen. And 

I can say Modify Tool, and it's going to jump me back in there. And I can change the color or the 

thickness or select a pattern. And something else I can do up here is if I click the Plus, I can add 

a pen. So it's going to allow me to choose what kind of pen I want to add. So I can add a pencil, a 

pen, or a Highlighter. So let's choose pencil, I'm going to set a color for this pencil, which is 

purple. And I'm going to make this one pretty thick, and click away.  

Let's make sure we have Draw with Mouse or Touch selected, and now let's do some writing. 

And you can see what that looks like. So because I'm using a pencil as opposed to a pen, I'm 

getting a slightly different texture just there. Now when it comes to the different Drawing Tools 

that you're seeing on this little ribbon, you can reorganize them. So if I always use this pencil 

tool, I can right-click, and I can say Move Left. And it's going to move that along. So maybe I 

want to place this as the first item in my list, like so.  

Now what I can also do in here that's fairly similar to the Desktop version is I can utilize the 

Lasso Select tool. So I'm going to click Lasso Select, and I’m just going to draw around this 
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annotation. And in this case, I want to delete this. So I'm just going to press the Delete key on my 

keyboard. Now when it comes to adding in blank space, we can also do that from here as well.  

So if I click on Insert or Remove Extra Space, again, I get this little horizontal bar running across 

the top. And if I want to move this piece of handwriting down a little bit, so I've got some space 

in between that Page title, I can click, I can drag, let go, and it inserts that blank space quite 

nicely.  

Now moving along at this ribbon, I can insert shapes. So let's select a rectangle. And of course, 

that's going to use the last pen that I selected. So maybe what I want to do here is change that. So 

I'm going to choose this blue pen, I'm going to make that a darker blue. I'm going to make it a 

thinner line. And now when I draw my shape, let's draw a circle this time. That's what I get. So 

moving along this ribbon, I have similar options. I have Ink to Shape and Ink to Text. So let's 

just demonstrate one of these.  

So, let's take a look at that Ink to Shape option. I'm going to select my pen, I'm going to turn on 

Draw with Mouse or Touch, I'm going to toggle on Ink to Shape. So now if I was to draw 

something like a square, watch what happens. It gives me a perfect square. And I can also insert 

mathematical equations. So again, if I turn on Touch, I'm just going to type in ½. I'm going to 

use Lasso to select my handwriting, click on Math, it's picked up that I'm trying to type ½, and 

I'm going to click on Ink to Math. And there we go, I now have my Typed Text.  

And don't forget with things like the shapes if you click on them and then right-click your 

mouse, you're going to get a Contextual Menu come up. So you can Cut, Copy, and Paste, you 

can Delete, you can change the Order. So if you have shapes layered on top of each other, which 

ones you want at the front and which ones at the back, and you can also do things like Rotate the 

shape as well.  

So when it comes to Drawing Tools, you have the full set here, which will allow you to annotate 

your notes and it's particularly good if you're using a Touch device. That's it for this module, I 

will see you in the next one. 
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Section 9 – Working with Outlook Tasks 
 

Video: Working with Outlook Tasks  

 

Deb: Hi guys, and welcome back to the course. We're down into Section 9 now. And in this 

Section, we're going to take a look at all of the different ways that you can interact with Outlook 

when you're using OneNote. And in this first module, we're going to take a look at how you can 

integrate your OneNote notes, your Action Items, with Outlook Tasks.  

So it might be as you're taking notes and planning your different projects in OneNote, you might 

want to manage deadlines and remember things on your ToDo list. And so thankfully, OneNote 

has a little integration option with Outlook that essentially allows you to Tag your Action Items 

or ToDo items in OneNote, and have them appear in your Outlook Tasks list. And it's a really 

simple and straightforward process. So let's jump in and take a look at an example.  

So I'm in the Meeting Section. And you can see that currently I have three Pages. And the Page 

that I'm currently clicked on is this Team Meeting Page. I can see the attendees of this meeting. 

And then you can see I have some Action Items right at the bottom here. So if Outlook is your 

primary tool that you use when it comes to keeping on top of Action Items and things that you 

need to remember to do, then this is going to be a great little feature for you. Because what I can 

do here is I can Tag these Action Items, and they'll all automatically synchronize with my 

Outlook so I can manage them within tasks.  

And if you take a look at the Home tab, you'll see in the middle there in that Tags group, you 

have a specific Tag for Outlook Tasks. So let's click the drop down. And we can Tag our tasks 

with various different timeframes. So if you have a particular ToDo item that needs to be 

completed Today you have a Tag for that. Tomorrow, This Week, Next Week, No Date, and you 

can also set a Custom Date if none of these particular Tags match exactly what you want to do. 

And you'll see that there is a keyboard shortcut for all of these just to make things super quick 

and effortless; Ctrl + Shift, and then 1, 2, 3, 4, 5, or K, depending on which option you want to 

select.  

So the first thing you need to do here is you need to click Next to the Action Item, or you can 

even highlight the entire Action Item. And then you can set a due date. So for this particular 

item, sending an email to Claire in HR to get CVs for new team members, I need to do this 

today. So I'm going to select the Today Tag. And you can see it puts a little flag next to that item. 

Let's do the rest of these. So I'm gonna say, “Update Job Description to include new salary”. I 

need to do that today as well. Now when it comes to Scheduling interviews, I'm going to say that 

that doesn't need to be done until tomorrow. And Booking meeting rooms can be done next 

week.  

Now I could go on Tagging items throughout all of my different Sections, I'm not just limited to 

this one particular Page as Outlook will synchronize and pick them all up. So what I'm going to 
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do now is just open up my Outlook, and take a look and see if those tasks have actually been 

added to my Tasks list.  

So I've opened up Outlook, let's jump down and pull up our ToDo list. And there they are at the 

bottom; Send an email to Claire, and Update Job Description. I Tagged one task for tomorrow, 

and there it is; Schedule interviews. And I also Tagged a task for next week, which is Book 

meeting rooms. So you can see there how nicely everything synchronizes across, and you have a 

real good level of integration between OneNote and Outlook.  

Now just as a side note here, it might be that when you're working in OneNote, you just want to 

see all of the items that you've flagged, so your Outlook Tasks, essentially. And we can do this 

using Find Tags. So I have everything Tagged in this workbook grouped by Tag Name. Now if 

I'm just specifically looking for flagged items, this is a bit of a pain having to scroll through all 

these other Tags. So what I could do is go down to where we have Search at the bottom and 

change it from this Notebook to this Page Group.  

Now I do have some other Tags on this Page for my attendees. But this is a lot easier for me to 

see if I'm just looking on the Page Group as opposed to throughout the entire Notebook where I 

have lots and lots of Tags. So this is a nice quick way of just being able to view those from 

within OneNote. Now of course at any point you can also change your Tags. So if I decide that I 

need to schedule interviews Today, as opposed to Next Week, I can just simply change that flag. 

And when I jump across to Outlook, I can see that Schedule interviews has now updated and is 

being shown underneath the Today group.  

What I can also do is completely removed these Tags. So if I click Next to Book Meeting Rooms 

and jump back up to Outlook Tasks, you'll see that I have a Delete Outlook Task option. So let's 

delete it. And then if we go back to Outlook, we can see that that task has now been deleted from 

Next Week. So that synchronization is pretty instantaneous.  

Now the final thing I'm going to run through here is just show you how you can add a Custom 

Flag. So let's jump down to Custom. I'm going to say I want this task to start on the 14th of 

December, and its due date is the 16th of December, and I'm going to click Save and Close. So 

now when I go back to Outlook, you can see that Book Meeting Rooms is now falling under the 

This Month group because it's a date that's in the future, but it's still within this month.  

So that is how Outlook Tasks are integrated with OneNote. A really super useful little feature for 

keeping on top of any ToDo or Action Items. In the next module, we're going to start to talk 

about Outlook Meeting integration with OneNote. So, please join me for that. 
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Video: Outlook Meetings and Meeting Notes 

 

Deb: Hello everyone, and welcome back to the course. We're in Section 9, and in this Section 

we're taking a look at how Outlook integrates really nicely with OneNote. And in the previous 

module, I showed you how you can Tag Action and ToDo items using the Outlook Tasks Tag, 

and have those appear in your Outlook ToDo List. Now what we're going to do in this module is 

take a look at another piece of integration between OneNote and Outlook. And that is Meeting 

Details.  

Now, if you take a look at this Home tab, the last Group on the end, the Meetings Group has a 

big old button in there that says Meeting Details. So let me show you how this works. So what 

I'm going to do is I'm going to add a new Page by clicking on that Add Page button. Now 

something else that I've also done off camera is that I've removed the Team Meeting default 

template for all new Pages.  

So when I click a new Page now, I'm just getting that blank Page. And I'm going to give this 

Page a title. So this is another meeting that I'm about to go into, and it's just our Weekly Meeting. 

Now, it might be that I'm about to run into this meeting, and I want to use OneNote to take 

Meeting Notes. So something that makes us a little bit more efficient, is that you can actually 

pull the Meeting Details through from Outlook into your OneNote Page.  

So what I could do here is if I jump up to my Meeting Details button and click the drop down, 

you can see that that integration between Outlook and OneNote means that it's looking at my 

calendar, and it's picking up any meetings that I have scheduled for today. And you can see it's 

showing me that I have a Weekly Planning Meeting. And in fact, what I'm going to do is just 

change this title, Weekly Planning Meeting. You'll also notice that underneath that I can choose a 

meeting from another day.  

So if I click this, I can basically navigate through the different days looking at the meetings I 

have scheduled in my Outlook calendar. So this is the one I have for today. But if I click the 

arrow to move to the next day, I don't have anything on Friday, I don't have anything on the 

weekends, I do have a Project Meeting on Monday. I've got a couple of meetings on Tuesday, 

and I have an interview on Wednesday. So if I wanted to I could utilize any of these meetings.  

Now I'm not going to at this stage because the one I want is actually scheduled for today. And if 

I click on the Weekly Planning Meeting, it basically imports all of the Meeting Details. So I can 

see very clearly that I have the Meeting Subject, the Date and Time of that meeting, I have a 

Link that's been inserted, which is going to jump me to that particular item in my Outlook 

calendar, I can see the Invitation Message by clicking the expand button. And then I can see all 

of the Participants below. And then I have a space underneath where I can start typing up my 

Meeting Notes.  

So, this is a really great, very quick way of just importing all of those important details. So that 

when you go back and you're looking at your notes, you know what date this meeting was on, 

who attended, all of those kinds of things. Now, if at any point those Meeting Details change, 
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what you'll see is when you go into Meeting Details, you'll see this option in the menu, Refresh 

Meeting Details for this Page. So what I'm going to do is I'm just going to jump in, I'm going to 

add something to the Invitation Message so I can show you how this button works. So I've gone 

in and added some text, I want to refresh this item. So let's jump up to Meeting Details and click 

on Refresh Meeting Details for this Page. And there we go. You can see the line of text has been 

added into that meeting.  

Now another thing I can do here in relation to OneNote and Outlook integration is that if I have 

some notes that I've created in OneNote, for example, these notes related to the Overview Page, I 

can share these notes with the participants of a particular Outlook meeting. So let's jump across 

to my Outlook calendar. And I can see that next week I have a Project Meeting. So if I double-

click to open up this meeting, what I can do is maybe share the notes on that Overview Page with 

all of the meeting participants. And you can see I have three people who are currently invited to 

this meeting.  

So from within the Meeting Request, if you take a look at the Meeting tab at the top, you can see 

that you have a Meeting Notes button with the OneNote icon. And as I hover over, it says, “Use 

OneNote to add notes to this meeting, or open notes already associated with this meeting”. So 

what I can do is click this button. And I can say that I want to share my notes with the meeting. 

It's then going to ask me to choose a Page of notes. So I'm going to expand Project Artemis, I'm 

going to expand Offices, and I want to share that Overview Page because this contains all of the 

details of the rollout project. Click on Ok.  

And what it does is it inserts a link which all of the meeting participants can click on, and it 

jumps them straight to that specific Page in my OneNote Notebook. So I might want to add some 

additional text. And I can then send my update out to the participants.  

So that is how you can add Meeting Details to Pages within OneNote, and also how you can 

share notes that you already have stored in OneNote with the attendees of an Outlook meeting. 

That's it for this module, I will see you in the next one. 
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Video: Sending Page Information by Email 

 

Deb: Hello everyone, and welcome back. In this Section, we've been talking about how OneNote 

and Outlook interacts. And so far, we've seen how we can utilize Outlook Tasks for Tagging in 

OneNote. And also how we can do things like import Meeting Details, and share Meeting Notes. 

So the final thing I want to run through with you in this particular Section is a very simple little 

feature. And that is emailing a OneNote Page.  

And once again, if you glance up to that Home tab, you'll see the second from last group, there is 

the Email group. And we just have one button and that is Email Page. Now a question I get asked 

all the time is if you can email multiple Pages, whole Sections, or entire Notebooks. And I will 

say that through this option, you can only email one specific Page of your Notebook. So let's take 

a look at that first. And then I'm going to run through with you some of the other options that you 

have if you do want to send entire Notebooks or entire Sections.  

So this is a very simple process, all you need to do is make sure that you're clicked on the Page 

that you want to email, and click on the Email Page option. And you'll see straightaway what this 

does, it opens up a brand new Outlook email message, and the details of that particular OneNote 

Page have been copied into this email. So all I would need to do now would be to address the 

email, maybe add some text, and then simply send that email. And then Jen has all of the details 

contained on this Page. So a very straightforward process.  

And it's also worth noting that if we jump up to the File tab, the backstage area has some options 

related to this as well. So if we go down to Send, you can see that we have that Email Page 

option in there as well. And using this button is exactly the same as the process that we've just 

run through. Now, of course, you do have other options in there, you can send the Page as an 

Attachment, as a PDF, you can create a new Word document, or you can send it directly to a 

Blog site. But all of these options are just for the Page that you're clicked on.  

Now, if you did want to do something like send the entire Notebook or an entire Section, the 

option you need for that would be this Export option. And this is going to allow you to export a 

Page or Section or the entire Notebook to one of these specific formats. And then if you wanted 

to email that you could attach the file to an Outlook email and send that through to people. So 

just remember that if you are using this option on the Home tab, you're simply emailing the Page.  

And once again, there's a keyboard shortcut for that of Ctrl + Shift + E. So with all that said, 

we're now kind of moving into the territory of sharing our notes with others. And that's exactly 

what we're going to focus on in the next Section. I'm going to show you how you can save to 

OneDrive, move your Notebooks around, share your Notebooks with other people, save to 

different formats, and also how you can synchronize your Notebooks. So all of that is coming up, 

go grab yourself a coffee and I will see you over in Section 10. 
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Video: Windows 10 Interacting with Outlook 

 

Deb: Hi guys, and welcome back to the course. In this module, I just want to briefly run through 

with you the one option that we have in OneNote for Windows 10, when it comes to Outlook 

Integration.  

Now, you'll find this option on the Insert tab. And it's this one just here, Meeting Details. So we 

saw in the Desktop version, how we can insert Meeting Details. And fortunately, in OneNote for 

Windows 10, we also have this option. So what I could do here is click on Meeting Details. And 

if this is the first time that you're using this, it's gonna ask you to sign in with a Microsoft 

account so you can access Outlook.  

So I'm going to click on Sign in with a Microsoft account. And I'm just going to enter in my 

credentials. I then need to enter in my password, and click on Sign In. It's going to ask me to give 

this app permission to read my calendars. And I'm going to say Yes, that's fine. And now in the 

Meeting Details pane on the side, it's going to show me any meetings that I have set up in my 

calendar.  

Now you can see that for today, I don't have any meetings, which would make sense because it is 

a Sunday. Now if I click this drop down arrow, I can choose a day. So let's take a look at 

Monday and I can see that I have a Project Meeting there. So I'm going to double click on the 

Project Meeting and it's going to insert those Meeting Details in.  

You'll also see in the bottom right-hand corner I have a Refresh options. So if any of the details 

change in the Outlook calendar invite, I can simply update my Meeting Notes here by clicking 

that refresh button. 
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Section 10 – Saving to OneDrive 
 

Video: Saving to OneDrive 

 

Deb: Hello everyone, and welcome back to the course. This is still Deb. I hope you are doing 

well and enjoying the course so far. And we've now made it all the way down to Section 10. And 

in this Section, we're going to be talking about something that's particularly important in 

OneNote, and that is sharing our Notebooks.  

Now, most of the time when you're creating a Notebook in a business environment, you're 

probably going to want to share that with other people, particularly if it's going to be a place 

where lots of people can jump into the Notebook and add team notes. Now, as I mentioned right 

at the beginning of this course, if you do want to share a Notebook, you need to make sure that 

that Notebook is saved to a sharing location.  

So in my case, that might be something like OneDrive, it could be a network drive that you have 

at your office. Or if you utilize something like Google Drive, you can even set that up in your 

OneNote and share directly to there. Now this Notebook that we've been working in 

predominantly throughout this course, the Project Artemis Notebook, I saved this to OneDrive 

when we created the Notebook. So if I now wanted to go in and share this Notebook with other 

team members, then I'm perfectly fine to do that I'm not going to come across any issues.  

So I just want to show you an example of what happens when you have a Notebook open that's 

stored locally, and you try to share it with other people. So let's jump up to File, and I'm going to 

go down to Open. And if I scroll down and just take a look at my Recent Notebooks, I can see 

the one at the top of the list here. This is my Personal Notebook. And I have this saved to the 

Downloads folder, which is a very strange folder to save your Notebooks to.  

Now the reason I have this saved to Downloads is that I have my PC set up so that majority of 

my folders, even my Desktop, synchronizes with OneDrive. Now the Downloads folder is a local 

folder. So that is why I've saved it there in order to be able to demonstrate this to you. So let's 

click to open the Personal Notebook. And there we go. Now, I don't have anything in this 

Notebook as yet. But if I click the drop down, you can now see I have Project Artemis and 

Personal open. So Project Artemis is saved to a Shared Location, and Personal is saved to my 

local drives. So what happens if I now want to share my Personal Notebook with other people?  

Well, let me show you. Let's jump up to File, and let's go down to the Share option. And what 

you'll see is that I get this yellow warning message running across the top that says, “To share 

this Notebook, you'll need to put it on OneDrive or SharePoint”. So it's basically telling me I 

have to move my Notebook. So I'm going to select OneDrive, and I'm going to put it in the 

Notebooks folder. I'm going to give my Notebook the name of Personal, and click on Move.  

I get a message that says my Notebook is now syncing to the new location. And when I click on 

Ok, you can see that that yellow warning message disappears, and I now get all of the options I 
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need in order to share this particular Notebook. And you're pretty much gonna get a similar thing 

if you create a new Notebook from scratch. So if we jump up to New and we want to create a 

new Notebook, we need to first choose a location to save to. And if we want to share this new 

Notebook, then we need to make sure that we're saving it to a Shared Location. And if you don't 

see your particular cloud storage listed in here, then you'll just need to go down to Add a place.  

And because I'm connected to Microsoft, I get the option of setting up our OneDrive account or a 

OneDrive business account. And then you'll see that listed underneath Recent so that you can 

save into it. So that is pretty much it. I just wanted to make sure you were clear on that. Because 

again, in the past, I've had so many questions about this from different people, because people 

tend to make the mistake of creating a Notebook and just putting it somewhere like their 

Desktop, and then wondering why they can't share that with any of their team members.  

So the key here is just make sure you have it saved into a shareable location. And if you don't, 

you have the option to move your Notebook across. That's it for this module, I will see you in the 

next one. 
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Video: Inviting Others  

 

Deb: Hello everyone, and welcome back to the course. We're down to Section 10, where we're 

taking a look at how we can share our Notebooks with others. And in the previous module, I 

talked you through how it's important that if you do you want to share your Notebook with other 

people, that you save it to a Shared Location, such as OneDrive.  

So what I want to do in this particular module is just show you how you then go about sharing 

with other people. Now, right at the beginning of this course, when I was showing you how to 

create a new Notebook from scratch, you got to see that at the point of creating the Notebook, 

you were actually prompted to share that Notebook with other people from the get go if you've 

saved it to a shared location. So let's just remind ourselves of that.  

So I'm going to go up to File, and I'm just going to create a new Notebook. And I'm going to 

save it to a shared location, so I'm going to select OneDrive, I'm going to select the Notebooks 

folder. And we're going to call this while on a Project Delta, and click on Create.  

Now you can see that as soon as I've done that, it's asking me to invite people. So as long as you 

save your Notebook to a shared location, it's going to prompt you right from the get go to share 

that particular Notebook. Now, previously, I clicked Not now because I really wanted to wait 

until this module just to show you how it all works. So now, let's say Yes, let's invite people.  

So what this basically does is it jumps you across to the Share tab in the File menu, it selects 

Share with people, and you can then go in and type in the name or email address to invite 

someone to this particular Notebook. So let's type in a couple of people to invite.  

So I'm going to invite Adam, I'm also going to invite Jen, and let's also invite Ben as well. And I 

could carry on going adding more email addresses. So what I can do now is I can choose the 

level of access that I want these people to have to the Notebook. And you can see over on the 

right-hand side, I can choose to let them edit this Notebook, or just view this Notebook. So if 

you're sharing it with a team of people, it might just be that you want them to be able to look at 

the Notebook, maybe read a few things, but not make any changes to it. So in that case, you 

would select Can view.  

Now I'm happy for all of these people to edit, I want this to be a very collaborative Notebook 

with people adding their own notes. So I'm going to say Can edit. Now what you'll also see here 

is that if you have contacts in your Outlook address book, then you can choose to select them 

from there as well. I can type in a personal message, like so. And then I can choose if I want 

them to have to sign into Microsoft 365 in order to be able to access the document.  

Now I'm going to deselect this, I just want them to be able to go in with not too much fuss and 

make their edits. And then right at the bottom, you can see who this is currently shared with. And 

that is me, I'm the owner of this particular Notebook. So once I've got all that information in, I 

can click on the Share button. And it's going to send emails to all of those people with a link to 

this Notebook. All they need to do then is click on that link, and it's going to take them straight 

to this Notebook and they can start working on it.  
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What you'll also see is that now that I've shared it with them, I can see all of their names 

underneath that Shared with Section and also their level of access. Now if at any point, I decide 

that I want to change their level of access, so maybe I decide that I just want Adam to be able to 

view this Notebook as opposed to edit it, I can right-click on his name, and I can say change 

permission to Can view. So the other two people can still edit but Adam can now only view. And 

once again, if I decide that I want to remove access from someone to this Notebook, I can right-

click, and say Remove user.  

So a very straightforward and simple process to share with other people. So that is one way that 

you can share your Notebook with others. But there is also an alternative method. If you take a 

look on the left-hand side, you'll see that underneath Share with People, we have Get a Sharing 

Link. So what you can do in here is you can generate a link to this Notebook, and you can 

generate either a Viewing Link or an Editing Link.  

So if I was to click Create a View Link, it's going to generate a link to this document and I can 

now essentially copy, Ctrl + C and then Ctrl + V to paste that link into an Outlook email, maybe 

into a conversation that I'm having in Microsoft Teams or another messaging application. Then, 

anybody who has that link is going to be able to jump in and view that particular Notebook. Now 

there might be reasons why this is more appropriate than actually going to Share with People and 

typing in everyone's email address.  

If you have a lot of people that you want to be able to view this Notebook or even edit this 

Notebook, then sometimes it's a bit easier just to generate a link, and then copy and paste it into 

an Outlook email. And maybe use some kind of group list or distribution list to send that out to a 

large group of people. But either method is going to work. So that's entirely up to you which one 

of those options you choose to use.  

Now, the final options that you have in here are Share with Meeting. Now if maybe you have 

something like notes that you want to share with people in an online meeting. So this is an online 

meeting that's currently running, you can click on Share with Meeting and a link to the notes is 

shared with everyone in that meeting, so that everybody can contribute to it. Now, I don't have 

an online meeting running at the moment. So if I was to click this button it’s just going to tell me 

that I'm not currently joined to any online meetings.  

But if you were, you would get your meeting list come up there and you can choose which 

meeting you want to share the notes with. And then finally, at the bottom, here, we have Move 

Notebook. And we saw how this option worked earlier when we moved our Personal Notebook 

from our local drives, I had it saved into that Downloads folder to OneDrive. So if you ever want 

to change where you have your Notebooks stored, you can come into this option and move it 

fairly easily.  

But just know that if you have already shared that Notebook with others, then you're going to 

need to read up on how to move that sort of Notebook by clicking on this link. But when it 

comes to sharing, that is pretty much it. It's all very straightforward.  
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The key takeaway here is remember that you must have it saved to a Shared Location before you 

can invite others to join. That's it for this module, I will see you in the next one. 
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Video: Converting Notebooks to Other Formats 

 

Deb: Hi guys, and welcome back to the course. We're still in Section 10, where we're taking a 

look at sharing our Notebook with other people. And so far, I've showed you how to move or 

save your Notebooks to a Shared Location, and also how you can invite others to either view or 

edit your OneNote Notebook.  

Now, in this very quick lesson, I just want to talk to you a little bit about converting your 

Notebook to a different format. Now, whilst it seems that OneNote is a reasonably new 

application with regards to the Microsoft suite, it's actually been around since 2007. So there is a 

version of OneNote called OneNote 2007. So, I just want to run through with you ways you can 

recognize if you've been sent a OneNote Notebook that has been created in the 2007 version, and 

also how you can convert that Notebook from that older version to the much newer OneNote 

version, which is the 2010 to 2016 version.  

And fortunately, the later versions of OneNote have a conversion tool, so that you can essentially 

upgrade a legacy Notebook to the current format, and have access to all of the newer tools, 

features, and utilities. Now if you're using OneNote, 2010, 2013, 2016, or even 2019, these all 

use the same file format so you don't need to convert these files between these versions as you 

can just use them interchangeably. Now, how can you recognize if you're currently working in a 

much older version of OneNote?  

Well, the first thing is that when you open the Notebook, if you take a look up in the Title bar, 

where I have the title of this particular Page, Overview, and then it says OneNote, if you see the 

words Compatibility Mode in brackets, then that means you're working in a much older 

Notebook format. Now if you do see that, and you want to upgrade your Notebook to the latest 

format, it's a fairly simple process. So for example, let's just imagine for a second that this 

Project Artemis was a 2007 Notebook.  

What I would do to convert it is just click the drop down so I can see all of my Notebooks, right-

click on the Notebook that I want to convert, and jump down to Properties in the Contextual 

Menu. And you'll see right at the bottom, it says Default Format. So I can see that this one that 

I'm currently using is the latest format, it's OneNote 2010 to 2016. However, if this was a 2007 

Notebook, it would say that down here, and I then have an option to convert to the latest format.  

Once I've done that, then all of the latest utilities, functions, features will be available for me to 

use. Now, obviously, I'm not using a very old version. And so, that feature is grayed out for me. 

But it is a very simple process of just clicking that button. Now the reverse of that is also 

something worth noting.  

So, if you have the latest version of a Notebook like I do here, there isn't actually a way to 

convert that back to an older format. So, I doubt you'd probably ever need to do that but just a 

piece of knowledge for yourselves, that option doesn't exist.  
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So, just a couple of things for you to check there and to be aware of. As I said, you may not ever 

come across that, but if you do, at least you'll have the knowledge and the skills you need in 

order to upgrade your Notebook. That's it for this module, I will see you in the next one. 

 

  

http://www.simonsezit.com/


OneNote Desktop and Windows 10 

© Copyright 2008-2020 Simon Sez IT, INC. All Rights Reserved. 

Video: Exporting OneNote Content 

 

Deb: Hi guys, welcome back to the course. This is still Deb and we are headed towards the end 

of Section 10. And in this Section we've been taking a look at sharing our Notebook with other 

people. We've seen how to save it to a Shared Location, invite others to view or edit that 

Notebook. And I've also spoken to you a little bit about how to upgrade a very old OneNote 

Notebook to the current version. So what we're going to focus on in this particular lesson is how 

to export our OneNote content.  

Now, as we all know, OneNote is a great program for taking and storing notes. But it might be at 

some stage, you want to archive your notes, or maybe share those notes with somebody who 

doesn't have a Microsoft account. And that is where exporting comes in. Now you'll find all of 

your export options underneath that File tab, and you'll see that we have an option for Export. 

And this is where you can choose exactly what it is that you want to export. And you have three 

options there, you can either export just the Page that you're currently on. So for me that is the 

Overview Page, I could choose to export the entire Section.  

So for me, again, that is going to be everything within this Offices Section. Or I can choose to 

export the entire Notebook and the format that I can export in changes depending on what I want 

to actually export. So you can see that if I want to export the entire Notebook, the formats that 

are presented to me are a little bit limited compared to if I was just exporting a Page from my 

Notebook. So let's start out by just exporting a Page.  

Now I'm going to say that I want to export this current Page, the Overview Page to a Word 

document. So I'm going to select Word, and click on the Export button. And the first thing I'm 

going to do here is just give my file a name. Now for this, I'm pretty happy with Overview, it's 

just picked up the name of the Page. It’s going to save it in docx format, which is fine, and I'm 

going to click on Save. So now let's open up that Word file and see what it looks like. And there 

we go, you'll see that I have the contents of that particular Page exported out to a Word 

document.  

Now I will say that if you're doing something like this, then the Paper Size that you have set in 

OneNote is particularly important. So for example, if you have your Paper Size set to A4 or 

Letter in OneNote, then it's going to export in that size also. So if you have a different Paper Size 

set in Word, then you might find that things start to cut off. If I scroll down, you can see my table 

cuts off a little bit there. So make sure that you do check the Paper Size in both applications prior 

to doing this to make sure that everything looks nice and neat and tidy.  

Now let's jump back into OneNote, go up to File, and back down to Export. And this time, I 

might want to export the entire Section. And I'm going to export this to a PDF file. Click on 

Export. Once again, it's going to ask me to save this, I'm happy to have it called offices.PDF and 

click on Save, it's going to convert that to a PDF. I'm going to jump back into File Explorer, and 

I can see it sitting just there. And if I double-click to open, I have my entire Section, exported out 

to a nice, neat PDF file.  
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Let's jump up to Export one more time. And this time, I'm going to select Notebook. Now the 

first option you get here is a OneNote Package File. Now what this is, is a single file, which is 

going to contain all of the Pages, all of the Sections for the entire Notebook. So it basically 

contains everything that you have in your Notebook, including all of the Tags, all of the Images, 

Embedded Files, Audio and Video, so on and so forth. And it packages it up in something that's 

very similar to a zipped file, and it gives it the extension .onepkg. So this is a great format.  

If you want to maybe archive your Notebook, then you can export it to a package file, and then 

maybe save it to cloud storage or save it somewhere else, so that you always have it as an 

archived Notebook. You also might want to send the entire Notebook maybe to somebody who 

doesn't even have a Microsoft account and so can't access it online. This is a useful option for 

that as well. So if I was to select OneNote Package and click on Export, once again, I'm happy 

with this file name Project Artemis.onepkg. Click on Save, and it's going to export that entire 

Notebook.  

So now if I jump back down to File Explorer, you can see it's sitting there. I can double-click, 

and it's going to ask me to unpack the Notebook. So, this is very similar to the process you go 

through if you are trying to open a zip file. You need to choose the location where you want to 

save this particular Notebook. So, I'm actually just going to browse and save it somewhere 

different. I'm just going to put this on my Desktop, click on Select, and then click on Create. And 

there we go.  

So, I'm now opening this essentially, from my Desktop. I have my entire Notebook, Project 

Artemis, and all of the information that's contained within it. Now, because I've saved this 

locally, I have this warning message across the top saying that my Notebook might not be 

syncing. And that's absolutely fine because I've saved it locally. It doesn't need to synchronize 

with the cloud.  

And we're going to learn more about Synchronization in the next lesson. So that's it on exporting, 

I hope you found that useful. I'm going to head across to the next module, and I hope to see you 

there. 
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Video: Syncing Notebooks 

 

Deb: Hello everyone, and welcome back to the course. We're in the last module of Section 10, 

where we've been talking about sharing Notebooks. So in this last module, what I want to talk to 

you about is synchronizing your Notebooks.  

Now, one key important point you have to remember here is that when you're working in 

OneNote, using a Microsoft 365 accounts, you have access to your notes on your Desktop, like 

I'm using them here. But remember that those notes are also available in the cloud. And that just 

means that wherever you are, you can log into your Microsoft 365 portal, and essentially work 

on your notes.  

You don't have to have the laptop that you created them on, you can be in a completely different 

location. But as long as you have an internet connection, and you're using a Microsoft 365 

account, you can log into the online version of your notes and work away. So essentially, what 

you have here are two copies. And these copies need to be kept in sync. So when I'm working in 

my Notebook like I am here, because I have this saved to OneDrive, every time I start to make 

changes to this Notebook, it's automatically synchronizing with the cloud version.  

So tomorrow, if I was away somewhere, and maybe in an internet cafe, maybe I don't have my 

laptop with me, I could still access my notes by logging into the web version, and opening up 

OneNote from there. So if you're not sure what I mean by the online version, let me show you 

that first. So this is the online web version. Now all I've done here is I've opened up a Google 

Chrome browser, I've gone to office.com, and then I've logged in to my Microsoft account.  

So these are the credentials that you get when you set up a Microsoft 365 account. And this 

allows you to access all of your different applications in a web browser. And you'll see one of the 

options we have there is OneNote. So if I click on that, I can then go through and I can see all of 

the Notebooks that I've created, and I can open them up. So if I click on Project Artemis, it then 

allows me to go into that Notebook, and work essentially in the web version of OneNote. And 

the thing you'll notice immediately is that this does look a little bit different to the Desktop 

version.  

But essentially, I have all of my different Sections and all of my Pages and I can work away. So 

just to go back to the topic of Synchronization. If I jump back to my Desktop version, if I make 

any changes in here, what OneNote does, it automatically saves those changes and synchronizes 

them so that when you're working in the cloud version, you have the most up to date copy. And 

one thing you'll notice with OneNote is that if we go to the File tab, we don't actually have a 

Save button in here.  

So we don't have to keep going in and saving or pressing the keyboard shortcut Ctrl + S as we're 

making our changes, because it's automatically saving to the cloud. So a few options related to 

Synchronization that you have in this area. So we're working on Project Artemis, I'm currently 

clicked on the Info Section. And what you'll see next to Project Artemis is that I have a View 

Sync Status button. So let's click on this and it opens up the Shared Notebook Synchronization. 
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So it's showing me all of the Notebooks that I've saved to OneDrive or a Shared Location. And I 

have the option Sync automatically whenever there are changes selected. And it's my 

recommendation that you have this option turned on so that you don't have to worry about saving 

or synchronizing manually.  

Then what I see underneath is it's going to tell me that these Notebooks are all up to date, and 

then also the last synchronization time. So I can see that for this one Project Artemis, it last 

synced about one minute ago. And I have an option there to run a manual sync by clicking on 

Sync Now. You can see that I get this bar. It's synchronizing, checking for changes. And then 

once it's done, that will finish. It's telling me my last sync was just now. So everything should be 

up to date. Now, because I've chosen to automatically sync my changes, I don't actually really 

need to go in and click on Sync Now. But just be aware that that button is there.  

And if you have a lot of Notebooks listed in here, and you want to just quickly manually 

synchronize them all, you have a Sync All button at the top. You could also choose to 

synchronize all of your Notebooks manually. Now as soon as I check that option, you can see 

that I get a cross next to each of my Notebooks. So that's basically telling me that I've turned off 

Automatic Synchronization. And so for any changes I make to update in the cloud version and be 

available when I access them through the web, I will need to go in and manually synchronize all 

of my Notebooks.  

So for me personally, that is way too much work. I much prefer to have them all automatically 

synchronizing whenever I'm making changes. And that is pretty all you need to know when it 

comes to synchronizing or keeping your Notebooks updated so that you can access the most up 

to date copy wherever you are using your Microsoft portal.  

That's it for this module, and that is it for this Section. In the next Section, we're going to start to 

take a look at how you can collaborate with others in a Notebook. So I'm excited. I'm going to 

grab a coffee, and I'll see you over there. 
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Video: Windows 10 Sharing a Notebook 

 

Deb: Hello guys, and welcome back to the course. We're now down into our module related to 

OneNote for Windows 10 users. And in this Section, we've been talking about sharing and also 

syncing our Notebooks.  

Now when it comes to syncing, things works slightly different in this version for Windows 10. 

So for example, when I first created this Notebook, it didn't ask me to select a location to save it 

into. And that's because it didn't need to. Because when I set up this laptop, I connected it up to 

my Microsoft account. And so OneNote for Windows 10 knows who I am, and it knows that I'm 

using OneDrive. And so it's automatically saved it into my Documents folder in OneDrive.  

Now, if you want to go in and start checking what account OneNote for Windows 10 is using, if 

you jump up to the three dots in the corner and go down to Settings, you'll see you have 

Accounts listed in here. And you can see that there is the account that mine is using and this has 

OneDrive attached to it. So if you don't see your account listed in here, you're going to want to 

add your account, and then go through and set up either your personal Microsoft account or your 

workplace or school account.  

And remember, all of these rely on you having a Microsoft 365 subscription. Because remember, 

when it comes to sharing and also synchronizing, your Notebook must be stored in a Shared 

Location. Now this Notebook here, Project Sierra, if I go to File Explorer, you can see, there it is. 

So this Notebook has automatically saved to my personal OneDrive into the Documents folder. 

So essentially, this is in a sharing location, which is going to enable me to share it. So let's move 

on to that topic of sharing our Notebooks.  

In the Windows 10 version, you'll see right up in the top right-hand corner, you have a share link. 

So let's click it and see what we get. So it's telling me that I'm about to share this Notebook, 

Project Sierra. And then I just need to type in an email address for the person I want to send it to, 

like so. And then I can choose if I want Jen to be able to edit or just view this particular 

document. I can see underneath who this Notebook is currently shared with, which is just me as 

the owner. And then I can choose if I want to send a copy, or if I'm just happy sending a link 

directly to this Notebook.  

So I'm going to click on Share. That's going to send an email to Jen with a link in it to this 

Notebook. And you can see that once I've done that, her name has now been added to this list of 

people who this Notebook has been shared with. Now just to go back to Synchronization for one 

moment. Because this Notebook is shared in OneDrive and I've just invited Jen, it might be that 

Jen jumps into this Notebook and then starts making changes. And everything synchronizes 

exactly the same as the Desktop version in OneNote for Windows 10.  

Now some other sync options that you have, if you right-click on the Notebook name. So in this 

case, Project Sierra, you'll see the second option down is Sync. And this is going to allow me to 

do a manual sync of this Notebook or all Notebooks that I have open. Now I shouldn't really 

need to do this because I have my Notebooks syncing automatically. So again, if you want to 
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check if you have that option turned on, if you click on the three dots in the top right-hand corner 

and jump into Settings, and then Options, you'll see where it says Sync your Notebooks.  

And then underneath, we have some text; “OneNote automatically syncs your Notebooks to the 

cloud to keep them up to date”. If you turn this off, remember to sync regularly to avoid losing 

any of your work. So I have my Notebooks syncing automatically turned on. And I've also 

chosen to sync all files and images as well. Now if you had these turned off, it means that you're 

going to need to do a manual synchronization.  

So that is when you would come into the right-click menu, go to Sync, and then choose Sync this  

Notebook, or Sync All Notebooks.  
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Section 11 – Author Indicators 
 

Video: Author Indicators 

 

Deb: Hi guys, and welcome back to the course. In this Section, Section 11, we're going to talk 

about collaborating on OneNote Notebooks. And we've been through the process of sharing a 

Notebook with team members, colleagues, and the people. And the idea behind sharing is that so 

you can have things like team Notebooks when you're working on group projects, and everybody 

can contribute to the notes on that project.  

Now, one of the issues that occurs when you do have several people working on a shared 

OneNote Notebook is that sometimes it can be quite difficult to know who's made each change. 

So to help with this, you have some options available on the History ribbon, that's going to help 

you search for changes by specific authors. So if we jump up to the History tab, you can see we 

have an Author's Group. So let's start out with this first button here, Recent Edits.  

This is going to allow you to find changes in your Notebook by time. So if I click the drop down, 

I can choose to see only the changes that have been made Today, I can choose to see all of the 

changes since Yesterday, the last 14 days, so on and so forth. And you can see there, it's 

highlighting in the Page where those changes have occurred. And if you take a look over in the 

right-hand side pane, it's searching through the entire Notebook. And of course, you can change 

that to be a little bit more specific if you want to. And it's also sorting by Date Modified.  

So it's showing me all of the changes that have been made this week. And then all of the changes 

that have been made last week, and last month. And if I want to jump to a specific change, I can 

simply click on the link, and it's going to jump me across, and it's going to highlight everything 

that's been changed on that Page. So that option is particularly useful for finding your most 

Recent Edits.  

The next option that you have is Find by Author so you can see who has made specific changes 

in this Notebook. Now currently, I'm the only one who's edited this Notebook. So when we click 

on Find by Author, again, we have a pane pop out on the right-hand side. But this time, it's 

sorting the changes by Author. And what's going to happen here is it's going to list out 

everybody who's made changes to this particular Notebook.  

So if you've shared this Notebook with maybe three or four other people, and they've come in, 

and they've added Notes, or Images or Tags to this particular Notebook, you're going to see those 

names listed in here. And when you click the Expand button, so if I do that for my name, it's 

going to show you all of the changes that that particular Author has made. So this option is 

particularly useful if you're wanting to know who exactly has changed what parts of the 

Notebook.  

And then finally, in here, you have a Hide Authors option. And it says, “Hide or show other 

authors’ initials next to their changes in this Notebook”. So if you want everybody who's 
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changing this Notebook to have their initials appear next to the text or the item that they've 

changed, then you can choose to show that by deselecting this button. However, if you want to 

hide it, if you click on Hide Authors, then it's just going to remove those initials from the Page as 

well.  

As I said, currently, I'm the only one who's editing this Notebook. And those initials won't show 

for me because I'm the one that created the Notebook. So three very straightforward but very 

useful utilities that you have when you have multiple people working on the same Notebook. 

That's it for this module, I will see you in the next one. 
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Video: Page Versions 

 

Deb: Hello everyone, and welcome back to the course. In this very quick module, I just want to 

run through with you Page Versions. Now a really cool feature of OneNote is that you have the 

ability to restore older versions of Pages.  

So, if maybe you've made changes to different Pages, and then you want to reverse those 

changes and go back to what they looked like originally, you can do that through the Page 

Versions feature. So once again, we're working up on the History tab. And in the History group, 

we have Page Versions. So let's click the drop down and see what we have available. So the first 

thing I can do here is I can show all versions of this specific Page.  

So currently, I'm clicked on the Page Project Meeting 12/02/2020. Now if I click on Page 

Versions, what you'll see is that now it's showing me an older version of this Page shaded out in 

gray. So what I can do is I can click on this Page, and I can take a look at the older version. So I 

can see that in this older version, I didn't have the date on the end. So what I've probably done 

here is created this Page, and then decided the title would be a bit more meaningful if I included 

the date of the Project Meeting. So I changed it so that it looks like this.  

However, if I decide that I actually want to go back to this original Page, you can see that I have 

a yellow warning bar across the top that says, “This is an older version of the Page that will be 

deleted over time. Click here to restore this as the main Page or see more options”. So let's just 

pretend for one moment that I want to restore this Page, I'm going to click on this yellow bar. 

And then I get a Contextual Menu full of different options. And the ones that I'm really 

concerned with are the top three, so I can choose to Restore this version.  

So essentially, it's going to override that new version. I can Delete this version, or I can Copy 

this version to another Section, another Page, so on and so forth. So what I'm going to do here is 

I'm going to say that I want to restore this version of this Page. So let's click on Restore. And 

now you can see that this has become that main Page. Now because I've restored that older 

version, OneNote is now showing me other versions of this particular Page. And I can see that I 

have two, again, highlighted in gray.  

Now I've decided that I don't actually need these versions, I'm happy with this one just here. So 

this time, I'm going to click on the yellow bar, and I'm going to say Delete Version. And I'm 

going to do the same thing for this one, click the yellow bar, and Delete Version. So let's take a 

look at some of the other options that we have in that Page Versions drop down menu. I switched 

to the Offices Section, and I'm clicked on the London Page. So I'm going to jump up to Page 

Versions and take a look at the older copies.  

So for this particular Page, I can see that I have four other versions. And I can click through them 

to take a look at the differences. And I can see here for this particular one, I've gotten an icon just 

before Office Address, whereas the current Page doesn't have that icon. So maybe I decide that I 

want to restore this particular version and make this the official London Page. Once again, I'm 
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going to click and select Restore Version. And now I have all of these other versions of this 

particular Page.  

Now I might want to go through the rest of this particular Section, taking a look at the Page 

Versions that I have. I can see that for some of these, when I click, if that Page Versions button is 

grayed out, it means that there are no other Page Versions for that particular Section. Now, we 

didn't really add anything to these, and so that would make sense. But I can see that for Paris 

Page Versions is active. So let me click it. And I have one other Page Version. Now, I don't 

particularly want that version, and I also don't want the Page Versions that I have for London.  

So once I've checked this entire Section, in order to delete all of the versions that I don't need, 

instead of going through and deleting each old version one by one, what I could do is jump up to 

Page Versions and say Delete All Versions in Section. And you'll see that I also have a Delete 

All versions in Notebook option up here as well. So a really efficient way of getting rid of all old 

copies of Pages. Now I'm going to say Delete All Versions in Section, and I'm going to say Yes. 

And there we go. All of those old versions have now been deleted. So that is it.  

That's a really nice way being able to keep track of old copies and restore them. So it's kind of 

like a bit of a lifesaver if you make changes to a Notebook and then change your mind and want 

to revert back to an older version. So, don't forget about that little option.  

Now in the final module of this particular Section, we're gonna deal with this other command 

that we have in this Histories group. And that is the Notebook Recycle Bin. So here, we're 

dealing with items that we've deleted. So let's talk about that more in the next module. I'm going 

to head over there now, and I look forward to you joining me. 
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Video: The Notebook Recycle Bin 

 

Deb: Hello everyone, and welcome back to the course. We're down to the last module of Section 

11. And for this module, we're going to be staying on that History tab. So we've been through 

pretty much all of the options that we have on this ribbon. And the last one that we need to go 

through is the Notebook Recycle Bin.  

Now, as you delete Sections and Pages from your Notebook, they don't disappear entirely, 

they're kept in the Notebook Recycle Bin in OneNote. And you can jump into that Recycle Bin 

and restore any deleted Sections or Pages from within your Notebook for up to 60 days. So it's 

worth noting that if you do delete something, and then 60 days passes, those Pages and Sections 

are going to be permanently deleted from OneNote, and you then can't recover them.  

But up until that 60-day mark, if you want to recover any deleted items, if you just jump into 

Notebook Recycle Bin, it’s going to jump you into the Recycle Bin for this particular Notebook, 

which in this case is Project Artemis. And it's going to show all of the Pages that you've deleted 

from your Notebook. And what you'll see is that if I click on any of these Pages, I get this yellow 

bar running across the top that says, “Items are permanently deleted after 60 days. Right-click a 

Page or Section to move it out of the Recycle Bin”.  

So let's right-click on this Page, just here and take a look at the options that we have. Now when 

you right-click, you might think you'd have some kind of Restore option. But in fact, what you 

have is the option to Delete and that will delete it permanently if you're deleting from the 

Recycle Bin, or you can Move or Copy that particular Page. So if I decided that I wanted to 

actually keep this Page and move it out of the Recycle Bin, I can click Move or Copy and then 

select where I want to move it to.  

So I'm going to say I want to move it to the Schedule Section, and click on Move. And you can 

see that that's now been moved. If I click the green arrow to go back to my Notebook and go to 

the Schedule Section, you can see that there is that Page. Now let's jump back into the Notebook 

Recycle Bin, because something you may not have noticed is that on the left-hand side, it's 

listing out all of the Pages that I've deleted.  

But running across the top, we have all of the Sections that I've deleted. So we can do exactly the 

same for any of these Sections. So if I wanted to restore the Courses Section, I can do the same 

thing, I can right-click, and I can choose to Delete, or Move or Copy. So don't forget that it 

doesn't just apply to deleted Pages, it also applies to deleted Sections.  

Now the final option we have in here that's of interest is the Empty Recycle Bin option. So if you 

just decide that you want to straight off the bat permanently delete all of the deleted Sections and 

Pages without waiting for that 60-days to pass, then you can choose just to empty the Recycle 

Bin.  

So it's going to say, “Are you sure you want to permanently delete all items in deleted notes for 

this Notebook”? So I'm going to say Yes, click on Delete, and now I have nothing listed in there. 

And finally, if we just jump back into that drop down menu, the option at the bottom is to 
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Disable History for this Notebook. So if you do that, it's basically not going to keep track of 

things that you've deleted or things that you've changed. So that's really entirely up to you if you 

want to enable that option. I like to have that backup just in case I do make a mistake, I know 

that I can go back and retrieve my items. But again, this is very much personal preference.  

So that is it on where your deleted items go, and some of those options you have for managing 

deleted items from that Notebook Recycle Bin. That's it for this module, and that is it for this 

Section.  

In the next Section, we're going to zero in on those OneNote options and I'm going to show you a 

few things that you might want to consider turning on to make the whole experience when you're 

working in OneNote a little bit more efficient. But for now, that is it. I will see you in the next 

Section. 
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Video: Collaborating on a Notebook 

 

Deb: Hi guys, and welcome back to the course. In this Section, we've been taking a look at 

collaborating on our Notebooks with others, and we're now down into Windows 10. And I'm just 

going to show you the equivalent options that you have in here.  

So for this, I'm going to jump up to the View tab. And you'll see right on the end, here, we have a 

Hide Authors button. And this is a toggle button. So you'll see when I click it, it highlights in 

gray to show that that is toggled on. If I click again, I'm toggling off. So if you remember, I 

shared this Notebook with Jen. And when Jen opens this Notebook and starts to make changes, 

you'll see that all of her changes will display her author initials. And so essentially, what this 

button does is it allows you to hide those author initials on the Page.  

Now, something else we covered in this Section was the Notebook Recycle Bin. So this is where 

all of your deleted notes end up. And they're held in that Recycle Bin for 60 days before they are 

permanently removed from the system. Now we have something that's fairly similar in this 

version of OneNote. And again, we're up on that View tab. And right in the middle there, we 

have Deleted Notes. You can see as I hover over, we have a drop down arrow, and I can go in 

and view my deleted notes. And this is now showing me all of my deleted Pages.  

So I can see that I've deleted two Pages; Tuesday, and Monday. And I'm getting a message 

running across the top that says, “Right-click or tap and hold on a Page or sanction to restore it”. 

And once again, all items are permanently deleted after 60 days. So if I now decided that I 

wanted to restore this Tuesday Page, what I could do is right-click my mouse, or if I was using a 

touch screen, I could tap and hold. And you can see I have some options in that Contextual 

Menu.  

Now I could choose to delete this Page permanently, which is going to delete it off the system 

now, which is going to override that 60-day grace period and just delete it permanently. But what 

I want to do here is I want to restore that Page. So I'm going to select Restore To. I'm going to 

restore it to the ToDo List and click on the Restore button. So now if I jump back to my 

Notebook list, I can see that there is my restored Page. 
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Section 12 – Customizing OneNote Options 
 

Video: Customizing OneNote Options 

 

Deb: Hello everyone, and welcome back to the course. We're heading towards the end of this 

entire course, and we're into the last couple of Sections. Now in this Section, Section 12, I just 

want to run through some of the important or key features when it comes to customizing 

OneNote so that it works for you how you want it to work.  

Now, we've been dipping in and out of OneNote options throughout this entire course. But I just 

want to dedicate a few minutes just to go back in there and review some other options that you 

might want to consider changing. So we're going to go up to File and all the way down to the 

bottom and select Options. So we have quite a few different Sections that make up our OneNote 

Options. And a lot of these will have default settings. And what I find is, in General, the default 

settings that you have in here are usually appropriate for most people.  

However, there are some things that you can customize just to make things really work how you 

want it to work. Now this first Section, the General Section, we actually went through this 

previously. This is where you would come if you want to toggle or forum that little mini toolbar 

for formatting. And you can also do things in here like customize the style of the ScreenTip. So 

when you hover your mouse over a command on the ribbon, what information do you want to 

see in there?  

This is also where you would come to set up your Default Font. So if you remember, I changed 

my Default Font from OneNote from Calibri to Sigoe UI. And I also changed that size, I made 

the Font a little bit bigger. And then finally at the bottom, something else we looked at is 

personalizing our copy of Office, we can do things like change the Background, and also change 

our Office Theme. Maybe you want a black theme or a dark grey theme, so on and so forth. So 

we're reasonably familiar with everything we have in that General Section. Let's jump across to 

Display.  

Now again, this is a Section that we've been into before. But a couple of things I’ll highlight in 

here is this second option down. If you want to make sure that all Pages that you create are 

created with rule lines, then you're going to want to toggle this option on. And if you remember 

something that I did change in here was that I changed where my Page tabs are going to appear. 

So by default, your Pages will be listed on the right. But I changed them to appear on the left, 

which is why you can see them running down the left-hand side.  

Now I'm going to change that back to on the right. And a couple of other things that I highlighted 

previously was I've chosen to show all of my note containers on my Pages. So when I start to 

type, I can see the container for that text. And I can do things like resize it, so on and so forth. 

And I've also chosen to disable Screen Clipping notifications. So one thing you'll notice is that if 

you have this turned off, when you take a Screen Clipping, you're gonna get lots of pop ups 

appear on your screen, we're not locked. So you'll get one pop up on your screen, just letting you 
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know that you've taken a Screen Clipping. If you find that's a bit annoying, then just toggle that 

on so that you disable it.  

So moving down to Proofing, this is really controlling your spelling and your grammar. So for 

example, right at the bottom, I have the option to check my spelling as I type. So as I'm typing 

out my notes, if I happen to make a spelling error, OneNote is going to immediately indicate that 

to me by displaying a red squiggly line underneath the word if it's spelt incorrectly, or a blue 

line, if I have a grammatical error. There's something else you can do in here is you can set up 

AutoCorrect options.  

So for example, if you find yourself constantly typing out your name, and you want to make that 

a lot quicker and simpler for yourself, what you can say here is replace your name with and then 

choose a much shorter version. Now I've already set up my name in here. So I'm going to do 

somebody else's name. Let's say I type the word Adam Lacey quite a lot. And instead of typing 

that out each time, I'm just going to replace it with his initials. So now when I'm typing a note, 

and I want to type in the word Adam Lacey, I can just type in AL, hit the spacebar, and it's going 

to autocorrect it to Adam Lacey.  

So this is really useful if you have lots of things that you find yourself repeating typing over and 

over again, it makes you a little bit more efficient. So it's definitely worth having a look in here 

and checking what AutoCorrect options you have set up. There's some really useful stuff in here. 

So for example, if you type the copyright symbol, instead of going up into symbols and 

searching for it, you can just type C with brackets around it, and it will autocorrect copyright. 

The same thing for the Euro Symbol, Trademark Symbol, so on and so forth. So very helpful to 

have a little look in here and add any AutoCorrect options that you think are going to be useful to 

you.  

We then have our Synchronize options. Now, not too much in here that I want to highlight, I 

would recommend that you do have Sync Notebooks automatically turned on, as we explained in 

the module related to Synchronization. Saving and Backing up, I'm going to talk about in another 

module. So I’m going to skip over that for now. The Send to OneNote option is really when you 

are sending content from external websites or other applications to OneNote. Now I have my 

different items that I can send. So I can send things like email messages directly to OneNote. I 

can send things like web content, we've seen that before. And I have all of these set to ask where 

to send.  

So if I'm on the internet, and I find a piece of content that I want to import, essentially into my 

OneNote Notebook, I want to be able to select exactly which Section and Page I want to send 

that to. And that is why I have this option, Ask where to send as my default. Now I could change 

that, I could say Send to current Page, so I'm not going to get that pop up asking me for a 

location, I could choose to send it to a new Page in the current Section, or I could set my own 

default location.  

Now, more often than not, when I'm sending content, there's no standard place I want to send it 

to, it's normally different Sections and different Pages each time. So that is why I like to have 

mine set up in this way. But again, this is completely personal preference. Audio and Video is 
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where you would come to set up your audio recording settings and also your video recording 

settings. So make sure that those are correct. We have a Language Section where you can select 

what your preferred language is to work in. So for me, you can see at the bottom here, even 

though I am in fact, in the United Kingdom, because a lot of the work I do is for American 

clients, I have English United States set up as my preference language for both proofing and 

typing out my notes.  

So that means that because I have selected English United States, if I was to type a word like 

colour in the British way, which would be c-o-l-o-u-r. Whilst that is correct for me, because I 

have my proofing set to United States, that's going to register as an incorrect spelling, because 

the word colour is spelt slightly differently in America, as opposed to the UK. So just be aware 

of that when you're setting up your Proofing and Language options.  

We then have the Advanced Section. Now this contains a whole host of options. And I would 

recommend that you go through each of them and make sure that everything is set up as you 

want it to be. So for example, this second one down here, Include link to source when pasting 

from the web. So if you remember when we would bring in content from the web or any other 

application, it posts a link underneath which allows you to click on that link and jump back to the 

source for that image or that note, whatever it might be.  

Now, I will say that a lot of the time I do go in and delete out these links if I just want the image. 

So if you don't want to have to do that each time, you could essentially toggle this option off. 

And it won't include any links when you're pasting from the web. A couple of other items in 

here, when it comes to Linked Notes, so I definitely want to Allow the creation of new Linked 

Notes. So if you did like that option, when I showed it to you make sure that you have a tick in 

there. We have some options in here for touch device users with regards to the pen. So if that 

applies to you definitely come and review those.  

And in this Section, Emails sent from OneNote, this is really where you can customize when you 

do send an email from OneNote. So if you share something maybe with somebody else, you can 

choose what appears in that particular email. So for me, I have Add the following signature to 

emails and web Pages created in OneNote. And it just says, Created with OneNote. It might be 

that you want to have some other kind of default text in there when you send an email. So this is 

where you can input it. Let's move down we have some options related to Tags.  

And then finally right at the bottom, this is really the only other thing I would highlight to you in 

here are your Measurement Units. So I have mine set to Inches. But if you want to change it to 

something else, so Centimeters, Millimeters, Points, or Picos, then you can do that from here. 

Now we then have the Customize ribbon Section. Now this is where you can come to customize 

the commands that you're seeing on your ribbons. So on the right-hand side, you can see all of 

my main tabs.  

So let's say for example, the Home tab. And underneath there you can see the different groups, I 

can expand the Clipboard group, for example, and that's going to show me exactly what is on 

that Clipboard group. So I have the Paste command, Cut, Copy, and Format Painter. Now the 

way that this works is that you can't actually add commands to existing groups. You would need 
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to create your own new group. So at the bottom here, if I select New Group, it's going to create 

me a custom group. I can rename it and choose a symbol. So I'm going to choose this symbol just 

here. And I'm going to call this group, let's just call it Delete, click on Ok, and I can now add 

commands to this particular group. So I'm going to select Delete from the left-hand side and 

click on Add. And you'll see in a moment when I click on Ok, what that looks like.  

So essentially, this is where you would come to create new groups on ribbons and then add 

commands. We then have the Quick Access toolbar, we've seen how this works in a previous 

module, so I'm not going to linger on this. We have a Section for Add-in. So if you want to 

enable or disable any Add-ins in OneNote, this is where you would come. And then finally, we 

have the Trust Center at the bottom, which is where you can customize your Trust Center 

settings.  

Now, we don't have as many different settings in here as we do in other applications such as 

Excel. But if you have things like Trusted Publishers, you can add them into here, and also any 

Add-ins as well. So let's just click on Ok. And I want to jump you to that Home tab. And what 

you'll now see is that I have a Delete group and a Delete command in here. So that has come 

from customizing the ribbon in our OneNote options. Another thing that you'll also notice is that 

I switched my Pages to display on the right-hand side of the screen. And you can see in fact, that 

is what I'm now seeing.  

So there are a lot of options in there. I haven't been through every single one in a very granular 

fashion. I've just tried to highlight some ones that I think are quite important and things that you 

might want to review. So definitely worth jumping in there and ensuring that your OneNote is set 

up in the way that you like to work. That's it for this module, I will see you in the next one. 
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Video: Password Protection 

 

Deb: Hi guys, welcome back to the course. We're down in Section 12, where we're taking a look 

at different OneNote options. And in the previous module, we jumped into OneNote options, and 

we reviewed each of the different Sections. And I highlighted to you some things that I think are 

important for you to review and customize to suit yourself.  

Now another option that you have in OneNote is the ability to Password Protect or Lock different 

Sections of your Notebook. Now, you may be used to this in other applications. So things like 

Excel, you can lock spreadsheets, and cells and things like that. And you can pretty much do a 

very similar thing in OneNote. So the reasons why you might want to lock different Sections in 

OneNote is to keep them safe from prying eyes.  

So that might be confidential meeting notes when you're at work, or maybe something that's 

more personal to you like a diary or a blog. Or maybe Sections that contain personal information 

about yourself or your family. Password Protecting them goes a long way to control who can 

access those notes. Now, before I go through and show you the process of Password Protecting 

items in OneNote, there's a few things you need to be made aware of.  

Now the first thing and this is a question I get all the time is that passwords can only be applied 

to Notebook Sections, you can't apply a password to an entire Notebook. Another important 

thing to know is that if you do set a password, OneNote uses encryption. So if you forget what 

the password is, or you lose that password, there is no way for you to recover that password 

essentially. So it is crucial that you remember it or write it down and keep it in a safe place 

because no one is going to be able to unlock the Section for you, not even Microsoft technical 

support.  

Another thing to note is that if you do Password Protect a Section, those Sections aren't included 

in any Notebook searches that you run. So if you Password Protect three different Sections, and 

then you're looking for a particular keyword, it's not going to search in those protected Sections. 

The same thing also applies to any Tags that you have on Pages. If you have Tags on protected 

Sections, if you run a search to look for specific Tags, it's not gonna include any Sections that are 

Password Protected. So just a few little items there to be aware of before we go through the 

process of locking our Sections.  

So let's just say that we want to lock the Page Setup Section. And this Section contains numerous 

different Pages. Now all you need to do is right-click your mouse on that Section tab. And you'll 

see towards the bottom we have a Password Protect this Section menu item. Let's click it and it 

opens the Password Protection pane. So what I'm going to do here is I'm going to say Set 

password. And I'm going to type in a password. And you can see again there at the bottom, we 

have that little caution, “If you lose or forget the password, OneNote cannot recover your data”.  

Also remember that passwords are case sensitive. So I'm just going to apply a quick password. 

I'm going to confirm that password and click on Ok. Now here, it's telling me that there are 

existing backup copies of this Section that will not be Password Protected. So basically, it's 
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telling me that I have older versions of this Page. So I'm going to say Delete existing backups, 

and my Section is now Password Protected. Now one thing here that often confuses people is 

that once they set a password on a Section, they kind of can still click around in that Section, 

start to type notes, and make changes. And that's because there is a second part to this locking 

process. Once you've set a password, you then need to lock the Section. And if you set a 

password or multiple different Sections, you can in fact lock all of them at the same time.  

So if you take a look in this Password pane on the right-hand side, you can see it says, “Once you 

unlock Password Protected Sections, they stay unlocked for a while. And you can lock all 

Sections now by pressing the keyboard shortcut Ctrl + Alt + L, or you can click the Lock All 

button”. So if I click Lock All, you'll now see that it says, “This Section is Password Protected”. 

So if I close down this pane, all of my other Sections are still available. When I go across to Page 

Setup in order to edit or even view this Page. If I click somewhere on the screen, it's going to ask 

me to enter the password. So I'm going to enter that password, click on Ok. I'm now back in and 

I can make my changes.  

So essentially anybody who's looking at this Notebook is going need to know the password in 

order to access that particular Section. If I right-click and go back into Password Protect this 

Section, we also have a couple of other options up here, you can choose to change that password. 

So for this, you're going to need to know what the old password was before you can enter a new 

one, or you can remove the password altogether. Which essentially removes the protection from 

this Section. So that is how you can lock one or more Sections in your Notebook.  

The final thing I want to show you here is if we jump back up to File and go back down to our 

Options where we were in before and go down to Advanced, we do have a Section in here for 

Passwords. Now, there's a couple of options in here that you might want to review. So for 

example, as you saw, we went in, we set a password, and then we locked that Section. But what 

you could do is say, “Lock Password Protected Sections after I've not worked in them for the 

following amount of time”.  

So if I have a password set in a particular Section, and I don't work in that Section for five 

minutes, OneNote is automatically going to lock that Section for me. Alternatively, you can 

choose to lock the Password Protected Section as soon as you navigate away from that Section. 

And then the final option is you can enable Add-in programs to access Password Protected 

Sections when they are unlocked. So a couple of options in there that you might want to review.  

But with regards to actually protecting your content, that is it. It's a fairly straightforward and 

simple process. That's it for this module, I will see you in the next one. 
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Video: Setting Backup Options 

 

Deb: Hello everyone, and welcome back to the course. This is still Deb, and we are down to the 

last module of Section 12. And the final thing I want to run through with you in this Section is 

Saving and Backing up your data. Now, as we all know, backing up is extremely important not 

just in OneNote, but for all of our files, so that we don't have some kind of catastrophic crash and 

lose all of our hard work. And the same thing applies in OneNote.  

Now, fortunately, OneNote automatically saves all your notes as you work. But it is always 

worth making sure that you do have a backup copy of your Notebooks. So to check the settings 

that you have set up with regards to backups, you want to go into File. And again, we're jumping 

straight back down into Options. And the Section we want to go to is the one that we skipped 

over when we were going through OneNote options in one of the previous modules, we're going 

to click on Save and Backup and just review what we have set in here.  

So it says, “Customize how OneNote saves and backs up your notes”. And the first thing we can 

see here are some default save locations. So for example, when it comes to Quick Notes, 

remember, those are those notes that we can take on the fly. So this is showing me the local path 

where it's going to save those notes. The same thing here for my Backup Folder. So everything 

that I'm doing is being backed up to this specific folder. And then finally, I have a Default 

Notebook Location. So when I create a new Notebook, it's automatically going to save it in this 

folder path.  

Now all of these are customizable. So if you decide that you don't like the Backup Folder that's 

been selected for you, you can click on Modify, go in and choose a different folder in order to 

backup to. So it might be that you want to create a folder called OneNote Backups somewhere on 

your PC, and then set that as the Backup Folder. How you want to manage that is entirely up to 

you. But make sure that it is a location that's easy for you to get to. You can then choose 

underneath how often you want to backup your data.  

So for mine, I have it set to, “Automatically backup my Notebook at the following time 

interval”. So every week, my Notebooks get backed up to this specific folder. And you can click 

the drop down and change that to any one of these different options. So again, just select 

something that's most suitable to you, and how often you work in OneNote and update your 

notes. And if you want to quickly run a backup right now, you can choose to Backup any 

changed files or Backup all of your Notebooks right now.  

So this is a manual way of backing up just to make sure that you have the most up to date copy. 

Now I in general like to do this before I do something like a Windows Update. I'll come in here, 

I’ll backup all of my Notebooks just so I know that if something happens to go wrong, I do have 

the latest version backed up. So there's just a few options that you need to check in here. But they 

are extremely important so that if something does happen, you've given yourself the best possible 

opportunity to be able to recover as many notes as possible.  
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So dive into here, check your settings, and set them up how you please. That's it for this module. 

And that is it for this Section. In the final Section of this course, I'm just going to be showing you 

a couple of the other versions of OneNote that you have available. So things like OneNote for the 

web and also a OneNote Mobile App. So I'm going to head over there now, and I look forward to 

you joining me. 
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Video: Windows 10 Setting OneNote Options 

 

Deb: Hi guys, and welcome back to the course. In this Section, we've been taking a look at some 

of those additional OneNote options, and I want to continue that for OneNote for Windows 10. 

So we've seen how we can add a password to Sections in OneNote for Desktop, and you can do 

exactly the same in OneNote for Windows 10.  

So remember, all the same rules apply. You can only add a password to a Section, not an entire 

Notebook. So let's take a look at how we would do that. So let's imagine for one second that I 

want to add a password to the ToDo List Section. All I need to do is right-click my mouse, and 

the final option in the Contextual Menu is Password Protection. And currently, the only option I 

have available to me in here is to add a password.  

So let's enter in a password, and then confirm it, and click on Ok. And once you protect a 

Section, you'll see that it now has that little padlock icon next to it. But much the same as within 

the Desktop version, I can still jump in here and I can start to add and type my notes because this 

doesn't come into effect until I complete the second part of the protection process. So let's go 

back down to Password Protection, and we need to lock the Section. You'll see that as soon as I 

select that option, it's now telling me that this Section is Password Protected.  

Which means I can freely click around in the Things to Remember Section. But in order to view 

or make any changes to the ToDo Section, I need to enter in that password first. So let's click, 

enter in the password, and there we go, we're all unlocked. And of course if we right-click again, 

and go back down to Password Protection, we have options to Change that password, Remove 

the password entirely so essentially remove protection, and then right at the bottom we can Lock 

All Protected Sections. So if you've set a password on multiple Sections, this option is super 

useful because it means that you can just lock them all in one click. 
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Section 13 – OneNote Online 
 

Video: OneNote Online 

 

Deb: Hello everyone, and welcome back to the course. We're down into the last Section now, 

hurray, we've made it all the way through. And I really just want to round out this course by 

showing you some examples of other versions of OneNote that you have available.  

Now as we've been going through this course, I've been throwing in a module at the end of each 

Section, that shows you the equivalent features in the OneNote for Windows 10 version. Now 

that is by far one of the most popular versions that people use as it comes free with Windows 10. 

However, I did also want to show you the web version and a brief look at the OneNote Mobile 

App. Because, each of these versions has a slightly different interface and a slightly different 

way that you do things which is a little bit confusing.  

So, in this module, we're going to dive into the online portal, and I'm just going to show you the 

web based version of OneNote, and get you a bit more familiar with it. So if you have a 

Microsoft 365 subscription, then you're probably already very used to logging into that online 

portal. If you're not, it's simply a case of opening up a web browser, going to office.com, and 

then clicking the Sign In button, and using your 365 credentials, which is normally your email 

address and associated password. And that will then take you into this main hub, where all of 

your Online versions of your applications are kept. And this is the stage that I'm at now.  

I've just signed in, and this is my dashboard. Incidentally, the version of OneNote that I've been 

using throughout this course is the Desktop version. If you don't have that this is where you also 

come to install it. So if you want to install all of the full Desktop versions of all of your 

applications, you click on the Install Office button on the right-hand side. Now over on the left-

hand side, you'll see that I have all of these application icons. So I can jump into any of these and 

work in the application, but in the Online version.  

Now one thing you need to remember about these Online versions is that they're great because 

they do allow you to essentially work in Word, Excel, PowerPoint, OneNote from wherever 

you're located. So if you're out of the office, or maybe even on holiday on a beach, as long as you 

have an internet connection, you can log into the portal, and you can view your documents, make 

changes, update them. But just remember that you won't have access to all of the features within 

each application. For that you would need to use the Desktop version. So with all that said, let's 

jump into OneNote and take a look at what we have.  

So I'm going to click on the OneNote icon, it's going to open another web browser. And now I'm 

working in the Online version. So this has given me access to all of the Notebooks I have under 

this particular account. So what I can do here is I can create a new Notebook by clicking on the 

plus. So I'm going to call this one let's call this Fun Planner, and click on Create. And there we 

go. It's created a brand new Notebook for me, and it's opened it up in the Online version. And 
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you can already see here it has a slightly different look and feel. Our ribbons are a little bit more 

collapsed up. But I still have a lot of the options that I would have in that full Desktop version.  

Now underneath there, you'll see I have Fun Planner. If I click the drop down, it's going to give 

me access to all of my other Notebooks which I can switch between and open. I then have my 

Section which currently is Quick Notes and then my Untitled Page. If I want to rename a 

Section, I can right-click and click on Rename. And I'm going to call this Lunches. And then I 

have my Page which I can then give a title, something along those lines. And then it works pretty 

much exactly the same. I can start to type my notes, I have all of my Formatting options 

available on this ribbon.  

I have my Alignment tools, my Styles, I can also utilize things like Tags from here as well. So I 

have all of the same Tags that I have in the Desktop version. But one difference you do notice is 

that I don't have the option to customize my tags from here. So that is a limitation of the Online 

version. I have my Spellchecker up here. And then I can do pretty much exactly the same as what 

I can do in that full version.  

I can insert Tables, Files, Pictures, Links. I have my Draw tabs, so if I'm using a Touchscreen 

device with a Stylus, I have my different options up here. I have a View tab so I can choose how 

I'm viewing this Page. I can even do things like change the Page Color, see the Page Versions, 

jump into my Deleted Notes, so on and so forth. You'll also see here that I have a tick in 

Simplified ribbon. So that is why I'm seeing this ribbon in a slightly different way to the Desktop 

version. And if you prefer how the Desktop version looks, you can untick this, refresh your Page, 

and it's going to give you a ribbon that's more similar to the one that we've been working on.  

Then finally, if you do create a Notebook in the web version, you can choose to open that in the 

Desktop app and carry on working on it from there as well. When it comes to doing things like 

adding Sections and Pages, if you take a look at this Section Lunches, right at the bottom, I have 

an Add Section button. So I can just add this in. And if I want to add any new Pages, I have an 

Add Page link right at the bottom, which allows me to add as many Pages as I like.  

And what you'll see is in the top right-hand corner, I've got that little synchronization icon, which 

is showing me that this is synchronizing with the Desktop version, so I can edit it online. And 

then when I get back to the office and open up OneNote, I can edit it in there as well. You'll also 

note that in the top right-hand corner, we have a Share button. So if I want to share this with 

other people, I pretty much get exactly the same options that I have in the Desktop version. I can 

choose if I want people to be able to edit, I can even set an expiration date.  

So if I put a date in here, it means that whoever I give access to will lose access when this date 

expires. And I can also choose to set a password from here as well. Enter the name or address in 

and a message, click Send, and it's going to send that invite to all of those people. And if we 

jump up to the File tab, again, in here we have options which are slightly more limited than the 

Desktop version.  

So in Info, all we have is the option to edit in the Desktop app, I can Print from here, I can Share 

with people, which is the same as clicking that Share link, and then I have some About 
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information. So with regards to the functionality, yes, it does have a little bit of a different look 

and feel. Yes, the things that you can do in here are slightly more limited than the full version. 

But fundamentally, it's fairly easy to navigate and Sections, read what you need to read and make 

minor edits, which is kind of what it's designed for. And if you are working in OneNote, and you 

want to jump back to your Microsoft 365 Home dashboard, if you click the app launcher in the 

top corner, and select Office, it’s going to take you back to that main Page.  

So that is it, a quick whiz around that Online version. In the final module of this course I'm just 

going to briefly show you what the Mobile App looks like. So I'm going to head across there 

now and I look forward to you joining me. 
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Video: Mobile App 

 

Deb: Hello everyone, and welcome back to the course. We've made it all the way through to the 

final module of the last Section. And in this Section, we've been taking a look at alternative ways 

that you can work with OneNote. And in the previous module, I showed you how you can utilize 

OneNote on the web. And what I want to run through with you now is just some of the features 

of the Mobile App.  

So like most applications these days, there is a OneNote Mobile App available for both iOS and 

Android. And you can see here, I'm just currently on the Microsoft support Page, where you'll 

find some instruction when it comes to setting up and using the Mobile App. So for example, I 

have an iOS phone, so I'm going to select iOS, and then it takes me through to some information 

related to my apps on my phone. And if I want to I can read a blog, I can also choose to get the 

app.  

Now most people won't get their app in this way. What's more likely is that if you do want the 

Mobile App, you're going to go to the App Store or the Play Store on your mobile phone, search 

for OneNote, and then download the app that way. So what we're gonna do is I've done a 

screencast of what the app looks like on my mobile phone. So let's take a look and run through 

some of the features.  

So let's start by open up the app store and running a search for the OneNote app. And I'm using 

iOS on the iPhone. We can scroll down and select the Microsoft app and I already have it 

installed so I can just open it. I can see a list of the Notebooks that I have. And if I click on my 

name, it's going to show me my background settings. Now if I click on the More Notebooks link, 

this is going to show me all of my recent Notebooks. So I've opened up Fun Planner, and it's now 

in the list.  

What I can also do is click on the plus and create a Notebook by giving it a new Notebook name. 

So I'm just going to call this one General Stuff. I can change the color of the Notebook to a pink 

color, I've got my location there, and then I can just create that Notebook. So now I'm in this 

Notebook. And you can see my Sections. So I have New Section 1, which I can of course 

rename. And if I click on it, I can see my Pages. So let's hold down our finger just to select 

Section 1. And then using the icons at the bottom, I'm just going to choose to rename this 

specific Section. So I'm going to call this ToDo List.  

What I could also do is create another Section by clicking on the plus in the top right-hand corner 

and running through the same process. So I'm going to give this one a name. So Things to 

Remember. And then if I edit, I can choose any one of these Sections, and then utilize the tools at 

the bottom to manage them. So for example, I could change the Section Color. I can go into the 

Notebook to see the Pages or I can choose to do things like delete the Section.  

I can protect the Section by typing in a password, and you'll see that I get a little padlock sign 

when that's been locked. If I go into the Pages, currently, I have an Untitled Page. And of course, 

this is something I can then just rename. And I can then utilize all of the tools across the bottom 
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to add my notes to my particular Page. So here I'm using a ToDo Tag and I'm just going to Add-

in a few to do items. I can click the three dots in the top corner to see more options.  

So I can Delete Pages, Copy Pages, move from here. I can also change the Page Background to 

white, I can add pictures either from my library or I can take a picture on my phone to add to my 

Notebook, I can add bullet points. So let's add some bulleted items into here. And then when I go 

back, I can see my Pages listed out, click on the plus to add another Page. So this one's called 

Tomorrow and click on the back arrow to go back to the main Pages list.  

Now I can also search so if I type in the search term Mark, you can see it's going to bring back 

those results and direct me to the Page that contains that specific word. Another thing I can do is 

utilize Annotation tools. So I'm just doing a quick scribble with a pen on there. I can highlight 

items, I can erase items, and I can also utilize that Lasso tool to make selections. I'm going to 

undo to pull all of that back again. But just remember you have those Draw utilities as well.  

Let's go back to our main Page and then back again to go back to our Sections. So that is all of 

my Notebooks listed out. I can add as many as I like, and I can also check for any notifications 

from here as well. So that is pretty much it, a very quick run through of how you can navigate 

and work with the Mobile App. Now bear in mind, my example was just for the app that I have 

on my phone, so that is for iOS.  

But of course, you do have the app available for Android and also for Windows phones. And, the 

functionality and how you move around it may differ very slightly, but hopefully that gives you 

an idea as to how you can perform all your tasks fairly easily.  

Well guys, that is it for this particular Section, and we've pretty much finished the course at this 

point. All that's left for me to do now is say my goodbyes, and I will do that in the last module. 

So I'm going to head over there now and I look forward to you joining me. 
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Section 14 – Course Close 
 

Video: Course Close 

 

Deb: Hello everyone, and welcome to the closing Section of this OneNote course. It's been an 

absolute pleasure hosting this course for you. And I hope you enjoyed running through the 

different modules and learning some new skills as much as I've enjoyed presenting it to you. 

We've pretty much covered all of the fundamental skills that you're going to need to work 

successfully in OneNote.  

From the very beginning of creating Notebooks, Sections, Pages, working through to Formatting, 

Inserting various different pieces of content from Multiple Sources. We've seen how to Search 

and also utilize the Tag feature. We've checked out the Drawing tools for making annotations, 

and we've seen how we can customize the Options and generally format our Notebooks.  

Now of course, we've learned much more than just the few things I've gone through there. And 

my hope is that you've learned enough skills in this course to feel a lot more confident when 

you're working in OneNote.  

So that about wraps it up for me. Congratulations, everyone. Thank you so much for choosing us. 

And I hope to see you somewhere down the track. Once again, my name is Deb. Good bye for 

now. 
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